
คูมือการปฏิบัติงาน
การออกแบบสื่ออินโฟกราฟก

ของสำนักวิทยบริการและเทคโนโลยีสารสนเทศ

ดวยโปรแกรมคอมพิวเตอรกราฟก Adobe Illustrator

นายนรินทร จิตตมั่นการ

สำนักวิทยบริการและเทคโนโลยีสารสนเทศ

มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร



ค ำน ำ 
 
 ปัจจุบันการออกแบบสื่อให้มีรูปแบบการน าเสนอข้อมูลข่าวสารที่หลากหลายและน่าสนใจมากยิ่งขึ้น 
สามารถสื่อข้อมูลให้ผู้รับได้มีประสิทธิภาพมากที่สุด โดยการน าเสนอข้อมูลรูปแบบซึ่งเป็นที่นิยมในปัจจุบันก็คือ
สื่ออินโฟกราฟิก ที่สามารถสื่อสารเชิงกลยุทธ์สามารถสร้างความสัมพันธ์และประโยชน์ร่วมกันระหว่าง
หน่วยงานและกลุ่มเป้าหมาย สร้างความดึงดูดความน่าสนใจ และเป็นที่ยอมรับในการจดจ าสื่อได้ง่าย 
 โดยในคู่มือฉบับนี้ได้ท าการรวบรวมหลักเกณฑ์วิธีการปฏิบัติงาน ข้อควรระวัง เทคนิคการปฏิบัติงาน 
ปัญหาอุปสรรคและข้อเสนอแนะ เพ่ือการพัฒนาการออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและ
เทคโนโลยีสารสนเทศ มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร 
 ผู้ปฏิบัติงานในต าแหน่งนักวิชาการช่างศิลป์ ระดับปฏิบัติการ ของส านักวิทยบริการและเทคโนโลยี
สารสนเทศ ได้ตระหนักถึงความส าคัญในการออกแบบสื่อประชาสัมพันธ์ของส านักวิทยบริการและเทคโนโลยี
สารสนเทศ จึงได้จัดท าคู่มือการปฏิบัติงาน เรื่อง การออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและ
เทคโนโลยีสารสนเทศ ด้วยโปรแกรมคอมพิวเตอร์กราฟิก Adobe Illustrator เพ่ือให้ผู้ที่ปฏิบัติงานสามารถ
ปฏิบัติงานแทนกันได ้และเป็นไปในมาตรฐานเดียวกัน 
 

นายนรินทร์  จิตต์มั่นการ 
นักวิชาการช่างศิลป์ ระดับปฏิบัติการ 

ส านักวิทยบริการและเทคโนโลยีสารสนเทศ 
 



 

สารบัญ 
หน้า 

ค าน า 
สารบัญตาราง           ง 
สารบัญภาพ           จ 
บทที่  1  บทน า 1 
 ความเป็นมาและความส าคัญ 1 
 วัตถุประสงค์ 1 
 ขอบเขตของคู่มือ 1 

 ขอบเขตกลุ่มเป้าหมาย 2 
  ค าจ ากัดความเบื้องต้น 2  
ประโยชน์ที่คาดว่าจะได้รับ 2 

บทที่  2  โครงสร้างละหน้าที่ความรับผิดชอบ 3 
 โครงสร้างการบริหารจัดการ 3 
 บทบาทหน้าที่ความรับผิดชอบ 11 
บทที่  3  หลักเกณฑ์วิธีการปฏิบัติงาน 16 
 หลักเกณฑ์วิธีการปฏิบัติงาน 16 
 ข้อควรระวังในการปฏิบัติงาน 51 
บทที่  4 เทคนิคการปฏิบัติงาน 52 
 กิจกรรมแผนการปฏิบัติงาน 52 
 ขั้นตอนและเทคนิคการปฏิบัติงาน 53 
 การติดตามประเมินผลการปฏิบัติงาน 78 
บทที่  5 ปัญหาอุปสรรและข้อเสนอแนะ 79 
 ปัญหา/อุปสรรค และแนวทางการแก้ไข 79 
 ข้อเสนอแนะเพ่ือการพัฒนา 82 
บรรณานุกรม 83 
ภาคผนวก 84 
ประวัติผู้เขียน 88 
 



ง 

 

สารบัญตาราง 

 
ตารางท่ี   หน้า 
4-1   แสดงแผนการปฏิบัติงานการออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการ 52 
  และเทคโนโลยีสารสนเทศ ด้วยโปรแกรมคอมพิวเตอร์กราฟิก Adobe Illustrator 



จ 

 

สารบัญภาพ 
 
ตารางท่ี หน้าที ่
2-1  แสดงโครงสร้างหน่วยงานของส านักวิทยบริการและเทคโนโลยีสารสนเทศ 5 
2-2   แสดงโครงสร้างการบริหารส านักวิทยบริการและเทคโนโลยีสารสนเทศ 5 
2-3   แสดงกระบวนการท างานการออกแบบสื่ออินโฟกราฟิก 15 
3-1   แสดงทิศทางน าสายตา 16 
3-2  แสดงจุดเด่นของการสื่อสารด้วย Infographic 27 
3-3    แสดงตัวอย่าง Infographic แบบอธิบายข้อมูล 30 
3-4    แสดงตัวอย่าง Infographic แบบแจกแจงข้อมูล 30 
3-5    แสดงตัวอย่าง Infographic แบบเปรียบเทียบข้อมูล 31 
3-6    แสดงตัวอย่าง Infographic แบบแสดงสถิติหรือผลส ารวจ 31 
3-7    แสดงตัวอย่าง Infographic แบบแสดงล าดับขั้นตอนของข้อมูล 32 
3-8    แสดงตัวอย่าง Infographic แบบแสดงความเชื่อมโยงของข้อมูล 32 
3-9    แสดงตัวอย่าง Infographic แบบแสดงข้อมูลตามล าดับเวลา 33 
3-10    แสดงตัวอย่าง Infographic แบบแสดงข้อมูลเชิงภูมิศาสตร์ 33 
3-11    แสดงตัวอย่าง Infographic แบบแสดงข้อมูลแบบผสมผสาน 34 
3-12    แสดงหน้าจอการท างานของโปรแกรม Adobe Illustrator 35 
3-13    แสดงฟังก์ชั่นคอนโทรลพาเนล 36 
3-14    แสดงแผงเครื่องมือ (Tool Panel) ในโปรแกรม Adobe Illustrator 38 
3-15    แสดงตัวอย่างหน้าต่างพาเนลในโปรแกรม Adobe Illustrator 40 
3-16    แสดงค าสั่งโหมดสี Color Mode 41 
3-17    แสดงตัวอย่างพาเนล Swatches 42 
3-18    แสดงตัวอย่างรูปแบบอักษรประเภท Point Type 42 
3-19    แสดงตัวอย่างรูปแบบอักษรประเภท Area Type 43 
3-20   แสดงตัวอย่างรูปแบบอักษรประเภท Type on a Path 43 
3-21    แสดงเครื่องส าหรับพิมพ์ข้อความ Type Tool ในรูปแบบต่าง ๆ 43 
3-22   แสดงความแตกต่างของการใช้ค าสั่ง Align กับการไม่ใช้ค าสั่ง Align 44 
   ในการจัดระเบียบเลเยอร์ 
3-23   แสดงหน้าต่างค าสั่งใน Panel Align 44 
3-24    แสดงตัวอย่างหน้าต่าง Panel Stroke 45 
3-25    แสดงค าสั่งการเปลี่ยนหน่วยวัด 45 



ฉ 

 

สารบัญภาพ(ต่อ) 
 
ตารางท่ี หน้าที ่
3-26    แสดงการใช้ค าสั่งเส้น Grid 46 
3-27    แสดงค าสั่งการเรียกใช้เส้นไกด์ 46 
3-28    การใช้ค าสั่ง Smart Guides 47 
3-29    แสดงตัวอย่างอาร์ตบอร์ดและพ้ืนที่เตรียมงาน 47 
3-30    แสดงการเลือกใช้ค าสั่งในการบันทึกข้ันตอนที่ 1 48 
3-31   แสดงการเลือกใช้ค าสั่งในการบันทึกข้ันตอนที่ 2 48 
3-32   แสดงการเลือกใช้ค าสั่งในการบันทึกข้ันตอนที่ 3 49 
3-33   แสดงการใช้ค าสั่ง Export File ขั้นตอนที่ 1 49 
3-34   แสดงการใช้ค าสั่ง Export File ขั้นตอนที่ 2 50 
3-35   แสดงการใช้ค าสั่ง Export File ขั้นตอนที่ 3 50 
4-1    แสดงขั้นตอนและเทคนิคการปฏิบัติงานในการออกแบบสื่ออินโฟกราฟิก 53 
4-2   แสดงหน้าเพจการเข้าสู่ระบบ www.google.com 54 
4-3   แสดงการเข้าระบบแอพ Google Drive 55 
4-4   แสดงโฟลเดอร์ข้อมูลใช้ท าสื่ออินโฟกราฟิก 55 
4-5    แสดงขั้นตอนการเปิดไฟล์งานอีเลิร์นนิ่ง 56 
4-6   แสดงการออกแบบร่างสื่ออินโฟกราฟิก 57 
4-7   แสดงการเปิดโปรแกรม Adobe Illustrator 58 
4-8   แสดงการตั้งแถบไม้บรรทัดบนอาร์ตบอร์ด 58 
4-9   แสดงการลากเส้นไกด์ด้านมุมซ้ายบน ก าหนดขอบของงาน 59 
4-10   แสดงการลากเส้นไกด์ด้านมุมขวาล่าง ก าหนดขอบของงาน 59 
4-11  แสดงการก าหนดพื้นที่ขอบเขตการท างาน 60 
4-12    แสดงการบันทึกไฟล์งานการออกแบบสื่ออินโฟกราฟิก 60 
4-13    แสดงการวัดและก าหนดจุดกึ่งกลาง 61 
4-14    แสดงการใส่สีพื้นให้ชิ้นงานบนอาร์ตบอร์ด 61 
4-15    แสดงการคัดลอกข้อความในโปรแกรม Microsoft Office Word 62 
4-16    แสดงการวางข้อความที่คัดลอก 62 
4-17    แสดงการเลือกรูปแบบฟอนต์ 63 
4-18    แสดงการใช้ค าสั่งขยายระยะห่างของข้อความ 63 
4-19    แสดงการจัดวางข้อความหัวข้อ 64 



ช 

 

สารบัญภาพ(ต่อ) 
 

ตารางท่ี หน้าที ่
4-20   แสดงการคัดลอกออบเจ็คในโปรแกรม Adobe Illustrator 64 
4-21   แสดงการใช้ค าสั่งจัดกลุ่มข้อความ 65 
4-22  แสดงการใส่สีพื้นและสีเส้นของข้อความ 65 
4-23   แสดงการใส่สีพื้นและสีเส้นในข้อความ 66 
4-24   แสดงการจัดระเบียบข้อความให้ได้รูปแบบ Point Type 66 
4-25   แสดงการเพ่ิมสีจาก Swatch Libraries menu 67 
4-26   แสดงการใส่สีเส้นและก าหนดขนาดของเส้นให้ภาพกราฟิก 67 
4-27   แสดงการสร้างภาพกราฟิกทรงสี่เหลี่ยมผืนผ้า 68 
4-28   แสดงการเปลี่ยนต าแหน่งของเลเยอร์ 68 
4-29   แสดงการจัดระเบียบจุดกึ่งกลางระหว่างออบเจ็คท้ัง 2 69 
4-30   แสดงการสร้างกราฟิกซ้อน 69 
4-31    แสดงการใช้ค าสั่ง Make Clipping mask 70 
4-32    แสดงการจัดวางเลเยอร์กราฟิก 70 
4-33    แสดงการใช้ค าสั่ง Effect เพ่ือใส่เงาให้ออบเจ็ค 71 
4-34    แสดงการค านวน Drop Shadow 71 
4-35    แสดงการปรับหมุนออบเจ็คด้วยค าสั่ง Rotate Tool (R)   72 
4-36    แสดงภาพกราฟิกใส่ข้อมูลอันดับรายวิชา 72 
4-37    แสดงภาพกราฟิกที่เปลี่ยนสีจาก Swatches Libraries menu 73 
4-38   แสดงการคัดลอกข้อความจาก Microsoft Office Word 73 
4-39    แสดงการวางข้อความหัวข้อชื่อรายวิชา 74 
4-40    แสดงการวางข้อความในส่วนของชื่ออาจารย์ประจ าวิชา 74 
4-41    แสดงการจัดวางข้อความรายวิชาและคณะที่อาจารย์สังกัดในรายวิชาแรก 75 
4-42    แสดงการจัดวางข้อความรายวิชา ชื่ออาจารย์และคณะที่สังกัดในรายวิชาทั้งหมด 75 
4-43    แสดงการใส่ตัวเลขล าดับที่ 76 
4-44   แสดงการใส่ข้อความรายชื่อหน่วยงาน 76 
4-45    แสดงการ Export File 77 
4-46   แสดงการบันทึกภาพอินโฟกราฟิก 77 
4-47    แสดงตัวอย่างสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยีสารสนเทศ 78 
  ที่เผยแพร่ผ่านระบบเว็บไซด์ E-learning 



บทท่ี 1 
บทน ำ 

 
1.1  ควำมเป็นมำและควำมส ำคัญ 
 ในทุกวันนี้มนุษย์ทุกคนล้วนต้องรับและส่งข้อมูลกันอยู่เสมอ ความต้องการให้ทุกคนคิดตรงกันว่าอยากจะ
สื่อสารกับอีกฝ่ายให้เข้าใจอย่างไร เนื่องจากมีความแตกต่างทางภาษา ทรัพยากร สถานภาพทางสังคม ซึ่งไม่ว่า
เราจะอยู่ที่ใดบนโลกใบนี้ การใช้ภาพเป็นเครื่องมือสื่อสารข้อมูลที่ชัดเจนและช่วยเติมเต็มการสื่อสารที่ค าพูดไม่
สามารถอธิบายได้ทั้งหมด ในหลาย ๆ รูปแบบของการสื่อสารด้วยภาพ สิ่งที่โดดเด่นมากในฐานะของเครื่องมือ
การสื่อสารข้อมูล คือ อินโฟกราฟิก ซ่ึงการใช้อินโฟกราฟิกเป็นการใช้ภาพมาเป็นเครื่องมือที่ใช้ในการแก้ปัญหา
ความแตกต่างนี้  โดยอินโฟกราฟิกจะท าหน้าที่สื่อสารข้อมูลให้เข้าใจง่าย ในการจะแปลงข้อมูลที่มีเนื้อหา
ซับซ้อนออกมาเป็นภาพได้นั้น จ าเป็นจะต้องท าการเลือกใช้และทิ้งข้อมูลที่ไม่ส าคัญ ต้องท าการเรียบเรียงและ
แบ่งประเภทข้อมูลให้เป็น (ณิชมน, 2558)  
 ส านักวิทยบริการและเทคโนโลยีสารสนเทศเป็นหน่วยงานที่ให้บริการด้านเทคโนโลยีสนับสนุนภารกิจ
หลักของมหาวิทยาลัย ผลิตการบริการการศึกษาโดยใช้นวัตกรรมดิจิทัล (ส านักวิทยบริการและเทคโนโลยี
สารสนเทศ, 2560) ตลอดจนเผยแพร่ความรู้วิวัฒนาการต่าง ๆ ข้อมูลสถิติการเข้าใช้ระบบต่าง ๆ เกี่ยวกับ
ระบบเทคโนโลยีสารสนเทศที่เป็นประโยชน์ต่อมหาวิทยาลัยและนักศึกษา เพ่ือให้บุคลากรทั้งภายในและ
ภายนอกองค์กรได้รับทราบข้อมูลข่าวสารกิจกรรมการด าเนินงาน การเลือกใช้ รูปภาพในการน าเสนอสื่อ
ประชาสัมพันธ์ให้เหมาะสมกับงานจึงเป็นสิ่งส าคัญ เนื่องจากสื่ออินโฟกราฟิกเป็นการเลือกใช้สื่อที่สามารถ
อธิบายข้อมูลที่มีอยู่อย่างมหาศาล ให้สามารถเข้าใจได้ภายในภาพเดียว มีความโดดเด่น ชัดเจนในข้อมูล โดย
การใช้โปรแกรมคอมพิวเตอร์กราฟิก Adobe Illustrator ในการท างานส าหรับการออกแบบ ทั้งนี้ต้องมีการ
ก าหนดการวางแผนก่อนการออกแบบสื่อ การรวบรวมข้อมูลเนื้อหา และการจัดวางองค์ประกอบ เพ่ือให้ได้สื่อ
ที่มีประสิทธิภาพมากและตรงตามวัตถุประสงค์ของหน่วยงาน 
 จากความเป็นมาและความส าคัญดังกล่าว ผู้เขียนจึงมีความสนใจเขียนคู่มือการปฏิบัติงานเรื่องการ
ออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยีสารสนเทศ ด้วยโปรแกรม Adobe Illustrator 
 
1.2  วัตถุประสงค์  
 1.2.1  เพ่ือให้ผู้ปฏิบัติงานสามารถปฏิบัติงานแทนกันได้ 
 1.2.2  เพื่อให้การปฏิบัติงานเป็นมาตรฐานเดียวกัน  
  
1.3  ขอบเขตของคู่มือ 
 การปฏิบัติงานนี้ ครอบคลุมขั้นตอนการออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยี
สารสนเทศ ตั้งแต่กระบวนการเริ่มต้นในขั้นตอนการก าหนดการวางแผนก่อนการออกแบบ การรวบรวมข้อมูล
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เนื้อหา และการจัดวางองค์ประกอบในการออกแบบ จนถึงกระบวนการสิ้นสุดของการออกแบบสื่ออินโฟ
กราฟิกในขั้นตอนการบันทึกสื่ออินโฟกราฟิกในรูแบบของ .jpg ส่งต่อให้เจ้าหน้าที่ผู้ปฏิบัติงานและผู้ด าเนินการ
เผยแพร่สื่อประชาสัมพันธ์  
 
1.4  ขอบเขตกลุ่มเป้ำหมำย 
 เป็นผูป้ฏิบตังิานในดา้นการออกแบบส่ือศลิปะ ระดบัปฏิบตักิารหรือผูท่ี้ปฏิบตัหินา้ท่ีเก่ียวขอ้งกบัการ
ออกแบบส่ือประชาสมัพนัธข์องหนว่ยงาน 

 
1.5  ค ำจ ำกัดควำมเบื้องต้น 
 กำรออกแบบ หมายถึง การออกแบบสื่อประชาสัมพันธ์ข้อมูลข่าวสารของส านักวิทยบริการและ
เทคโนโลยีสารสนเทศ ในรูปแบบสื่ออินโฟกราฟิก ที่ก าหนดการวางแผนการออกแบบแล้ว โดยการน าข้อมูล
เนื้อหา และรูปภาพที่ได้จากการรวบรวมมาท าการออกแบบใหม่ด้วยโปรแกรมที่ก าหนด เพ่ือให้เกิดความ
เหมาะสมสวยงามและเกิดความน่าสนใจ 
 ส่ืออินโฟกรำฟิก หมายถึง สื่อประชาสัมพันธ์ของส านักวิทยบริการและเทคโนโลยีสารสนเทศ ที่จัดท าขึ้น 
เพ่ือน าเสนอผลการด าเนินงาน ข่าวสาร และกิจกรรมการด าเนินงานของหน่วยงาน เพ่ือเป็นสื่อที่ท าให้เกิด 
ความเข้าใจที่สามารถอธิบายข้อมูลทั้งหมดได้ภายในภาพเดียว  
 โปรแกรม Adobe Illustrator หมายถึง โปรแกรมคอมพิวเตอร์กราฟิกส าเร็จรูปที่ใช้ส าหรับการ
ออกแบบสื่อกราฟิก ทั้งในรูปแบบสิ่งพิมพ์ โปสเตอร์ หรือสื่ออิเล็กทรอนิกส์ โดยมีจุดเด่นในการสามารถสร้าง
ภาพกราฟิกได้หลากหลายตามความต้องการของผู้ออกแบบ 

 
1.6  ประโยชน์ที่คำดว่ำจะได้รับ  
 1.6.1  ผู้ปฏิบัติงานสามารถปฏิบัติงานแทนกันได้  
 1.6.2  การปฏิบัติงานเป็นมาตรฐานเดียวกัน 
 
   
 

  
  
 



บทท่ี 2 
โครงสร้างและหน้าที่ความรับผิดชอบ 

 

2.1  โครงสร้างการบริหารจัดการ 
มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร สถาปนาขึ้นตามพระราชบัญญัติมหาวิทยาลัยเทคโนโลยี      

ราชมงคล เมื่อวันที่ 18 มกราคม พ.ศ. 2548 ประกอบด้วยวิทยาเขต 5 แห่ง ได้แก่ วิทยาเขตเทเวศร์, วิทยาเขต
โชติเวช , วิทยาเขตพณิชยการพระนคร , วิทยาเขตชุมพรเขตรอุดมศักดิ์ และวิทยาเขตพระนครเหนือ        
ข้อมูลระบบเครือข่ายคอมพิวเตอร์เดิม แต่ละวิทยาเขตได้ใช้เทคโนโลยีของ Cisco System โดยใช้ Router เป็น
อุปกรณ์ค้นหาเส้นทาง เชื่อมต่อผ่าน Leased Line มี Bandwidth ขนาด 2 Mb เชื่อมต่อไปยังส านักเทคโนโลยี
สารสนเทศ ต่อมาได้ด าเนินการจดโดเมนใหม่เป็น rmutp.ac.th เมื่อวันที่ 8 กันยายน พ.ศ.2548 เพ่ือให้
สอดคล้องกับลักษณะขององค์กร 

เมื่อวันที่ 14 พฤศจิกายน พ.ศ.2549 จึงได้มีกฎกระทรวง จัดตั้งส่วนราชการในมหาวิทยาลัยเทคโนโลยี
ราชมงคล ให้เป็นส านักวิทยบริการและเทคโนโลยีสารสนเทศ โดยมีส านักงานชั่วคราวตั้งอยู่ที่ อาคาร 1 ชั้น 4 
และในปัจจุบันตั้งอยู่ ณ อาคารราชบุรีดิเรกฤทธิ์ มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร วิทยาเขตเทเวศร์ 
มีศูนย์วิทยบริการและเทคโนโลยีสารสนเทศให้บริการ 4 แห่ง ได้แก่ สาขาโชติเวช สาขาพณิชยการพระนคร 
สาขาชุมพรเขตรอุดมศักดิ์ และสาขาพระนครเหนือ 

วิสัยทัศน์ พันธกิจ เป้าหมาย ยุทธศาสตร์ กลยุทธ์ ของส านักวิทยบริการและเทคโนโลยีสารสนเทศ 
 วิสัยทัศน์ 
 - พัฒนาองค์กรสู่การเป็นมหาวิทยาลัยดิจิทัล  
 

 ปณิธาน 
- มุ่งมั่นเป็นผู้น าการจัดการศึกษาด้านวิชาชีพด้วยวิทยาศาสตร์และเทคโนโลยีเชิงบูรณาการ พัฒนา
ก าลังคนให้มีคุณภาพ คู่คุณธรรม สู่มาตรฐานสากล 

 

 พันธกิจ 
- พัฒนานวัตกรรมด้านไอซีที  เ พ่ือสนับสนุนภารกิจหลักของมหาวิทยาลัยในการก้าวไปสู่ 
การเป็นมหาวิทยาลัยดิจิตัล 

-  ผลิตการบริการการศึกษาโดยใช้นวัตกรรมด้านไอซีที  เ พ่ือบูรณาการเข้ ากับการเรี ยน  
การสอนสมัยใหม่โดย ผ่านระบบบริการอิเล็กทรอนิกส์ 

- พัฒนาการบริหารจัดการองค์กรโดยใช้นวัตกรรมด้านไอซีที เ พ่ือเพ่ิมประสิทธิภาพและประสิทธิผล
การบริหารการศึกษาสมัยใหม่และเป็นกลไกในการสร้างหลักธรรมาภิบาล 

- พัฒนาทรัพยากรบุคคลให้มีสมรรถนะทางไอซีทีที่มีคุณภาพ สอดคล้องกับการพัฒนาประเทศ 
- จัดหาทรัพยากร ICT โดยใช้เทคโนโลยีที่เหมาะสม สอดคล้องกับภารกิจของมหาวิทยาลัย 
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 เป้าประสงค์ 
-  ยกระดับ เ พ่ิมขีดความสามารถของบุคลากรและนักศึกษาในการใช้นวัตกรรมดิจิ ทั ล 
เพ่ือการศึกษา 

- พัฒนาสื่อและระบบสนับสนุนการเรียนรู้ ในรูปแบบดิจิ ทัลเ พ่ือบูรณาการเข้ากับการเรียน 
การสอนออนไลน์ 

- สร้างวัฒนธรรมการท างานขององค์กรให้เป็นสังคมดิจิทัลที่มีคุณภาพ 
- สร้างระบบนิเวศดิจิทัลส าหรับงานวิจัยอย่างครบวงจร เพ่ือบูรณาการเข้ากับการบริหารจัดการงานวิจัย
และบริการงานวิชาการ 

-  สร้างระบบบริหารจัดการเชิงกลยุทธ์  โดยใช้ เทคโนโลยีการประมวลผผลข้อมูลขนาดใหญ่   
เพ่ือเพ่ิมประสิทธิภาพและประสิทธิผลการบริหารจัดการและการพัฒนาองค์กร 

 - พัฒนาโครงสร้างพ้ืนฐานด้านไอซีทีท่ีมีมาตรฐานและทันสมัยด้วยเทคโนโลยีดิจิทัล 
 
กลยุทธ์ 
- พัฒนาคุณภาพนักศึกษา (Smart Student)  
- พัฒนาคุณภาพบุคลากรสายวิชาการ (Smart Lecturer) 
- พัฒนาคุณภาพบุคลากรสายสนับสนุน (Smart Personal)  
- พัฒนาคุณภาพระบบการจัดการความรู้ (Smart Knowledge  
- พัฒนาศูนย์ความเป็นเลิศทางวิชาการ (Center of Excellence) 
- พัฒนาคุณภาพหลักสูตรและการเรียนการสอน (Smart Learning)  
- พัฒนาทรัพยากรการเรียนรู้ดิจิทัล (Smart Library) 
- พัฒนาระบบงานการให้บริการอิเล็กทรอนิกส์(e-Services)  
- พัฒนาระบบบริหารและบริการงานวิจัย (e-Research)  
- .พัฒนาระบบบริหารจัดการเชิงกลยุทธ์ (e-Strategy)  
- พัฒนาระบบประมวลผลข้อมูลขนาดใหญ่ (Big Data) 
- พัฒนาระบบการประกันคุณภาพการศึกษา (Quality Assurance) 
- พัฒนาโครงสร้างพื้นฐานทางด้านเทคโนโลยีสารสนเทศและการสื่อสาร (e-Infrastructure) 
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2.1.1  โครงสร้างหน่วยงานของส านักวิทยบริการและเทคโนโลยีสารสนเทศ (Organization chart) 
 
 
 
 
 
 
 
 
  ภาพที่ 2-1 แสดงโครงสร้างหน่วยงานของส านักวิทยบริการและเทคโนโลยีสารสนเทศ 

 1. โครงสร้างการบริหารส านักวิทยบริการและเทคโนโลยีสารสนเทศ (Adminisstration 
chart) 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  ภาพที่ 2-2  แสดงโครงสร้างการบริหารส านักวิทยบริการและเทคโนโลยีสารสนเทศ 
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2.1.2  โครงสร้างการปฏิบัติงาน (Activity chart) กลุ่มพัฒนานวัตกรรมและเทคโนโลยีการศึกษา 
 1. รายชื่อผู้บริหาร 

 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 ผู้อ านวยการส านักวิทยบริการและเทคโนโลยี

สารสนเทศ 

 
รองผู้อ านวยการส านักวิทยบริการ

และเทคโนโลยีสารสนเทศ 

 
รองผู้อ านวยการส านักวิทยบริการ

และเทคโนโลยีสารสนเทศ 
รองผู้อ านวยการส านักวิทยบริการ

และเทคโนโลยีสารสนเทศ 

ผู้บริหาร หัวหน้าส านักงานผู้อ านวยการ 
 

ผู้ช่วยผู้อ านวยการส านักวิทยบริการและ
เทคโนโลยีสารสนเทศ 
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 2. งานวิจัยและพัฒนาสื่อการศึกษา 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 3. งานผลิตสื่อโสตทัศน์ 
 
 
 
 
 
 
 
 
 
 
 

หัวหน้างานวิจัยและพัฒนาสื่อการศึกษา 

นักวิชาการโสตทัศนศึกษา นักวิชาการโสตทัศนศึกษา 

 
หัวหน้างานผลิตสื่อโสตทัศน์ 
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 4. งานผลิตสื่อคอมพิวเตอร์ 

 
 
 
 
 
 
 

นักวิชาการโสตทัศนศึกษา 
ปฏิบัติการ 

นักวิชาการโสตทัศนศึกษา 
ปฏิบัติการ 

นักวิชาการโสตทัศนศึกษา 
ปฏิบัติการ 

นักวิชาการช่างศิลป์ปฏิบัติการ 
 

นักวิชาการช่างศิลป์ปฏิบัติการ 
 

นักวิชาการช่างศิลป์ปฏิบัติการ 
 

นักวิชาการช่างศิลป์ปฏิบัติการ 
 

ช่างศิลป์ นักวิชาการโสตทัศนศึกษา 

 
นักวิชาการคอมพิวเตอร์ปฏิบัติการ 
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 5. งานบริหารทรัพยากรสื่ออิเลคทรอนิกส์ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
2.1.3  ภาระหน้าที่ของส านักวิทยบริการและเทคโนโลยีสารสนเทศ 

ส านักวิทยบริการและเทคโนโลยีสารสนเทศ มีภารกิจมุ่งเน้นพัฒนามหาวิทยาลัยเทคโนโลยีราช
มงคล  พระนคร ให้เป็นสังคมแห่งการเรียนรู้ (Learning Society) โดยใช้ ICT เป็นฐานในการบริการการศึกษา
ได้อย่างเต็มศักยภาพ มีจริยธรรม และมีสมรรถนะทาง  ICT ตามมาตรฐานสากล หมายถึง ผู้เรียน ผู้สอน 
บุคลากร ของมหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร และประชาชนทั่วไป สามารถใช้ประโยชน์จาก ICT ใน
การเข้าถึงบริการทางการศึกษาได้อย่างเต็มศักยภาพ มีจริยธรรม และมีสมรรถนะทาง ICT ตามมาตรฐานสากล 
ส านักวิทยบริการและเทคโนโลยีสารสนเทศ มีภาระหน้าที่ แบ่งตามงาน 1 งาน และกลุ่ม 4 กลุ่ม ประกอบด้วย 
ส านักงานผู้อ านวยการ กลุ่มเทคโนโลยีสารสนเทศ กลุ่มเครือข่ายคอมพิวเตอร์และการสื่อสาร กลุ่มวิทยบริการ 
และกลุ่มพัฒนานวัตกรรมและเทคโนโลยีการศึกษา 

1. ส านักงานผู้อ านวยการ 
งานบริหารทั่วไป มีหน้าที่รับผิดชอบหลัก ดังนี้ 
1) งานธุรการและสารบรรณ 
2) งานบัญชีการเงิน 

 
นักเอกสารสนเทศ 

 
นักเอกสารสนเทศ 
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3) งานบุคลากร 
4) งานนโยบายและแผน 
5) งานพัสดุและอาคารสถานที่ 
6) งานฝึกอบรม 
7) งานสถิติและประเมินผล 
8) งานประชาสัมพันธ์ 
9) งานประกันคุณภาพ 

2. กลุ่มเทคโนโลยีสารสนเทศ มีหน้าที่รับผิดชอบหลัก ดังนี้ 
1) งานวางแผนและพัฒนาระบบสารสนเทศเพ่ืองานการบริหารจัดการภายในมหาวิทยาลัยฯ 
2) งานดูแลเครื่องคอมพิวเตอร์แม่ข่าย (server)  
3) งานติดตั้งและพัฒนาระบบสารสนเทศเพ่ือการบริหารงานภายในมหาวิทยาลัยฯ 
4) งานก าหนดมาตรฐานด้านเทคโนโลยีสารสนเทศ 
5) งานดูแลระบบสารสนเทศเพ่ือการบริหาร 
6) งานดูแลลิขสิทธิ์ซอฟต์แวร์ในมหาวิทยาลัยฯ 
7) งานบริการระบบสารสนเทศเพ่ือการจัดการ 
8) งานระบบประกันคุณภาพ 
9) งานพัฒนาศูนย์ปฏิบัติการเพ่ือการตัดสินใจเชิงการตัดสินใจเชิงกลยุทธ์ 
10) ให้ค าปรึกษาด้านเทคโนโลยีสารสนเทศแก่หน่วยงานต่างๆ ภายในมหาวิทยาลัย 

3. กลุ่มเครือข่ายคอมพิวเตอร์และการสื่อสาร มีหน้าที่รับผิดชอบหลัก ดังนี้ 
1) งานวางแผนและพัฒนาระบบเครือข่ายหลักของมหาวิทยาลัยและการเชื่อมโยง 

เครือข่ายภายในมหาวิทยาลัย 
2) งานดูแลเครือข่ายคอมพิวเตอร์หลัก 
3) งานดูแลเครื่องคอมพิวเตอร์แม่ข่ายด้านเครือข่าย 
4) งานดูแลเว็บไซต์ของมหาวิทยาลัยด้านเทคนิค  
5) งานให้บริการระบบเครือข่ายภายในมหาวิทยาลัย 
6) ให้ค าปรึกษาการใช้งานระบบเครือข่ายแก่หน่วยงานภายในมหาวิทยาลัย 
7) งานดูแลและให้บริการศูนย์การเรียนรู้ด้วยตนเองทั้ง 4 แห่ง ได้แก่  

ศูนย์การเรียนรู้ด้วยตนเองเทเวศร์  
ศูนย์การเรียนรู้ด้วยตนเองพระนครเหนือ   
ศูนย์การเรียนรู้ด้วยตนเองพณิชยการพระนคร  
ศูนย์การเรียนรู้ด้วยตนเองโชติเวช 
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4. กลุ่มวิทยบริการ มีหน้าที่รับผิดชอบหลัก ดังนี้ 
1) งานพัฒนาทรัพยากรสารสนเทศ 
2) งานวิเคราะห์ทรัพยากรสารสนเทศ 
3) งานวารสารและเอกสาร 
4) งานเตรียมทรัพยากรสารสนเทศ 
5) งานเทคโนโลยีสารนิเทศ 
6) งานให้บริการสารสนเทศและห้องสมุด 4 แห่ง ได้แก่ 

งานห้องสมุดเทเวศร์ 
งานห้องสมุดโชติเวช 
งานห้องสมุดพณิชยการพระนคร 
งานห้องสมุดพระนครเหนือ 

5. กลุ่มพัฒนานวัตกรรมและเทคโนโลยีการศึกษา มีหน้าที่รับผิดชอบหลัก ดังนี้ 
1) งานวิจัยและพัฒนาสื่อการศึกษา 
2) งานผลิตสื่อโสตทัศน์ 
3) งานผลิตสื่อคอมพิวเตอร์ 
4) งานบริการทรัพยากรสื่ออิเล็กทรอนิกส์ 
 

2.2  บทบาทหน้าที่ความรับผิดชอบของต าแหน่ง 
1)  บทบาทหน้าที่ความรับผิดชอบของต าแหน่งตามมาตรฐานก าหนดต าแหน่ง 

 ต ามมาต ร ฐ านก า หนดต า แหน่ ง ส า ย ง านนั ก วิ ช า ก า ร ช่ า ง ศิ ล ป์ ที่  ก . พ . อ .  เ มื่ อ วั นที่   
21 กันยายน 2553 ฉบับแก้ไขเพ่ิมเติมครั้ งที่  1 เมื่อวันที่  1 กรกฏาคม พ.ศ. 2554 ระบุบทบาทหน้าที่                  
ความรับผิดชอบของสายงานของสายงานนักวิชาการช่างศิลป์ ระดับปฏิบัติการ ดังนี้ 
   ต าแหน่งประเภท  วิชาการ 
  ชื่อสายงาน   วิชาการช่างศิลป์ 
  ชื่อต าแหน่งในสายงาน  นักวิชาการช่างศิลป์ 
  ระดับต าแหน่ง   ปฏิบัติการ 

หน้าที่ความรับผิดชอบหลัก 
ปฏิบัติงานในฐานะผู้ปฏิบัติงานระดับต้นที่ต้องใช้ความรู้ความสามารถทางวิชาการในการปฏิบัติงาน

เกี่ยวกับงานด้านวิชาการช่างศิลป์ ภายใต้การก ากับ แนะน า ตรวจสอบและปฏิบัติงานอ่ืน ๆ ตามที่ได้รับ
มอบหมาย โดยมีลักษณะงานที่ปฏิบัติในด้านต่าง ๆ ดังนี้ 
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1. ด้านการปฏิบัติการ 
1) ศึกษา ค้นคว้า รวบรวมข้อมูลที่เกี่ยวข้องทางด้านศิลปกรรม และงานช่างสิบหมู่ เพ่ือเป็น

ข้อมูลในการออกแบบ เขียนแบบ อนุรักษ์ สร้างสรรค์งานด้านศิลปกรรม และรวบรวมองค์ความรู้ในการจัดท า
เอกสารทางวิชาการ 

2) ออกแบบ เขียนแบบ อนุรักษ์สร้างสรรค์งานศิลปกรรม และงานช่างสิบหมู่ เพ่ือการสืบทอด 
สร้างสรรค์ เผยแพร่ และประชาสัมพันธ์ 

3) ซ่อมงานศิลปกรรมและงานช่างสิบหมู่ เพ่ืออนุรักษ์ผลงานศิลปกรรมของไทยให้คงอยู่ต่อไป 
4) ร่วมจัดท าสื่อประชาสัมพันธ์ เ พ่ือเสริมสร้างความเข้าใจแก่ประชาชน และสืบทอด

ศิลปวัฒนธรรม 
5) ร่วมจัดนิทรรศการด้านศิลปกรรม เพ่ือเผยแพร่และประชาสัมพันธ์ 

  2. ด้านการวางแผน 
   วางแผนการท างานที่รับผิดชอบ ร่วมด าเนินการวางแผนการท างานของหน่วยงานหรือ
โครงการ เพ่ือให้การด าเนินงานเป็นไปตามเป้าหมายและผลสัมฤทธิ์ที่ก าหนด 
  3.  ด้านการประสานงาน 
  1)  ประสานการท างานร่วมกันทั้งภายในและภายนอกทีมงานหรือหน่วยงาน เพ่ือให้เกิดความ
ร่วมมือและผลสัมฤทธิ์ตามที่ก าหนด 
  2) ชี้แจงและให้รายละเอียดเกี่ยวกับข้อมูล ข้อเท็จจริง แก่บุคคลหรือหน่วยงานที่ เกี่ยวข้อง 
เพ่ือสร้างความเข้าใจหรือความร่วมมือในการด าเนินงานตามที่ได้รับมอบหมาย 
  4.  ด้านการบริการ 
   ให้ค าแนะน าความรู้ด้านศิลปกรรม แก่บุคคล หรือหน่วยงานที่เกี่ยวข้อง เพ่ือเผยแพร่ความรู้ 
  คุณสมบัติเฉพาะส าหรับต าแหน่ง 
  มีคุณสมบัติอย่างใดอย่างหนึ่งดังต่อไปนี้ 

1) ได้รับปริญญาตรีหรือคุณวุฒิอย่างอ่ืนที่เทียบได้ในระดับเดียวกัน ในสาขาวิชาวิจิตรศิลป์และ
ประยุกต์ศิลป์ หรือสาขาวิชาสถาปัตยกรรมศาสตร์ หรือสาขาวิชาใดสาขาวิชาหนึ่ง หรือหลายสาขาวิชาดังกล่าว 
ในทางที่ส่วนราชการเจ้าสังกัดเห็นว่าเหมาะสมกับหน้าที่ความรับผิดชอบ และลักษณะงานที่ปฏิบัติ หรือ
สาขาวิชาอ่ืนที่ ก.พ. ก าหนดว่าใช้เป็นคุณสมบัติเฉพาะส าหรับต าแหน่งนี้ได้ 

2) ได้รับปริญญาโทหรือคุณวุฒิอย่างอ่ืนที่เทียบได้ในระดับเดียวกัน ในสาขาวิชาวิจิตรศิลป์และ
ประยุกต์ศิลป์ หรือสาขาวิชาสถาปัตยกรรมศาสตร์ หรือสาขาวิชาใดสาขาวิชาหนึ่ง หรือหลายสาขาวิชาดังกล่าว 
ในทางที่ส่วนราชการเจ้าสังกัดเห็นว่าเหมาะสมกับหน้าที่ความรับผิดชอบ และลักษณะงานที่ปฏิบัติ หรือ
สาขาวิชาอ่ืนที่ ก.พ. ก าหนดว่าใช้เป็นคุณสมบัติเฉพาะส าหรับต าแหน่งนี้ได้ 

3) ได้รับปริญญาเอกหรือคุณวุฒิอย่างอ่ืนที่เทียบได้ในระดับเดียวกัน ในสาขาวิชาวิจิตรศิลป์และ
ประยุกต์ศิลป์ หรือสาขาวิชาสถาปัตยกรรมศาสตร์ หรือสาขาวิชาใดสาขาวิชาหนึ่ง หรือหลายสาขาวิชาดังกล่าว 
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ในทางที่ส่วนราชการเจ้าสังกัดเห็นว่าเหมาะสมกับหน้าที่ความรับผิดชอบ และลักษณะงานที่ปฏิบัติ หรือ
สาขาวิชาอ่ืนที่ ก.พ. ก าหนดว่าใช้เป็นคุณสมบัติเฉพาะส าหรับต าแหน่งนี้ได้ 

4) ได้รับปริญญาในสาขาวิชาหรือทางอ่ืนที่ อ.ก.พ. กรม พิจารณาเห็นว่ามีความรู้ที่เทียบได้ใน
ระดับเดียวกันกับสาขาวิชาหรือทางตามข้อ 1 หรือ ข้อ 2 หรือ ข้อ 3 ซึ่งมีความเหมาะสมกับหน้าที่ความ
รับผิดชอบและลักษณะงานที่ปฏิบัติ 

5) ได้รับปริญญาหรือคุณวุฒิอย่างอ่ืนที่ ก.พ. ก าหนดว่าใช้เป็นคุณสมบัติเฉพาะส าหรับต าแหน่งนี้
ได ้
  ความรู้ความสามารถ ทักษะ และสมรรถนะท่ีจ าเป็นส าหรับต าแหน่ง 

1. มีความรู้ความสามารถที่จ าเป็นส าหรับการปฏิบัติงานในต าแหน่ง 
2. มีทักษะที่จ าเป็นส าหรับการปฏิบัติงานในต าแหน่ง 
3. มีสรรถนะที่จ าเป็นส าหรับการปฏิบัติงานในต าแหน่ง 

2)  บทบาทหน้าที่ความรับผิดชอบของต าแหน่งตามท่ีได้รับมอบหมาย 
 บทบาทหน้าที่ความรับผิดชอบของ นายนรินทร์ จิตต์มั่นการ ต าแหน่ง นักวิชาการช่างศิลป์ ระดับ
ปฏิบัติการ ตามที่ได้รับมอบหมาย มีดังนี้  

1. งานออกแบบสื่ออินโฟกราฟิก 
- ประสานงานข้อมูลเนื้อหาที่ใช้ในการออกแบบสื่ออินโฟกราฟิก 
- ร่วมวางแผนการออกแบบสื่ออินโฟกราฟิก 
- ออกแบบและผลิตสื่ออินโฟกราฟิก 
- ปรับปรุงแก้ไขข้อผิดพลาดการออกแบบและผลิตสื่ออินโฟกราฟิก 
- สรุปผลการปฏิบัติงานการออกแบบและผลิตสื่ออินโฟกราฟิก 

2. งานออกแบบป้ายไวนิล ป้ายประชาสัมพันธ์ 
- ประสานงานข้อมูลการออกแบบป้ายไวนิล ป้ายประชาสัมพันธ์  
- ร่วมวางแผนการออกแบบป้ายไวนิล ป้ายประชาสัมพันธ์ 
- ออกแบบป้ายไวนิล ป้ายประชาสัมพันธ์ 
- ปรับปรุงแก้ไขข้อผิดพลาดการออกแบบป้ายไวนิล ป้ายประชาสัมพันธ์ 
- สรุปผลการปฏิบัติงานการออกแบบป้ายไวนิลและป้ายประสัมพันธ์ 

3. งานออกแบบฉากถวายพระพรเนื่องในวันเฉลิพระชนมพรรษา พระบาทสมเด็จพระวชิรเกล้า
เจ้าอยู่หัว  ,  สมเด็จพระนางเจ้าสุทิดา พัชรสุธาพิมลลักษณ พระบรมราชินี  และ                  
สมเด็จพระนางเจ้าสิริกิติ์ พระบรมราชินีนาถ พระบรมราชชนนีพันปีหลวง 
- ประสานงานจัดหาวัสดุในการออกแบบฉากวายพระพร กับหน่วยงานที่เกี่ยวข้อง 
- ร่วมวางแผน การจัดท าฉากถวายพระพร 
- ปรับปรุงแก้ไขข้อผิดพลาด 
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- บริการค าแนะน า ค าปรึกษาในด้านการออกแบบฉากถวายพระพร 
4. งานให้บริการด้านการออกแบบสื่อกราฟิกแก่หน่วยงานภายในและภายนอก ส านักวิทย

บริการและเทคโนโลยีสารสนเทศ 
- ประสานงานข้อมูลในการออกแบบสื่อกราฟิก กับหน่วยงานภายในและภายนอก 
- วางแผน การออกแบบสื่อกราฟิก ให้กับหน่วยงานภายในและภายนอก  
- บริการค าแนะน า ค าปรึกษาในด้านการออกแบบสื่อกราฟิก 

5. จัดเก็บและบ ารุงรักษาวัสดุ อุปกรณ์ท่ีใช้ในการออกแบบและผลิตสื่อกราฟิก 
- ตรวจเช็คครุภัณฑ์อุปกรณ์ท่ีใช้ในการออกแบบให้พร้อมใช้งานอยู่เสมอ 
- ตรวจสอบปริมาณวัสดุ อุปกรณ์ให้พร้อมใช้ในการผลิตสื่อ ,ฉากถวายพระพร 
- ตรวจสอบและท าการซ่อมแซมวัสดุ อุปกรณ์ท่ีช ารุดเสียหายในเบื้องต้น หากช ารุดเสียหาย

มาก ประสานงานด าเนินการซ่อมกับช่างผู้เชี่ยวชาญ หรือจัดหาวัสดุใหม่มาทดแทน 
6. ปฏิบัติงานอื่น ๆ ตามที่ได้รับมอบหมาย  

จากภาระหน้าที่ที่ได้รับมอบหมายดังกล่าวข้างต้นผู้เขียนได้สรุปกระบวนการท างานการออกแบบสื่อ
อินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยีสารสนเทศ ด้วยโปรแกรม Adobe Illustrator มาเขียนคู่มือ
การปฏิบัติงาน โดยมี Flow Chart ดังนี้  
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ภาพที่ 2-3  แสดงกระบวนการท างานการออกแบบสื่ออินโฟกราฟิก 

เริ่ม 

ผู้อ านวยการส านักวิทยบริการและเทคโนโลยีสารสนเทศ 
รองผู้อ านวยการส านักวิทยบริการและเทคโนโลยีสารสนเทศ 

หัวหน้ากลุ่มงานภายในส านักวิทยบริการและเทคโนโลยีสารสนเทศ 

ผู้ปฏิบัติงานก าหนดการวางแผนการออกแบบ 

รวบรวมเนื้อหาและจัดวางองค์ประกอบในการออกแบบ 

ผู้ปฏิบัติงานท าการออกแบบในโปรแกรมคอมพิวเตอร ์
Adobe Illustrator 

ส่งไฟล์งานให้ผู้มอบหมาย
งานตรวจสอบ 

ส่งไฟล์งานใหผู้้ปฏิบัติหน้าที่ ท าการอัพโหลดเพ่ือเผยแพร่ 

สิ้นสุดกระบวนการ 

ไม่ผ่าน 

ผ่าน 



บทท่ี 3 
หลักเกณฑ์วิธีการปฏิบัติงาน 

 
3.1  หลักเกณฑ์วิธีการปฏิบัติงาน 
 ในการจัดท าคู่มือการปฏิบัติงานเรื่อง การออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยี  
สารสนเทศ ด้วยโปรแกรมคอมพิวเตอร์กราฟิก Adobe Illustrator ของกลุ่มพัฒนานวัตกรรและเทคโนโลยี 
การศึกษา ส านักวิทยบริการและเทคโนโลยีสารสนเทศ มหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร ผู้จัดท าคู่มือ
มีหลักเกณฑ์วิธีการปฏิบัติงาน โดยมีทฤษฎีที่เกี่ยวข้อง ดังนี้  
 3.1.1  หลักการออกแบบกราฟิก  
  องค์ประกอบของศิลปะเป็นส่วนประกอบที่เป็นรากฐานส าคัญ ประกอบด้วย 
  3.1.1.1 ทิศทางและการเคลื่อนไหว 
   ทิศทาง (Direction) รูปร่างพ้ืนฐาน สี่เหลี่ยม สามเหลี่ยม หรือวงกลม เป็นการแสดงออก
ในเรื่องทิศทางต่างกัน คือ รูปสี่เหลี่ยมจะให้ความรู้สึกถึงทิศทางในแนวราบและตั้งฉาก รูปสามเหลี่ยมจะให้
ความรู้สึกถึงทิศทางในแนวเอียง ส่วนวงกลมให้ความรู้สึกเป็นแนวโค้ง ทิศทางเหล่านี้มีความหมายต่อการ
สร้างสรรค์ผลงาน เช่น ทิศทางในแนวนอนและแนวตั้งฉากจะให้ความรู้สึกถึงความมั่นคงทิศทางแนวเฉียงให้
ความรู้สึกที่ไม่คงที่ ไม่แน่นอน มึความเคลื่อนไหวอย่างเร็ว  ทิศทางในแนวโค้ง แสดงถึงความไม่อยู่กับที่ ดูช้า 
อบอุ่น 
     
 
 
 
 
 

ภาพที่ 3-1 ทิศทางน าสายตา 
 
  ความเคลื่อนไหว (Movement) การเคลื่อนไหว ให้ความรู้สึกท่ีไม่หยุดนิ่ง มีลักษณะคล้าย
กับจังหวะ ความเปลี่ยนแปรและการช้ า แต่มีความเร่งสูงกว่า คือ ดูแล้วมีความรวมเร็วในทางศิลปะ            
การเคลื่อนไหวจะท าให้เกิดการรับรู้ได้จากประสาทสัมผัสทางสายตา จากจุดหนึ่งไปยังจุดหนึ่งเคลื่อนที่ไปตาม
เส้น สี น้ าหนักอ่อนเข้ม ของรูปทรงกับที่ว่าง  ในการสร้างอารมณ์ ความรู้สึก ความหมายและเวลา การ
เคลื่อนไหวส่วนหนึ่งเกิดจากประสบการณ์รับรู้ของมนุษย์จากธรรมชาติ (ประเสริฐ, 2555) 
 
 

แนวตั้ง 

แนวนอน 

แนวเฉียง 
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 3.1.1.2 เอกภาพและความกลมกลืน  
   เอกภาพ หมายถึง การประสานหรือจัดระเบียบของส่วนต่าง ๆ ระหว่างองค์ประกอบใน
การออกแบบ เพ่ือให้มีความเป็นอันหนึ่งอันเดียวกันและอยู่ร่วมกันได้ดี สอดคล้องกัน ไม่ขัดแย้งกันไปคนละทิศ
คนละทาง ช่วยให้เกิดความเด่นชัดในเนื้อหาและรูปแบบ 
   วิธีการออกแบบเพ่ือให้เกิดเอกภาพในชิ้นงานนั้นมีด้วยกันหลากหลายวิธี แต่วิธีที่จะ
กล่าวถึงนี้เป็นวิธีการทีสามารถสร้างเอกภาพในชิ้นงานออกแบบซึ่งสามารถแบ่งได้ดังนี้ 

1. การใช้รูปทรงแบบง่าย ๆ และตรงไปตรงมา เช่นรูปทรงเรขาคณิต 
2. การใช้จังหวะการออกแบบให้มีความสัมพันธ์กัน เช่น การใช้จังหวะที่ซ้ าหรือ

ต่อเนื่องกัน 
3. การใช้หลักความสมดุลหรือการสร้างดุลยภาพในการออกแบบ 
4. การใช้ความกลมกลืนของรูปทรงและขนาดให้สอดคล้องกัน 
5. การใช้ความกลมกลืนและสัมพันธ์กันในส่วนของ วัสดุ สี โครงสร้าง และส่วนประกอบ

ทีน่ ามาตกแต่ง 
6. การสร้างจุดสนใจ หรือ จุดเด่น ในต าแหน่งหรือรูปแบบที่เหมือนหรือสัมพันธ์กัน 
7. การก าหนดต าแหน่งองค์ประกอบได้มีความใกล้ชิด ไม่กระจัดกระจาย 
8. การสร้างรูปแบบให้มีความสอดคล้องในด้านประโยชน์ใช้สอยหรือการสื่อความหมาย

ที่สัมพันธ์กัน (สมสกุล, 2546) 
   เอกภาพในทางงานศิลปะ หมายถึง การประสานกันของส่วนต่าง ๆ เพ่ือให้เกิดความเป็น
หนึ่งเดียวกัน เช่น เรื่อง แนวเรื่อง และรูปทรง ที่มีความขัดแย้งกัน ให้เกิดความประสานกันอย่างมีระเบียบ และ
ดุลยภาพ เอกภาพทางศิลปะ ประกอบด้วย 

1. เอกภาพทางความคิด เป็นการคิดริเริ่มของรูปความคิดที่เป็นโครงสร้างหลักที่มี
ความหมาย ที่เป็นแนวผลักดันต่อการสร้างสรรค์รูปทรง 

2. เอกภาพทางรูปทรง คือ การรวมตัวกันอย่างมีเอกภาพ มีระเบียบขององค์ประกอบ
ทรงศิลปะ เป็นการรวมตัวกันของทัศนธาตุต่าง ๆ เพ่ือให้เกิดเป็นรูปทรงหนึ่งที่
สามารถแสดงความคิด และอารมณ์ได้อย่างชัดเจน เอกภาพของรูปทรงเป็นสิ่งส าคัญ
ที่สุดในการสื่อความงามและการสื่อความหมาย  

3. เอกภาพทางการแสดงออก เป็นการแสดงออกในรูปความคิด ที่มีจุดหมายเดียวที่
ประกอบด้วยแนวเรื่อง ความคิดและอารมณ์ท่ีใช้เป็นสื่อในการแสดงออก 

เอกภาพในงานศิลปะมีอยู่ด้วยกัน 2 ลักษณะ คือ  
1. เอกภาพท่ีอยู่กับที่ (Static Unity) จะมีรูปลักษณะที่ไม่เปลี่ยนแปลง มีความคล้ายคลึง

กัน ต่อเนื่องกัน ส่วนมากจะเป็นการจัดกลุ่มของรูปร่างหรือรูปทรงทางเรขาคณิต
เอกภาพในลักษณะนี้จะให้ความรู้สึกแข็งกระด้าง มั่นคง ไม่เคลื่อนไหว 
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2. เอกภาพที่เคลื่อนไหว (Dynamic Unity) มีลักษณะเปลี่ยนแปลงได้ มีลีลาคาม
เคลื่อนไหว จะสร้างความน่าสนใจได้มากกว่า รูปทรงหรือรูปร่างส่วนใหญ่เป็นแบบ
อิสระเอกภาพในลักษณะนี้จะให้ความรู้สึกเคลื่อนไหว 

ในการสร้างเอกภาพในงานศิลปะ มีลักษณะดังนี้ 
- ลักษณะการขัดแย้ง (Opposition) ของทัศนธาตุ รูปทรง ขนาด ทิศทาง จังหวะ และ

ที่ว่าง 
- ลักษณะการประสาน (Transition) โดยมีตัวกลางเป็นตัวช่วยลดความขัดแย้งและ 

การซ้ า เพ่ือลดความส าคัญ 
นอกเหนือจากลักษณะ การขัดแย้ง และการประสานยังมีความเด่นที่เกิดจากการขัดแย้ง 

การประสานและการเปลี่ยนแปรของลักษณะขนาด ทิศทาง และจังหวะ  
ความกลมกลืน (Harmony) หมายถึง การประสานกัน ความเป็นอันหนึ่งอันเดียวกัน 

ปรองดองไม่ขัดแย้งกัน แต่ในทางศิลปะนั้น ความกลมกลืน คือ การรวมกันของหน่วยย่อยต่าง ๆ ให้กลมกลืน
กัน ซึ่งได้แก่ จุด เส้น รูปร่าง รูปทรง สี พ้ืนผิว ฯลฯ และการจัดวางองค์ประกอบ เช่น ที่ว่าง จังหวะ เพ่ือให้เกิด
ความประสานกัน หากผลงานทางศิลปะมีความกลมกลืนเพียงอย่างเดียว หรือมีมากเกินไป จะท าให้เกิดความ
น่าเบื่อได้ ดังนั้นจึงต้องเพ่ิมความขัดแย้ง หรือความแตกต่างเข้าไป เพ่ือลดความน่าเบื่อและท าให้งานดูมีความ
น่าสนใจมากยิ่งขึ้น ความกลมกลืนอาจแบ่งได้ดังนี้ 

1. ความกลมกลืนด้วยเส้น เป็นการน าเส้นลักษณะเดียวกัน ขนาดเดียวกัน ทิศทาง 
เดียวกันมาจัดให้มีความกลมกลืนกัน 

2. ความกลมกลืนด้วยขนาด เป็นการน าองค์ประกอบขนาดเท่าเทียมกันหรือใกล้เคียงกัน
มาจัดวางไว้รวมกัน 

3. ความกลมกลืนด้วยลักษณะผิว เป็นการน าลักษณะของผิวที่เหมือนกัน หรือใกล้เคียง
กันมาจัดรวมเป็นองค์ประกอบเดียวกัน 

4. ความกลมกลืนกันของสิ่งทีเหมือนกัน คือ การน าองค์ประกอบที่มีลักษณะเหมือนกัน
มาจัดรวมกัน เพ่ือให้เกิดความกลมกลืนกัน 

5. ความกลมกลืนของสิ่งที่คล้ายกัน เป็นการน าองค์ประกอบที่มีลักษณะคล้ายกันแต่ไม่
เหมือนกัน มาจัดรวมกันจนเกิดความกลมกลืนกัน 

ความกลมกลืนกันด้วยสี หมายถึง การเลือกใช้สีในวรรณะเดียวกัน หรือการใช้สีเดียวกัน
ที่เรียกว่าสีเอกรงค์ เช่น การใช้สีแดงสีเดียวในการไล่น้ าหนักจากอ่อนไปเข็ม หรือการใช้สีใกล้เคียงกันมาจัด
องค์ประกอบเข้าด้วยกัน จะท าให้เกิดความกลมกลืนกันด้วยสี ซึ่งนอกจากนี้ยังมีการกลมกลืนกันของเนื้อหา 
ถึงแม้ว่าลักษณะจะไม่สัมพันธ์กัน แต่มีเนื้อหาเดียวกัน เช่น ดินสอ กระดาษ ยางลบ ไม้บรรทัด ที่หนีบกระดาษ  
เมื่อน าภาพของเนื้อหาเหล่านี้มารวมกัน แม้จะมีรูปลักษณ์ขัดแย้งกันก็ตาม แต่ในทางเนื้อหาแล้ว ภาพก็ดูมี
ความสัมพันธ์กันแล้วน าไปสู่ความเป็นเอกภาพได้เช่นกัน (ประเสริฐ, 2555)  



การออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยสีารสนเทศ ด้วยโปรแกรม Adobe Illustrator | 19  

3.1.1.3  ความสมดุล 
  ความสมดุล (Balance) ในการออกแบบมาจัดวางให้เกิดความเสมอกัน เท่าเทียมกัน

เป็นการกระจายน้ าหนักภายในผลงานให้เกิดความรู้สึกไม่หนักไปด้านใดด้านหนึ่ง ทั้งตามที่ตามองเห็นและตาม
ความรู้สึก โดยความสมดุลอาจเกิดทั้งแนวตั้งหรือแนวนอนก็ได้ ส าหรับงานออกแบบมีวิธีมากมายที่จะท าให้เกิด
ความสมดุลขึ้น โดยจะต้องค านึงถึงจุดศูนย์ถ่วงตรงกลางผลงาน เพ่ือเป็นการเฉลี่ยน้ าหนักขององค์ประกอบ 
ต่าง ๆ โดยรอบ การสร้างสมดุลนั้นช่วยให้ผลงานเกิดความมั่นคงและดูน่าสนใจ ซึ่งโดยทั่วไปแล้วสามารถแบ่ง
ความสมดุลออกเป็น 3 แบบด้วยกัน คือ  

1. แบบซ้ายขวาเหมือนกันหรือคล้ายกัน (symmertrical or formal balance) คือ 
การจัดวางองค์ประกอบต่าง ๆ ห่างจากเส้นแกนกลางให้ด้านซ้ายและขวาเท่ากัน 
ความสมดุลแบบนี้จะให้ความรู้สึกมั่นคง เป็นทางการ แข็งแรง สง่างาม สงบนิ่งและ
ยุติธรรม เหมาะสมกับงานการออกแบบที่ต้องการความเป็นระเบียบแบบแผน  

2. แบบซ้ายขวาไม่เท่ากัน (asymmetrical or informal balance) คือการจัดวาง
องค์ประกอบทั้งด้านซ้ายและขวา มีลักษณะต่างกันหรือไม่เท่ากัน แต่ให้ความสมดุล
ทางด้านความรู้สึก ความสมดุลแบบนี้สามารถสร้างความรู้สึกขัดแย้ง ไม่เป็นระเบียบ 
ความหลากหลายและความเคลื่อนไหว จึงเหมาะในงานที่ต้องการความตื่นตาตื่นใจ 
แปลกใหม่  

3. แบบรัศมีหรือวงขด (radial or spiral balance) คือการจัดวางองค์ประกอบให้เกิด
ความสมดุล โดยแผ่จากจุดศูนย์กลางแล้วกระจายออกไปโดยรอบคล้ายกับรัศมี มัก
ใช้ ในงานออกแบบเครื่องประดับ งานหัตถกรรม ลวดลายที่ประดับตาม
สถาปัตยกรรมหรือเฟอร์นิเจอร์  

3.1.1.4 สัดส่วน 
 สัดส่วน หมายถึง ความสัมพันธ์ระหว่างส่วนประกอบของรูปร่างหรือรูปทรงของตนเอง

และความสัมพันธ์ที่เปรียบเทียบกับรูปทรงรูปร่างของสภาพแวดล้อมโดยรอบ มีสัดส่วนที่เหมาะสมกลมกลืน
สมเหตุสมผลใช้ประโยชน์ได้ดี ให้ความงดงามน่าสนใจและสร้างความพึงพอใจต่อผู้พบเห็นได้ (สมสกุล, 2546) 

 ความเหมาะสมของสัดส่วนท าให้เกิดความงดงามมากขึ้น ในทางด้านศิลปะนั้นสัดส่วน
ถูกสร้างขึ้นเพ่ือเน้นความงามของรูปทรง และเพ่ือการแสดงออกของอารมณ์ความรู้สึก ให้เป็นไปตามความ
ต้องการของผู้สร้างงานศิลปะ ดังนั้น สัดส่วนจึงเป็นเรื่องของอุดมคติ และเป็นสุนทรียภาพที่ขึ้นกับประสบการณ์
ของผู้สร้างผลงาน เหมาะสมของสัดส่วนอาจพิจารณาจากคุณลักษณะ ดังนี้ 

1. สัดส่วนจากความรู้สึก โดยที่ศิลปะนั้นไม่ได้สร้างขึ้นเพ่ือความงานของรูปทรงเพียง
อย่างเดียว แต่ยังสร้างขึ้นเพ่ือแสดงออกถึงเนื้อหา เรื่องราว ความรู้สึก ซึ่งสัดส่วนจะ
มีส่วนช่วยเน้นอารมณ์ ความรู้สึกให้เห็นเป็นไปตามเจตนารมณ์ และเรื่องราวที่ศิลปิน
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ต้องการลักษณะเช่นนี้ท าให้งานศิลปะของชนชาติต่าง ๆ มีลักษณะแตกต่างกัน 
เนื่องจากมีเนื้อหา เรื่องราว อารมณ์ ความรู้สึก ความเชื่อ ความศรัทธา ที่ต่างกัน 

2. สัดส่วนที่ดูเป็นมาตรฐาน จากรูปลักษณะตามธรรมชาติของคน สัตว์ พืช ซึ่ง
โดยทั่วไปถือว่า สัดส่วนตามธรรมชาติจะมีความงามที่เหมาะสมที่สุด เช่นเดียวกับ
สัดส่วนต่าง ๆ ของร่างกายมนุษย์ ที่เป็นแม่บทอิทธิพลต่อสัดส่วนของความงามทาง
ศิลปะและการออกแบบที่สร้างขึ้นต้องมีความสัมพันธ์กับมนุษย์ในฐานะเป็นผู้ใช้ ผู้
ชื่นชม และเป็นสิ่งที่ครอบคลุมสิ่งมีชีวิตทั้งหลายที่มนุษย์คุ้นเคย หรือจากรูปลักษณ์ที่
เป็นการสร้างสรรค์ของมนุษย์ การใช้หรือการแบ่งสัดส่วนในการสร้างสรรค์ จะ
เป็นไปตามหลักทางเอกภาพของความขัดแย้งและประสานที่เหมาะสม ซึ่งมีพลัง
ความเคลื่อนไหวที่สมดุล 

3.1.1.5 ความแตกต่าง  
  ความแตกต่าง หมายถึง การจัดองค์ประกอบของการออกแบบที่ไม่ประสานกันของ

ส่วนประกอบภายใน เพื่อลดความซ้ าซากท่ีเกิดจากการจัดองค์ประกอบของการออกแบบที่ดูกลมกลืนและเรียบ
มากเกินไป เพ่ือแปรเปลี่ยนให้ผลงานดูเด่นและเกิดความน่าสนใจ 

 การสร้างความแตกต่าง มีด้วยกันหลากหลายลักษณะ เช่น การสร้างความแตกต่างด้วย
รูปร่าง ขนาด สี พ้ืนผิว ทิศทาง ฯลฯ แต่อย่างไรก็ตามสามารถแบ่งการสร้างออกเป็นกลุ่มใหญ่ ได้ 10 ประการ
ตามลักษณะต่าง ๆ ดังต่อไปนี้ 

1. การสร้างความแตกต่างด้วยรูปร่าง การตัดกันของรูปร่างสามารถพิจารณาได้จาก
หลายปัจจัย เช่น การตัดกันของรูปร่างเรขาคณิตกับรูปร่างทางธรรมชาติ หรือรูปร่าง
เราคณิต 2 รูปที่มีความแตกต่างกัน เช่นรูปหนึ่งเป็นรูปทรงเหลี่ยมในอีกรูปแบบหนึ่ง
เป็นรูปทรงกลม หรือการเขียนรูปร่างทีใช้เครืองมือกับรูปที่เขียนด้วยลายเส้นอิสระ 

2. การสร้างความแตกต่างจากขนาด ได้แก่การสร้างความแตกต่างโดยให้เกิดความ
แตกต่างในด้านของขนาด เช่นการตัดกันของขนาดใหญ่และเล็ก 

3. การสร้างควมแตกต่างจากการตัดกันของสี สามารถท าได้ด้วยกันหลายวิธี เช่น น า
ความแตกต่างของสีร้อนและสีเย็นมาใช้ ท าให้เกิดความรู้สึกในการมองที่สามารถ
มองเห็นได้ชัดเจน ดังนั้น ในการตัดกันของสีจึงมีผลต่อความสว่างและมืด ความ
สดใสและขุ่นมัว ความร้อนและความเย็น เป็นต้น 

4. การสร้างความแตกต่างจากลักษณะของพ้ืนผิว ลักษณะของพ้ืนผิวมีด้วยกัน
หลากหลายชนิด ดังนั้นจึงสามารถสร้างความแตกต่างจากพ้ืนผิวได้ เช่น พ้ืนผิวที่
เรียบคู่กับพ้ืนผิวที่ขรุขระ พ้ืนผิวที่ละเอียดคู่กับพ้ืนผิวที่หยาบ พ้ืนผิวที่มันวาวกับ
พ้ืนผิวที่ด้าน เป็นต้น 
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5. การสร้างความแตกต่างจากการตัดกันของทิศทาง ความแตกต่างกันของทิศทาง
เกิดขึ้นเมื่อองค์ประกอบของทิศทางท ามุมกันเท่ากับ 90 องศาและการก าหนด
ต าแหน่งของรุปทรงในลักษณะคู่ขนานกันท าให้เกิดความรู้สึกท่ีแตกต่างกันได้ชัดเจน 

6. การสร้างความแตกต่างจากการก าหนดต าแหน่ง จะเห็นได้ว่ามีความสัมพันธ์กับ
กรอบศูนย์กลาง เช่น ต าแหน่งบนและล่าง ต าแหน่งซ้ายและขวา ต าแหน่งศูนย์กลาง
และชิดขอบ 

7. การสร้างความแตกต่างจากมาตราส่วน โดยการบิดเบือนมาตราส่วนของวัตถุ 2 ชนิด 
ภายใต้สัดส่วนที่แตกต่างกัน เช่น สัดส่วนของคนคู่กับกล่องขอวขวัญขนาดยักษ์ที่ท า
ให้ใหญ่โตผิดกับสัดส่วนปกติ 

8. การสร้างความแตกต่างจากการตัดกันของที่ว่าง จะเป็นการตัดกันของที่ว่างใน
ลักษณะบวกและลบ ซึ่งจะช่วยให้เราเห็นที่ว่างนั้นดูอัดแน่นหรือแผ่ขยาย รวมถึงที่
ว่างในลักษณะที่ลวงตา ให้เกิดความรู้สึกใกล้ ไกล แบน ราบหรือ สามมิติ 

9. การสร้างความแตกต่างจากแรงโน้มถ่วง การสร้างความแตกต่างในลักษณะนี้มี
ด้วยกัน 2 ชนิด คือ ความมั่นคงกับความไม่มั่นคงและความรู้สึกเบากับความรู้สึก
หนัก โดยความมั่นคงกับความไม่มั่นคง มักขึ้นอยู่กับทิศทางตามแนวตั้ง แนวนอน 
หรือแนวทแยง รวมถึงรูปทรงขององค์ประกอบนั้นด้วย ในขณะที่ความรู้สึกเบากับ
ความรู้สึกหนัก อิทธิพลของสีนั้นมีผลอย่างมากควบคู่กับรูปทรงและขนาดของ
องค์ประกอบนั้น 

10. การสร้างความแตกต่างจากโครงสร้าง ที่แสดงความแตกต่างมักพบจากโครงสร้างที่
ไม่มีแบบแผน ซึ่งมักจะขาดกฏเกณฑ์หรือระเบียบที่ชัดเจนท าให้องค์ประกอบใน
โครงสร้างนั้นมีความแตกต่างกัน โครงสร้างทีไ่ม่มีแบบแผนนั้นจะไม่มีเส้นโครงสร้าง
ของรูปทรงจะอยู่กันอย่าง อิสระ ในขณะที่ โครงสร้างที่มีแบบแผนนั้นจะ
ประกอบด้วยโครงสร้างที่มีการจัดระเบียบวิธีที่แน่นอน  

ในการรวบรวมจัดระบบโครงสร้างที่แตกต่าง ไม่มีกฏเกณฑ์ที่ตายตัว รูปร่างและขนาด
ของหน่วยรูปทรงสามารถปรับเปลี่ยนไปได้ตามความจ าเป็น ความคล้ายคลึงมิได้เกิดขึ้นจากส่วนประกอบที่
มองเห็นได้ในแต่ละตัวเท่านั้น แต่ยังเกิดจากส่วนประกอบที่มีความสัมพันธ์กันอย่างมีเอกภาพ ด้วยการตัดกัน
หรือการสร้างความแตกต่างกันในบางโอกาส เพ่ือสร้างความน่าสนใจและความรู้สึกที่ตื่นเต้นให้กับผลงาน 
ส่วนประกอบที่สัมพันธ์กันก่อให้เกิดโครงสร้างที่แตกต่างสามารถแบ่งได้ดังต่อไปนี้ 

1. ทิศทาง รูปทรงต่างๆ อาจมีทิศทางส่วนใหญ่ที่คล้ายคลึงกัน แต่ก็มีบางหน่วยที่มี
ทิศทางที่แตกต่างกัน เพ่ือจุดประสงค์ที่สร้างความน่าสนใจและความตื่นเต้นใน
ชิ้นงาน แต่โครงสร้างโดยรวมก็ยังคงความเป็นเอกภาพ แม้ว่าทิศทางจะแตกต่าง
กัน 
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2. ต าแหน่ง โดยการจัดหน่วยของรูปทรงที่มีอยู่ให้อยู่ในต าแหน่งตรงข้ามบริเวณ
กรอบของรูป หรือภาพ เพ่ือสร้างแรงดึงดูดระหว่างกัน 

3. ที่ว่าง รพบกันของหน่วยรูปทรงบวกและลบ ท าให้เกิดความแตกต่างของที่ว่าง 
ที่ว่างนั้นจะถูกผลักหรือบีบโดยรูปทรงต่าง ๆ ซึ่งการผลักดันของกันและกันจะ
เหลือที่ว่างขึ้น ซึ่งจะตัดกับพ้ืนที่ที่แออัด 

4. แรงโน้มถ่วงหรือแรงดึงดูด หน่วยรูปทรงที่ตกจากที่สูงลงสู่ที่ต่ า หรือกลับกันจาก
ที่ต่ าขึ้นที่สูง ซึ่งเป็นตัวเสมือนแรงโน้มถ่วงหรือรงดึงดูดหน่วยรูปทรงสามารถ
แสดงให้เห็นถึงความมั่นคง ความไม่มั่นคง การเคลื่อนที่หรือการอยู่นิ่ง ความ
หนักหรือเบา สามารถน ามาจัดรวมกันและก่อให้เกิดแรงโน้มถ่วงหรือแรงดึงดูด
ที่แตกต่างกัน (สมสกุล, 2546) 

3.1.1.6 จังหวะ ลีลา และการซ้ า 
 จังหวะ (Rhythm) คือ ลักษณะของการเคลื่อนไหวที่ถี่ ห่าง หรือต่อเนื่องกัน เป็นการ

ซ้ าอย่างมีระเบียบ มีเอกภาพ มีความหมาย คือ เป็นการซ้ าของทัศนธาตุ เช่น น้ าหนัก สี รูปร่าง รูปทรง พ้ืนผิว 
เป็นการสลับกันของการเน้น และการผ่อนคลาย การท างานของทัศนธาตุต่าง ๆ เพื่อให้เกิดเอกภาพในเรื่องของ
จังหวะนั้นมีอยู่ในทุกท่ี 

 จังหวะเกิดจากการสลับกันของรูปทรงและที่ว่าง จังหวะลีลาจึงหมายถึงการไหลที่มี
ความแตกต่างกันของจังหวะที่ช้าหรือเร็ว ที่ต่อเนื่องกันของเส้น รูปทรงหรือน้ าหนักกับพ้ืนที่ว่างจะเป็นตัวคงท่ี  
แต่จังหวะจะเป็นตัวก าหนดให้เกิดความช้าเร็ว หรือความถี่ ดังนั้น จังหวะของรูปทรง จะเคลื่อนไหวไปในพ้ืนที่
ว่าง ท าให้เกิกความรู้สึกถึงเวลาที่เคลื่อนไป 

 ลักษณะการเกิดของจังหวะแบ่งได้ 3 ประเภท คือ 
1. จังหวะการเกิดซ้ ากัน (Repetition Rhythm) หมายถึง ช่วงของจังหวะที่มีการซ้ า

กันตั้งแต่สองหน่วยขึ้นไปของเส้น สี น้ าหนัก รูปร่าง รูปทรง โดยมีที่ว่างคั่นอยู่
ระหว่างรูปทรงหรือรูปร่าง 

2. จังหวะเกิดจากการต่อเนื่อง (Continuous Rhythm) หมายถึง การเคลื่อนไหวที่มี
จังหวะของเส้น สี น้ าหนัก รูปทรง รูปร่าง ที่ต่อเนื่องโดยไม่มีพ้ืนที่ว่างมากั้น การ
ก าหนดจังหวะอยู่ที่บริเวณของวัตถุเอง เช่น คลื่นในทะเล ที่ลื่นไหลไปอย่างต่อเนื่อง 
สม่ าเสมอ ไม่ขาดระยะ 

3. จังหวะเกิดจากการต่อเนื่องก้าวหน้า (Progressive Rhythm) หมายถึง การเพ่ิมขึ้น
ของค่าระดับความเข้ม เร็ว หรือความจาง ช้า ที่เกิดจากเส้น รูปร่าง รูปทรง น้ าหนัก 
สี เป็นต้น เป็นการสร้างระยะของจังหวะให้เปลี่ยนแปลงไปทีละน้อย และถ้าใช้
จังหวะสลับกันก็จะเพ่ิมความซับซ้อนมากขึ้น 
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  โดยสรุป ความรู้สึกในจังหวะจะเป็นอย่างเดียวกัน แต่แตกต่างกันในการแสดงออกและ
รูปแบบเท่านั้น จังหวะที่มาสร้างสรรค์งานศิลป์ ได้แก่ การเคลื่อนไหวของคน สัตว์ การเติบโตของพืชและสัตว์ 
การเต้นร า ลม ฝน หรือการเคลื่อนไหวของเครืองจักรกล น ามาใช้เป็นแรงบันดาลใจในการท างาน                  
(ประเสริฐ, 2555) 
  ลีลา (Rhythm) หมายถึง รูปแบบของการเคลื่อนไหวที่ต่อเนื่องซ้ าๆ กัน ของสิ่งใดสิ่ง
หนึ่งในช่วง “ระยะเวลาหนึ่ง” ลีลาจะปรากฏอยู่ทั่วไปในกิจกรรมของมนุษย์ หรือธรรมชาติ  ตราบเท่าที่ยังมี
ความเคลื่อนไหวปรากฏอยู่ ลีลาจะหมดสิ้นไป หากสิ่งนั้นปราศจากความเคลื่อนไหวใด ๆ เช่น ลีลาการเดินของ
คน ๆ หนึ่ง ลีลาการพูด ลีลาการเต้นร า ลีลาการบินของสัตว์ ฯลฯ 
  องค์ประกอบของลีลา ประกอบด้วยส่วนส าคัญ 2 ประการ คือ 

1. ความเคลื่อนไหว (Motion) หมายถึง ความเคลื่อนไหว หรือ ความรู้สึกไม่หยุดนิ่ง
อาจเคลื่อนไหวรุนแรง แผ่วเบา หรือสม่ าเสมอก็ได้ ในทางทัศนศิลป์ ความ
เคลื่อนไหวสามารถท าได้หลายวิธีการ ได้แก่ การกระจายของสี (Prograssion of 
Colors) การซ้ าๆ กันของรูปทรง (Repetition of Forms) การเปลี่ยนแปลงของ
รูปทรง (Development of Forms) การเปลี่ยนแปลงค่าของแสงเงา (Nuance of 
Tones) การเปลี่ยนแปลงพื้นผิว (Modulation of Texture) 

2. เวลา (Time) คือช่วงเวลาระหว่างความต่อเนื่องของความเคลื่อนไหว (ระหว่าง
ความเคลื่อนไหวครั้งแรกกับครั้งที่ 2 และครั้งต่อไป) ซึ่งอาจต้องใช้ระยะเวลาหนึ่ง 
เช่น ลีลาของการเดิน มิได้หมายถึงการเดินเพียงก้าวเดียว แต่หมายถึงการเดิน
หลาย ๆ ก้าว จากจุดหนึ่งไปยังจุดหนึ่งต้องใช้ช่วงระยะเวลาหนึ่ง ฉะนั้นการเดิน
เพียงกา้วเดียว เสียงกลองเพียงครั้งเดียว จึงไม่ใช่ลีลา เพราะขาดความต่อเนื่องของ
ความเคลื่อนไหว ขาดระยะเวลา 

ลีลาในงานศิลปะ ในงานทัศนศิลป์ ลีลาอาจเกิดขึ้นได้จากองค์ประกอบศิลป์เพียงตัว
เดียวหรือองค์ประกอบศิลป์หลาย ๆ ตัว สร้างความเคลื่อนไหวซ้า-เร็ว งานใดที่ปราศจากลีลา จะท าให้งานดู
แข็งตรงกันข้ามกับงานที่มีลีลารุนแรง ท าให้ภาพมีพลังชีวิตชีวา งานที่มีจังหวะเคลื่อนไหวเนิบนาบให้อารมณ์
สงบ ลีลาในงานศิลปะคล้ายลีลาของชีวิต ก่อนให้เกิดอารมณ์และความรู้สึกได้ การใช้สีหนึ่ง ๆ หลาย ๆ ครั้งใน
งานชิ้นหนึ่ง สามารถสร้างลีลาบางอย่างได้ บางครั้งเราจะรู้สึกเหมือนเคลื่อนไหวแผ่วเบา  นุ่มนวล อ่อนหวาน 
บางครั้งการใช้สีรุนแรงตัดกันซ้ าๆ  กันให้ความรู้สึกเคลื่อนไหวรุนแรงตามไปด้วย  

รูปแบบของลีลา มีหลายลักษณะบางครั้งดูรวดเร็ว บางครั้งดูสงบ เคลื่อนที่สู่ส่วนบน
หรือก้าวคืบไปข้างหน้า ซึ่งแบ่งได้ 5 ลักษณะ  ดังนี้  

1. ลีลาซ้ าๆ กัน (Repetition Rhythm or Metric Rhythm) 
2. ลีลาก้าวหน้า (Progression Rhythm or Flowing Rhythm) 
3. ลีลาต่อเนื่อง (Contionous Rhythm) 
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4. ลีลาหมุนรอบตัว (Swirling Rhythm) 
5. ลีลากระจายสู่อากาศ (Climatic Rhythm) 
การท าซ้ า (Repetition) หมายถึง การสร้าง หรือกระท าสิ่ใดสิ่งหนึ่งซ้ าๆ กันมากกว่า 1 

ครั้ง เช่น สร้างรูปต้นไม้ 1 ต้นขึ้นในภาพ แล้วสร้างรูปต้นไม้เหมือนเดิม หรือคล้ายกันข้ึนอีก 1 รูป หรือมากกว่า
จัดวางในภาพเดียวกัน ถ้าเปรียบเทียบการซ้ ากันกับกิจกรรมของมนุษย์  

1. ลักษณะการท าซ้ า มีหลายลักษณะสิ่งของที่คล้ายคลึงกัน เมื่ออยู่รวมกันให้
ความรู้สึกซ้ าๆ กันได้ สิ่งของหลาย ๆ อย่างแตกต่างกัน แต่ชุดของความแตกต่างนั้นเกิดขึ้นซ้ าๆ กัน ก็สามารถ
ให้ความรู้สึกซ้ า ๆ กัน ได้ ลักษณะของการซ้ ามีหลายลักษณะดังนี้ 

- การซ้ าเหมือนกันทุกประการ (Exact Repetition) หมายถึง การซ้ าตัวมันเอง
เป็นการสร้างรูปแบบเหมือนต้นฉบับ ไม่ว่าจะเป็นรูปร่าง ผิว สี น้ าหนัก 
ระยะห่าง (หรือเวลาของการซ้ า) และทิศทาง 

- การซ้ าของสิ่งที่คล้ายกัน (Familiar Repetition) เป็นการซ้ าของสิ่งที่คล้ายกัน 
เป็นการน าสิ่งที่ไม่เหมือนกันแต่ดูคล้ายกันมาท าซ้ า ท าให้ดูเกิดความน่าสนใจ 

- การซ้ าในลักษณะสลับกันอย่างต่อเนื่อง (Alternation Repetition) เป็นการซ้ า
ของสิ่งที่ไม่เหมือนกัน สลับกันไปมาอย่างต่อเนื่อง การซ้ าลักษณะนี้ให้ความ
น่าสนใจได้ด ี

- การซ้ าในลักษณะกลับด้าน (Reversible Repetition) เป็นการซ้ าของสิ่งของที่
เหมือนกันแต่กลับซ้ายเป็นขวา หรือจากด าเป็นขาวต่อเนื่องไปเรื่อยๆ  

- การซ้ าในลักษณะเปลี่ยนทีละน้อย (Gradation Repetition) เป็นการซ้ าใน
ลักษณะการลดหลั่น (Gradation) กล่าวคือ ลักษณะโดยรวมค่อย ๆ เปลี่ยนไป 
เช่น การเปลี่ยนน้ าหนักในขณะที่รูปร่าง และระยะห่างยังคงเดิม 

2. จุดมุ่งหมายของการท าซ้ า ในการท าซ้ าสามารถน าไปใช้ในการสร้างงานศิลปะได้
หลากหลาย เช่น  

- เพ่ือตกแต่งขอบริมวัตถุ เป็นการแก้ปัญหาบริเวณว่างอย่างหนึ่ง ขณะเดียวกันท า
ให้บริเวณขอบริมวัตถุได้รับความน่าสนใจ เช่น การท าซ้ าของลายเชิงผ้าซิ่น ขอบ
จาน ริมผ้าเช็ดหน้า การท าซ้ าในกรณีนี้มักใช้วิธีการท าซ้ าของรูปที่เหมือนกัน
ต่อเนื่องกันไป 

- เพ่ือสร้างลวดลายให้กับบริเวณว่าง บริเวณพ้ืนที่ว่างหากปล่อยทิ้งไว้จะให้
ความรู้สึกว่างเปล่า ไม่น่าสนใจ การท าซ้ าในลักษณะสร้างลวดลายจะช่วย
แก้ปัญหาดังกล่าวได้ 
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- การท าซ้ าเพ่ือให้เกิดทิศทางความเคลื่อนไหว เป็นการท าซ้ าเพ่ือบังคับสายตา
ของผู้มอง ให้มองไปทางใดทางหนึ่งที่ต้องการ การท าซ้ าแบบนี้ใช้วิธีของการ
ลดหลั่น 

- การท าซ้ าเพ่ือการสร้างจุดสนใจ ได้แก่การท าซ้ าในจุดที่ต้องการเน้นให้เป็นจุด
สนใจ เช่น ในภาพเขียนบางครั้งประกอบไปด้วยสิ่งของมากมาย แต่ละอย่างไม่มี
สิ่งใดเป็นจุดสนใจได้ วิธีแก้ปัญหาท าได้โดยการท าซ้ าในรูปวัตถุสิ่งของที่ต้องการ
ให้เป็นจุดสนใจ 

- การท าซ้ าเพ่ือให้เกิดความรู้สึกเกี่ยวกับมิติ เป็นการท าซ้ าเพ่ือให้ เกิดความรู้สึก
ตื้นลึก โดยการท าซ้ าในลักษณะท าซ้อนๆ กัน 

3. องค์ประกอบของการท าซ้ า มีองค์ประกอบ 3 ประการ ได้แก่ 
- รูปแบบต้นฉบับ หมายถึง รูปแบบที่จะถูกท าซ้ า ซึ่งรูปแบบดังกล่าวในทาง

ทัศนศิลป์หมายถึงองค์ประกอบศิลป์ทั้ง 6 ตัว ได้แก่ เส้น สี รูปร่างรูปทรง พื้นผิว 
ช่องว่าง แสงและเงา 

- ทิศทางของการท าซ้ า หมายถึง การท าซ้ าในทิศทางใดทิศทางหนึ่ง เช่น 
แนวนอน-แนวตั้ง – แนวเฉียง - รูปซิกแซก – รูปตาหมากรุก - รูปขั้นบันได หรือ 
รูปกระจาย การท าซ้ าในรูปแบบใดก็ตาม จะเกิดความเคลื่อนไหวในทิศทางของ
รูปแบบนั้นด้วย  

- เวลา หมายถึง ระยะทางของการท าซ้ าแต่ละครั้ง ระยะทางห่าง หมายถึงเวลา
ของการท าซ้ าแต่ละครั้งนาน ระยะถี่ หมายถึง เวลา ของการท าซ้ าเร็วขึ้น 

4. วิธีการท าซ้ าเพ่ือให้เกิดความน่าสนใจ การท าซ้ าเหมือน ๆ กัน จนเกินไป จะท าให้
เกิดความน่าเบื่อได้ง่าย วิธีการท าซ้ าให้เกิดความน่าสนใจ ได้แก่  

- การเปลี่ยนแปลงรูปลักษณะ หมายความว่า อย่าใช้รูปเดิมในการท าซ้ า แต่ควร
ใช้การท าซ้ าในลักษณะคล้ายคลึงกัน (Familiar Repetition)  

- การเปลี่ยนแปลงขนาด รูปร่างของวัตถุที่จะท าซ้ ายังคงเดิม แต่มีความต่างกัน
ของขนาด ความเล็กใหญ่ จะจัดวางในลักษณะเรียงล าดับ (Gradation) หรือ
สลับขนาดกันไปมาก็ได้ 

- การเปลี่ยนแปลงทิศทาง ได้แก่ การซ้ ากันในทิศทางทีแตกต่างกัน ท าให้ดูมีความ
เคลื่อนไหวที่น่าสนใจ 

- การเปลี่ยนแปลงจังหวะ ได้แก่ การซ้ าในช่วงเวลาที่แตกต่างกัน ช้าเร็วไม่เท่ากัน 
ถี่ห่างต่างกัน สร้างความน่าสนใจให้กับการซ้ าได้ (สมชาย, 2548) 
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3.1.2  สื่ออินโฟกราฟิก 
   เป็นการน าค าภาษาอังกฤษ ค าว่า Information หมายถึง ข้อมูลสารสนเทศหรือข้อมูลข่าวสาร 
ต่าง ๆ ข้อมูลความรู้ ไอเดีย การรายงานผลต่าง ๆ หรือแม้แต่การรายงานเหตุการณ์และสถานการณ์ และค าว่า 
Graphic หมายถึง รูปภาพในรูปแบบดิจิทัล ซึ่งสร้างด้วยคอมพิวเตอร์ หรือรูปภาพที่แสดงผลผ่านระบบ 
คอมพิวเตอร์ รวมถึงอุปกรณ์อ่ืน ๆ อย่างแท็บเล็ตหรือสมาร์ทโฟน ดังนั้นค าว่า Infographic (อินโฟกราฟิก) จึง
มีความหมายถึง การน าเสนอข้อมูลสารสนเทศต่าง ๆ โดยใช้ภาพกราฟิกเป็นเครื่องมือส าคัญ ซึ่งอินโฟกราฟิก  
จะต้องประกอบด้วย 2 ส่วนหลัก ๆ คือ “ข้อมูล” และ “ภาพกราฟิก” (ธัญธัช, 2561) 
  อินโฟกราฟิก เป็นการแปลงข้อมูลให้เป็นภาพ เพ่ือให้เข้าใจได้ง่ายและสื่อสารกับผู้คนด้วยสิ่งที่จับ
ต้องได้ อินโฟกราฟิกไม่ใช่การสรุปข้อมูลทั้งหมดแล้วมาน าเสนอในภาพหนึ่งภาพ แต่เป็นการน าเสนอข้อมูล
โดยรวม และการน าเสนอข้อมูลรายละเอียดเชิงลึก (Jun, 2558)  
  อินโฟกราฟิกเกิดจากการผสมค า Information กับค าว่า Graphic ซึ่งหมายถึงอะไรก็ตามที่
เกี่ยวข้องกับการสร้างภาพให้ปรากฏขึ้น ดังนั้น Infographic จึงมีความหมายถึงการน าข้อมูลมาสรุปและจัดท า
เป็นสื่อกราฟิก ดังนั้น อินโฟกราฟิกที่ดีจะช่วยให้ผู้อ่านเข้าใจในเนื้อหามากยิ่งขึ้น อีกทั้งสามารถเปลี่ยนข้อมูลที่
ดูยุ่งยากซับซ้อนให้เข้าใจได้ง่ายผ่านรูปภาพกราฟิกรูปแบบต่าง ๆ โดยไม่จ าเป็นต้องมีใครมาน าเสนอข้อมูล
เพ่ิมเติม (จุติพงศ์, 2560) 
  อินโฟกราฟิก เป็นการน าข้อมูลหรือความรู้มาท าการสรุปให้เป็นสารสนเทศในลักษณะของข้อมูล
กราฟิกที่อาจจะเป็นลายเส้น สัญลักษณ์ กราฟ แผนภูมิ ไดอะแกรม แผนที่ ซึ่งได้ออกแบบเป็นภาพนิ่งหรือ
ภาพเคลื่อนไหวที่ดูแล้วสามารถท าความเข้าใจได้ง่ายในเวลาอันรวดเร็ว และมีความชัดเจน สามารถสื่อสารให้
ผู้ชมเข้าใจความหมายของข้อมูลทั้งหมดได้โดยไม่จ าเป็นต้องมีผู้น าเสนออ่ืนมาช่วยขยายความเข้าใจเพ่ิมเติม 
(จงรัก, 2562) 
  อินโฟกราฟิก หมายถึงภาพหรือกราฟิกซึ่งบ่งชี้ถึงข้อมูลไม่ว่าจะเป็นสถิติ ความรู้ ตัวเลข หรือ
ข้อเท็จจริงต่าง ๆ เรียกได้ว่า เป็นตัวแทนของข้อมูลสื่อมาเป็นภาพ โดยจะช่วยในการน าเสนอข้อมูลข่าวสารที่
สามารถเข้าใจได้ยาก มีความซับซ้อน หรือมีจ านวนมากให้เข้าใจได้ง่ายขึ้น ด้วยการน าเสนอในรูปแบบต่าง ๆ 
อย่างสร้างสรรค์ และช่วยลดเวลาในการอธิบายเพ่ิมเติม ท าให้การสื่อสารมีประสิทธิภาพ สามารถประยุกต์ใช้
ได้กับทุกสาขาอาชีพ (ภาณุพงศ์, 2557) 
  จากที่ผู้ปฏิบัติได้ท าการศึกษามาดังกล่าวข้างต้น สามารถสรุปได้ว่า Infographics หมายถึง การ
แปลงข้อมูลเนื้อหามาท าการน าเสนอข้อมูลโดยรวม ด้วยการน าเสนอภาพรูปภาพกราฟิกเพ่ือช่วยให้ผู้อ่าน
สามารถเข้าใจในเนื้อหาได้มากยิ่งขึ้น โดยสามารถเปลี่ยนข้อมูลเนื้อหาที่มีความเข้าใจได้ยากให้สามารถเข้าใจได้
โดยง่าย เปลี่ยนจากข้อมูลที่ซับซ้อนให้เข้าใจได้ง่ายผ่านรูปภาพกราฟิกในรูปแบบต่าง ๆ  
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  3.1.2.1  องค์ประกอบของอินโฟกราฟิก 
   1. ข้อมูล (ตัวหนังสือ) เป็นองค์ประกอบส าคัญอย่างหนึ่งของอินโฟกราฟิก ซึ่งถึงแม้ว่า
อินโฟกราฟิกจะเน้นน าเสนอข้อมูลด้วยภาพกราฟิก แต่ก็ไม่ได้หมายความว่าจะมีแต่แต่กราฟิกอย่างเดียวต้องมี
ข้อมูลที่เป็นตัวหนังสือประกอบอยู่ด้วย หากมีแค่ภาพกราฟิกเพียงอย่างเดียวก็มักไม่เรียกว่าอินโฟกราฟิก 
   2. ภาพกราฟิก เป็นองค์ประกอบที่จะขาดไม่ได้ในอินโฟกราฟิก การน าเสนอข้อมูลโดย
ใช้ตัวหนังสือล้วน ๆ ก็ไม่สามารถเรียกได้ว่าเป็นอินโฟกราฟิกได้ ภาพกราฟิกที่น ามาใช้ได้นั้นมีอยู่หลากหลาย
รูปแบบ เช่น รูปทรงเรขาคณิต, ภาพไอคอ, ภาพการ์ตูน, ชาร์ตหรือไดอะแกรม, ภาพถ่าย ฯลฯ  
  ประโยชน์หลักของอินโฟกราฟิก ช่วยให้การน าเสนอข้อมูลข่าวสารนั้น ๆ ดึงดูดความสนใจของ
กลุ่มเป้าหมายได้มากขึ้น เพราะการใช้ภาพกราฟิกเป็นตัวเล่าเรื่อง จะช่วยสร้างความน่าสนใจและแปลกตาได้
มาก  
  นอกจากนี้ยังช่วยให้เข้าใจเนื้อหาสาระที่ต้องการสื่อได้ง่ายขึ้นและรวดเร็ว เพราะข้อมูลในอินโฟ
กราฟิกมักผา่นการสรุปเรียบเรียงให้สั้น กระชับเข้าใจได้ง่าย เป็นการสื่อสารอย่างตรงไปตรงมา  
  จุดเด่นของการสื่อสารด้วยอินโฟกราฟิกนั้นต้องง่ายต่อการท าความเข้าใจ สามารถดึงดูดความ
สนใจได้มากกว่า ประหยัดเวลาในการศึกษาข้อมูล ช่วยให้เกิดการจดจ าข้อมูลได้ดีกว่า น าไปเผยแพร่ต่อได้ ง่าย 
และดูเป็นมืออาชีพน่าเชื่อถือ (ธัญธัช, 2561) ดังแสดงภาพที่ 3-2 
 
 
 
 

 
 
 
 
 
 
 

ภาพที่ 3-2 แสดงจุดเด่นของการสื่อสารด้วย (ธัญธัช, 2561 หน้า 29) 
 

  3.1.2.2  ประเภทของอินโฟกราฟิก 
    ปัจจุบันสื่อต่าง ๆ โดยเฉพาะในสื่อโซเซียลมีเดียได้เติบโตอย่างมาก ท าให้การแชร์ข้อมูล
ในรูปแบบต่าง ๆ มีรูปแบบที่หลากหลายมากขึ้น ซึ่งท าให้สื่ออินโฟกราฟิกมีการน าเสนอในรูปแบบใหม่ ๆ ตาม
ไปด้วยเช่นกัน 
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1. อินโฟกราฟิกแบบภาพนิ่ง (Static Infographics) เป็นการสรุปเนื้อหาลงในหนึ่งหน้า
โดยใช้ไอคอน รูปภาพและข้อความ มีข้อดีคือ ต้นทุนต่ าผลิตง่าย สามารถแชร์ต่อได้ง่าย ข้อเสียคือ หากข้อมูล
หนึ่ง ๆ สามารถจัดแบ่งได้หลายกลุ่มจะยากต่อการท าความเข้าใจอาจไม่ดึงดูดความสนใจเท่าท่ีควร 

2. อินเตอร์แอ๊คทีฟอนโฟกราฟิก (Interactive Infographics) หรืออินโฟกราฟิกที่มี
ปฏิสัมพันธ์โต้ตอบกับผู้ชมได้ เปลี่ยนการแสดงผลได้ตามสิ่งที่ผู้ชมเลือก ซึ่งอินโฟกราฟิกลักษณะมักน าไปใช้บน
เว็บไซด์ ข้อดีคือ เข้าใจง่ายหากข้อมูลสามารถแบ่งได้หลายกลุ่มหลายรูปแบบสามารถปรับปรุงได้ตลอดเวลา 
ข้อเสียคือ ผู้ผลิตต้องมีความเข้าใจในการเขียนโปรแกรมและการจัดการฐานข้อมูล รวมถึงมีข้อจ ากั ดในการ
แสดงผลบนอุปกรณ์แต่ละชนิดและมีความยุ่งยากในการจัดพิมพ์ 

3. โมชั่นอินโฟกราฟิก (Motion Infographics) หรืออินโฟกราฟิกที่มีการเคลื่อนไหว 
โดยอาจจะอยู่ในรูปแบบของวิดีโอหรือไฟล์เคลื่อนไหวอ่ืน ๆ มักถูกใช้ในการเล่าเรื่องหรืออธิบายกลไกต่าง ๆ 
ข้อดีคือ ดึงดูดความน่าสนใจได้มาก เข้าใจง่าย ข้อเสียคือมีต้นทุนการผลิตที่สูงกว่าอินโฟกราฟิกแบบภาพนิ่ง 
และไม่เหมะกับข้อมูลที่ต้องใช้เวลาในการท าความเข้าใจ รวมถึงมีขนาดของไฟล์ที่ใหญ่ที่สุด 
  3.1.2.3  ข้อดีของอินโฟกราฟิก 
    อินโฟกราฟิกสามารถประยุกต์ใช้ได้หลากหลายรูแบบ สามารถสรุปได้ดังนี้ 

1. มีเสน่ห์และดูน่าสนใจและผู้ชมไม่จ าเป็นต้องใช้เวลาจดจ่อมากนัก 
2. ลดปัญหาด้านข้อมูลที่เยอะเกินความจ าเป็น 
3. ง่ายต่อการรับชม ง่ายต่อความเข้าใจ 
4. เพ่ิมประสิทธิภาพในการจดจ าข้อมูล ผ่านกราฟิกรูปแบบต่าง ๆ 
5. ง่ายต่อการเข้าถึงกลุ่มคนจ านวนมาก ฝ่าข้อจ ากัดด้านเวลา อายุ เชื้อชาติ และภาษา 
6. ผู้คนชอบแชร์อินโฟกราฟิกผ่านโซเซียลเน็ตเวิร์ค (จุติพงศ์, 2560) 

3.1.2.4   ข้อจ ากัดของอินโฟกราฟิกที่ไม่ควรท า 
 1. อย่าใช้ข้อมูลมากเกินไป (Don’t use too much text) อินโฟกราฟิกเป็นการ

ออกแบบโดยใช้ภาพ ควรมีตัวหนังสือน้อยกว่าภาพหรือแบ่งส่วนให้เท่าๆ กัน ซึ่ง
เหมาะส าหรับผู้ที่อ่านน้อยและขึ้นอยู่กับภาพข้อมูล ถ้าใส่ตัวหนังสือมากและมีภาพ
น้อยก็ยังไม่ถึงวัตถุประสงค์ของอินโฟกราฟิก 

2 .  อย่ าท าข้อมูลที่ น า เสนอให้ยุ่ งยากซับซ้ อน (Don’t make confusing data 
presentation) การน าเสนอข้อมูลที่ยุ่ งยากซับซ้อนผิดวัตถุประสงค์ของการ
ออกแบบอินโฟกราฟิก อย่าเน้นข้อมูลที่ไม่จ าเป็น และต้องแน่ใจว่าจัดการกับข้อมูล 
ให้ชัดเจนและเข้าใจง่าย ซึ่งมักจะท าโดยการใช้กราฟ ภาพวาด และกราฟิกอ่ืนๆ  

3.  อย่ า ใช้สีมากเกิน ไป (Don’t overuse color) การใช้สีมากเกิน ไปจะท า ให้
ประสิทธิภาพในการน าเสนอข้อมูลน้อยลง ผู้อ่านจะไม่สามารถอ่านและเข้าใจเนื้อหา
ได้ดี ควรศึกษาจิตวิทยาการใช้สีที่ตัดกันด้วย 
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4. อย่าใส่ตัวเลขมากเกินไป (Don’t place too much numbers) การใช้ตัวเลขช่วย
ให้การสร้างอินโฟกราฟิกมีประสิทธิภาพ แต่อย่าใช้ให้มากเกินไปจะท าให้ผลงาน
ออกมาเหมือนเป็นใบงานวิชาคณิตศาสตร์ จะต้องใช้กราฟิกในการน าเสนอจ านวน
ต่างๆ  

5. อย่าละเลยข้อมูลที่ไม่สามารถระบุแยกแยะได้ (Don’t leave figures unidentified) 
อินโฟกราฟิกบางเรื่องขาดตัวเลขไม่ได้ ข้อเท็จจริงบางอย่างต้องมีตัวเลขข้อมูลทาง
สถิติ แต่ผู้ชมอาจไม่เข้าใจทั้งหมด ถึงแม้จะช านาญในการออกแบบ ถ้าใส่ข้อมูลโดย
ไม่ระบุค าอธิบายลงไปด้วยก็จะเป็นตัวเลขที่ไม่มีประโยชน์ ดังนั้นต้องแน่ใจว่าใส่ป้าย
ระบุค าอธิบายของข้อมูลแต่ละชุด 

6. อย่าสร้างอินโฟกราฟิกให้น่าเบื่อ (Don’t make it boring) อินโฟกราฟิกส่วนมากจะ
ให้ความรู้ ประโยชน์ และความบันเทิง มีจุดมุ่งหมายที่การจัดการข้อมูล ให้ผู้ชม
เข้าใจง่าย ถ้าสร้างอินโฟกราฟิกให้น่าเบื่อจะไม่ดึงดูดความสนใจของผู้ชม ต้ อง
วางแผนสร้างแนวทางของเรื่องและการน าเสนอที่ดี จึงจะสามารถบอกเรื่องราวตาม
จุดประสงค์ที่ตั้งไว้ได้อย่างมีประสิทธิภาพ 

7. อย่าใช้วิธีการพิมพ์ผิด (Don’t misuse typography) หลักการพิมพ์เป็นสิ่งที่ส าคัญ
ในการออกแบบช่วยให้อินโฟกราฟิกดูดีขึ้น ท าให้ง่ายต่อการถ่ายทอดข้อมูล แต่ถ้าใช้
ผิดวิธีจะเป็นผลเสียในการออกแบบ ต้องแน่ใจว่าจะใช้วิธีการพิมพ์ถูกต้องการใช้สีที่ดี
และขนาดของ Fonts ที่ด ีจะท าให้การตีความไม่ไขว้เขว 

8. อย่าน าเสนอข้อมูลที่ผิด (Don’t present wrong information) ควรตรวจสอบให้
แน่ใจในข้อมูลสองครั้ง โดยเฉพาะการใช้ข้อมูลทางสถิติ ถ้าข้อมูลผิดพลาดจะท าให้
ผู้อ่านเข้าใจผิดส าหรับอินโฟกราฟิกจะต้องแม่นย าน่าเชื่อถือและถูกต้อง 

9. อย่าเน้นที่การออกแบบ (Don’t focus on design) อินโฟกราฟิกไม่จ าเป็นต้องเน้น
ที่การออกแบบให้สวยงาม ควรเน้นที่การน าเสนอข้อมูลที่ถูกต้อง ก่อนสร้างอินโฟ
กราฟิกต้องดูว่ามีข้อมูลที่จ าเป็นทั้งหมด การจัดการข้อมูลสามารถน าเสนอได้อย่าง
ชัดเจน แต่ไม่ได้หมายความว่าจะไม่สนใจการออกแบบ ควรผสมผสานระหว่างข้อมูล
และการออกแบบกราฟิกอย่างมีประสิทธิภาพ 

10. อย่าใช้แบบเป็นวงกลม (Don’t use a circus layout) อินโฟกราฟิกที่ดีควรจะ
สามารถชี้น าผู้ชมได้ทั้งหมด อย่าใส่องค์ประกอบทุกที่ที่เราคิด ควรพิจารณาว่าผู้ชม
จะสนใจจุดไหน อย่าให้ผู้อ่านยุ่งยาก ต้องแน่ใจว่าผู้ชมสามารถเข้าใจในวิธีการ
น าเสนอ (จงรัก, 2557) 
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  3.1.2.5  รูปแบบของอินโฟกราฟิก 
   อินโฟกราฟิกที่นิยมใช้มีกันอยู่หลายรูปแบบหลายลักษณะ ซึ่งแต่ละรูปแบบมีคุณ
ลักษณะเฉพาะแตกต่างกันไป 

1. อินโฟกราฟิก แบบอธิบายข้อมูล เป็นอินโฟกราฟิกที่เน้นน าเสนอข้อมูลส าคัญแค่ส่วน
เดียวหรือย่อหน้าเดียว นอกนั้นเป็นภาพกราฟิกท่ีน ามาประกอบ ดังแสดงภาพที่ 3-3 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-3  แสดงตัวอย่าง Infographic แบบอธิบายข้อมูล (ธัญธัช, 2561 หน้า 47) 
 

2. อินโฟกราฟิก แจกแจงข้อมูล เป็นอินโฟกราฟิกที่เน้นน าเสนอข้อมูลโดยแบ่งแยก
ออกเป็นย่อยๆ ส่วน ๆ หรือข้อ ๆ อินโฟกราฟิกรูปแบบนี้พบเจอได้มากท่ีสุด ดังแสดงภาพที่ 3-4  
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-4  แสดงตัวอย่าง Infographic แบบแจกแจงข้อมูล (ธัญธัช, 2561 หน้า 49) 
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3. อินโฟกราฟิก เปรียบเทียบข้อมูล เป็นอินโฟกราฟิกที่แสดงการเปรียบเทียบข้อมูล 2 
ชุด หรือมากกว่า เพ่ือให้เห็นความแตกต่างอย่างชัดเจน ดังแสดงภาพที่ 3-5 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-5  แสดงตัวอย่าง Infographic แบบเปรียบเทียบข้อมูล (ที่มา : www.freepik.com) 
 

4. อินโฟกราฟิก แสดงสถิติหรือผลส ารวจ เป็นอินโฟกราฟิกที่แสดงสถิติหรือผลส ารวจ 
มักมีตัวเลขแสดงจ านวนหรือเปอร์เซ็นต์เป็นส่วประกอบอยู่ด้วย ดังแสดงภาพที่ 3-6 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-6  แสดงตัวอย่าง Infographic แบบแสดงสถิติหรือผลส ารวจ (ธัญธัช, 2561 หน้า 53) 
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5. อินโฟกราฟิก แสดงล าดับขั้นตอนของข้อมูล เป็นอินโฟกราฟิกที่ใช้แสดงข้อมูลที่เป็น
ล าดับหรือเป็นขั้นตอนต่อเนื่องกัน ส่วนใหญ่จะมีตัวเลขก ากับด้วย ดังแสดงภาพที่ 3-7 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-7  แสดงตัวอย่าง Infographic แบบแสดงล าดับขั้นตอนของข้อมูล (ที่มา : www.freepik.com) 
 

6. อินโฟกราฟิก แสดงความเชื่อมโยงของข้อมูล เป็นอินโฟกราฟิกที่ใช้แสดงข้อมูลซึ่ง
เกี่ยวข้องเชื่อมโยงกัน แต่ไม่ได้มีลักษณะเป็นล าดับขั้นตอน  รูปแบบนี้มักมีเส้น ลูกศร หรือสัญลักษณ์แสดง
ความเชื่อมโยงกัน ดังแสดงภาพที่ 3-8  
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-8  แสดงตัวอย่าง Infographic แบบแสดงความเชื่อมโยงของข้อมูล (ที่มา : www.freepik.com)  
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7. อินโฟกราฟิก แสดงข้อมูลตามล าดับเวลา เป็นอินโฟกราฟิกที่แสดงข้อมูลตามล าดับ 
วัน/เวลา หรือไทม์ไลน์ ซึ่งส่วนใหญั่กใช้แสดงพัฒนาการของสิ่งใดสิ่งหนึ่ง โดยมักมีตัวเลขแสดงล าดับเวลาก ากับ
อยู่ ดังแสดงภาพที่ 3-9 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-9  แสดงตัวอย่าง Infographic แบบแสดงข้อมูลตามล าดับเวลา (ท่ีมา : www.freepik.com) 
 

8. อินโฟกราฟิก แสดงข้อมูลเชิงภูมิศาสตร์ เป็นอินโฟกราฟิกที่แสดงข้อมูลอย่างใดอย่าง
หนึ่งโดยอิงกับสภาพภูมิศาสตร์หรือพ้ืนที่ต่าง ๆ อินโฟกราฟิกรูปแบบนี้มักจะมีกราฟิกแผนที่หรือกราฟิกที่
เกี่ยวข้องกับภูมิศาสตร์ ดังแสดงภาพที่ 3-10 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-10  แสดงตัวอย่าง Infographic แบบแสดงข้อมูลเชิงภูมิศาสตร์ (ท่ีมา : www.freepik.com) 
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9. อินโฟกราฟิก แบบผสมผสาน เป็นอินโฟกราฟิกที่ผสมผสานอินโฟกราฟิกหลาย
รูปแบบเข้าด้วยกัน เช่น อธิบายข้อมูล แสดงสถิติต่าง ๆ และให้ข้อมูลเชิงภูมิศาสตร์ด้วย  ดังแสดงภาพที่ 3-11 
(ธัญธัช, 2561) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-11  แสดงตัวอย่าง Infographic แบบแสดงข้อมูลแบบผสมผสาน (ท่ีมา : www.freepik.com) 
 

3.1.2.6  ประเภทของกราฟิก 
   ภาพกราฟิกที่ใช้กันทั่วไป จะแบ่งตามวิธีการเก็บข้อมูลและการแสดงผลออกเป็น 2 
ประเภทใหญ่ ๆ ด้วยกัน ได้แก่ 

1. Bitmap Images  ภาพแบบบิทแมพ หรือ ราสเตอร์ (Raster) เป็นภาพที่เกิดจากจุด
สีที่เรียกว่า พิกเซล (Pixels) ซึ่งเรียงต่อกันเป็นรูปร่างบนพ้ืนที่ที่มีลักษณะเป็นตาราง (กริด) แต่ละพิกเซลจะมี
ค่าของต าแหน่งและค่าสีของตัวเองภาพหนึ่งภาพจะประกอบด้วยพิกเซลหลาย ๆ พิกเซลรวมกัน แต่เนื่องจาก
พิกเซลมีขนาดเล็ก ภาพที่เห็นจึงมีความละเอียดสวยงามไม่เป็นกรอบสี่เหลี่ยมความละเอียดหรือความคมชัด 
ของภาพขึ้นอยู่กับจ านวนพิกเซลที่ก าหนดไว้แล้วเป็นค่าที่แน่นอน ดังนั้นเมื่อมีการขยายภาพจะเกิดปัญหาคือ
เห็นภาพเป็นกรอบสี่เหลี่ยมเล็ก ๆ หลาย ๆ จุด ภาพบิทแมพเป็นภาพที่นิยมใช้กันในภาพถ่ายหรือภาพวาดบาง
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ประเภท เนื่องจากสามารถไล่โทนสีและแสงเงาได้เหมือนจริงที่สุด โปรแกรมที่นิยมใช้กันมากที่สุดในการสร้าง
ภาพบิทแมพ คือ Adobe Photoshop เป็นต้น 

2. ภาพแบบเวคเตอร์ (Vector Graphics) เป็นภาพที่ประกอบไปด้วยเส้นตรง ส่วนโค้ง 
และรูปทรงเรขาคณิต ซึ่งเก็บอยู่ในรูปของค าสั่งโปรแกรมหรือสมการทางคณิตศาสตร์ โดยสามารถก าหนด
คุณสมบัติเกี่ยวกับเส้นและสีพ้ืนได้ โดยภาพกราฟิกจะประกอบด้วยส่วนเส้นตรง เส้นโค้งหลายส่วนที่เชื่อมกัน
กลายเป็นรูปทรง ซึ่งโปรแกรมที่ใช้สร้างภาพกราฟิกแบบเวคเตอร์ (Drawing Program) เป็นออบเจ็ครูปทรง
ต่าง ๆ เช่น Adobe Illustrator, Adobe Flash, CorelDraw เป็นต้น 
 3.1.3  การใช้งานโปรแกรมคอมพิวเตอร์ประยุกต์ Adobe Illustrator  
  3.1.3.1  ท าความรู้จักโปรแกรม Adobe Illustrator เบื้องต้น 
    Illustrator เป็นโปรแกรมที่ใช้ท างานกราฟิกโดยเน้นการสร้างชิ้นงานจากการวาดเป็น
หลัก ซึ่งเป็นที่นิยมส าหรับนักออกแบบทั้งหลายเพ่ือน าไปใช้ในงานด้านต่าง ๆ ไม่ว่าจะเป็นงานสิ่งพิมพ์ งาน
โฆษณา การออกแบบฉลากและผลิตภัณฑ์ การออกแบบโลโก้  ภาพที่ได้จากโปรแกรมจะเป็นภาพกราฟิก
ประเภทเวคเตอร์ และไฟล์ของโปรแกรม (.ai, .pdf และ .eps) ที่สามารถน าไปใช้งานร่วมกับโปรแกรมกราฟิก
อ่ืน ๆ ได้ เช่นโปรแกรม InDesign, Photoshop, Flash ซึ่งเป็นจุดเด่นของโปรแกรมนี้ (บุญญาดา, 2553) 

3.1.3.2  เริ่มเปิดโปรแกรม Adobe Illustrator 
 เมื่อเปิดโปรแกรม จะเป็นฟังก์ชั่นการท างานและเครื่องมือในการท างาน ซึ่งแบ่งออกเป็น

ส่วน ๆ ดังนี้ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-12  แสดงหน้าจอการท างานของโปรแกรม Adobe Illustrator 

 เมนูบาร ์  การจัดเรียงอาร์บอร์ด 
 เปิด Adobe Bridge 

 ไตเติลบาร ์
 คอนโทรลพาเนล 

 ทูลพาเนล 

 แถบสถานะ 

 

พาเนลต่างๆ 

 พื้นที่เตรียมงาน 

(Scratch Areal) 
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1. คอนโทรลพาเนล (Control Panel) 
    เป็นส่วนที่ใช้ในการปรับแต่งการท างานของเครื่องมือต่าง ๆ ซึ่งรายละเอียดใน
คอนโทรลพาเนลจะเปลี่ยนไปตามการเลือกเครื่องมือหรือเลือกออบเจ็คขณะนั้น เช่น ถ้าหากเลือกออบเจ๊คทั่ว 
ๆ ไป คอนโทรลพาเนลจะแสดงออปชั่นการก าหนดสี / ขนาดของพ้ืนและเส้น หรือหากเลือกออบเจ็คที่เป็น
ตัวอักษรก็จะแสดงออปชั่นที่เกี่ยวกับการก าหนดรูปแบบตัวอักษร ดังแสดงภาพที่ 3-13 
 
 

ภาพที่ 3-13  แสดงฟังก์ชั่นคอนโทรลพาเนล 
 
    ที่คอนโทรลพาเนลยังมีพาเนลอ่ืนที่เกี่ยวข้องกับเครื่องมือหรือออบเจ็คที่เลือกฝังอยู่ 
เพ่ือใช้ในการก าหนดออปชั่นเพิ่มเติม ซึ่งสามารถเปิดใช้พาเนลที่ฝังอยู่ได้โดยคลิกที่ชื่อ (ตัวอักษรสีส้ม)  
 
 
 
 
 
     
    หรือปุ่ม      บนคอนโทรลพาเนล จากนั้นจึงปรับแต่งออปชั่นต่าง ๆ ตามต้องการ 
 
 
 
 
 
 
 
 
 
 

2. แถบสถานะ  
แถบสถานะจะปรากฎอยู่ด้านล่างสุดของวินโดว์ โดยแสดงเปอร์เซ็นต์ของการซูมภาพ 

(เลือกซูมภาพได้จากเมนู หรือพิมพ์ค่าลงไปเอง และรายละเอียดข้อมูลของสถานะต่าง ๆ โดยสามารถเปลี่ยนให้
แสดงอย่างอ่ืนได ้

 คลกิที่ปุ่ ม      แสดงพาเนล Swatches ส  าหรบั
เลอืกสเีสน้ 

 คลกิ Stroke แสดงพาเนล Stroke ส าหรบัปรบัแตง่
ขนาดและรูปแบบเสน้ 
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1. คลิกปุ่ม 
2. เลือกค าสั่งต่าง ๆ ดังนี้ 

Reveal In Bridge แสดงรูปตัวอย่างของไฟล์ปัจจุบัน Adobe Bridge 
Show แสดงข้อมูลต่าง ๆ บนแถบสถานะ ซึ่งมีดังนี้ 
Artboard Name แสดงเป็นชื่อ Artboard ปัจจุบัน 
Current Tool แสดงชื่อเครื่องมือปัจจุบันที่ใช้งานอยู่ 
Date and Time แสดงวันที่และเวลาปัจจุบัน 
Number of Undo แสดงจ านวนครั้งที่จะยกเลิก (Undo) และท าซ้ า (Redo) ค าสั่งได้ 
Document Color Profile แสดงโปรไฟล์สีของไฟล์ปัจจุบัน 

3. ทูลพาเนล (Tools Panel)  เป็นกล่องเครื่องมือหรือเรียกว่า ทูลพาเนล ซึ่งจะ
ประกอบด้วยเครื่องมือต่าง ๆ ที่จ าเป็นต่อการท างานและมีจ านวนมาก ดังนั้น จึงมีการรวมเครื่องมือบางอย่าง
ไว้ในปุ่มเดียวกันเป็นกลุ่ม ๆ ซึ่งจะมีรูป     สามเหลี่ยมอยู่ที่มุมขวาล่างบนรูปเครื่องมือเพ่ือบอกว่ายังมีเครื่องมือ
อ่ืนซ่อนอยู่ด้วย 

 การเลือกเครื่องมือ เมื่อท าการคลิกปุ่มใด 1 ครั้ง จะเป็นการเลือกเครื่องมือนั้นส าหรับ
ไปใช้งาน จะสังเกตได้ว่าบนเมาส์พอยเตอร์จะเปลี่ยนไปตามลักษณะของเครื่องมือที่เลือก แต่ถ้าต้องการเลือก
เครื่องมืออ่ืนที่อยู่บนปุ่มเดียวกัน ก็สามารถคลิกบนปุ่มค้างไว้สักครู่แล้วลากเมาส์ไปชี้เครื่องมือที่ต้องการ ดัง
แสดงภาพที่ 3-14 
 
 
 
 
 
 
 

1  เปอร์เซ็นต์
การซูมภาพ 

 เลื่อนดู 
อาร์ตบอร์ด 

2 คลกิ คลิกเลือกค าสั่งเพ่ือให้ 
แสดงข้อมูล 

คลิกเมาส์ค้างไว้ 

ลากเมาส์ชี้ที่เครื่องมือ
แล้วปล่อยปุ่มเมาส์ 
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ภาพที่ 3-14  แสดงแผงเครื่องมือ (Tool Panel) ในโปรแกรม Adobe Illustrator 

Selection = (V) 

Magic Wand = (Y) 

Pen = (P) 

Line Segment = (\) 

Paintbrush = (B) 

Blob Brush =(Shift+B) 

Rotate = (R) 

Width = (Shift+W) 

Shape Builder = (Shift+M) 

Mesh =(U) 

Eyedropper = (I) 

Symbol Sprayer = (Shift+L) 

Artboard=(Shift+O) 

Hand =(H) 

Fill = สีพื้น 

ปรับสีพื้นและเส้นเป็นค่าสี
เริ่มต้น (ขาว/ด า) = (D) 

เลือกใช้สีแบบทึบ = (<) 

เลือกรูปแบบการวาด 

Direct Selection = (A) 

Lasso =(Q) 

Type = (T) 

Rectangle= (M) 

Pencil = (N)  

Eraser = (Shift+E) 

Scale = (S) 

Free Transform = (E) 

Perspective Grid = (Shift+P)  

Gradient = (G) 

Blend = (W) 

Column Graph = (J) 

Slice = (Shift+K) 

Zoom = (Z) 

สลับสีพื้นและเส้น = (Shift+X) 

สีเส้น = Stroke 

ไม่ใช้สีใดๆ เลย = (/) 

เลือกใช้สีแบบไล่โทน = (>) 

ปรับวินโดว์เป็นโหมดต่าง ๆ =(F) 
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  กลุ่มเครื่องมือย่อย 
  ใช้ส าหรับวาดและปรับแต่งรูปทรงใช้ในการสร้าง Path (คีย์ลัด P) 
  ใช้ส าหรับเลือกจุดแองเคอร์และเลือกออบเจ็ค (คีย์ลัด A) 
  ใช้ส าหรับวาดเส้นต่าง ๆ (คีย์ลัด \) 
  ใช้ส าหรับพิมพ์ตัวอักษรในรูปแบบต่าง ๆ  (คีย์ลัด T) 
  ใช้ส าหรับหมุนและพลิกกลับรูปทรง (คีย์ลัด R) 
  ใช้ส าหรับวาดสร้างรูปทรงเรขาคณิต (คีย์ลัด M) 
  ใช้ส าหรับปรับแต่งรูปทรง (คีย์ลัด Shift + W) 
  ใช้ส าหรับวาดและรับแต่งรูปทรงอิสระ (คีย์ลัด N) 
  ใช้ส าหรับปรับแต่งรูปทรงและเติมสีภาพ (คีย์ลัด Shift + M) 
  ใช้ส าหรับลบและตัดรูปทรงของวัตถุ (คีย์ลัด Shift + E) 
  ใช้ส าหรับก๊อปปี้สีและวัดขนาดของวัตถุ (คีย์ลัด I) 
  ใช้ส าหรับปรับขนาด บิดเอียงและปรับรูปทรงของวัตถุ (คีย์ลัด S) 
  ใช้ส าหรับการสร้างและปรับแต่งซิมโบล (คีย์ลัด Shift + S) 
  ใช้ส าหรับเลือกและปรับแต่งรูปแบบ Perspective (คีย์ลัด Shift + P) 
  ใช้ส าหรับเลื่อนต าแหน่งบนพ้ืนที่ชิ้นงาน (คีย์ลัด H) 
   ใช้ส าหรับสร้างกราฟในรูปแบบต่าง ๆ (คีย์ลัด J) 

   ใช้ส าหรับแบ่งส่วนภาพ (คีย์ลัด Shift+ K) 

  4.  พาเนล (Panel)  
   เป็นกรอบหน้าต่างย่อย ๆ ที่อยู่ทางขวามือ สามารถเคลื่อนย้ายที่ได้ตามต้องการ ที่มี
ค าสั่งและเครื่องมือในการจัดการ ตรวจสอบค่าและปรับแต่งองค์ประกอบต่าง ๆ  ของออบเจ็ค เครื่องมือเหล่านี้
จะถูกจัดแบ่งไว้เป็นหมวดหมู่ เช่น พาเนล Color ใช้ก าหนดสี, พาเนล Stroke ใช้ปรับขนาดและรูปแบบเส้น, 
พาเนล Align ใช้จัดต าแหน่งออบเจ็ค เป็นต้น บางพาเนลที่มักใช้งานร่วมกันจะถูกจัดไว้ในกลุ่มเดียวกัน เช่น 
พาเนล Color และ Color Guide (บุญญาดา, 2553) โดยมีพาเนลหลัก ๆ 5 พาเนล ที่ต้องใช้ ดังนี้ 
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ภาพที่ 3-15  แสดงตัวอย่างหน้าต่างพาเนลในโปรแกรม Adobe Illustrator 
 

4.1 Panel Color Mode   
   โหมดสี (Color Mode) คือ ระบบการแทนค่าสีที่ใช้ในภาพกราฟิกโดยจะอ้างอิง
มากจากโมเดลสีมาตรฐานต่าง ๆ ส าหรับโหมดสีใน Illustrator แบ่งออกเป็น 2 โหมด คือ RGB และ CMYK ซ่ึง
เหมาะส าหรับงานคนละประเภท ภาพในโหมด RGB เหมาะส าหรับการน าเสนอบนจอภาพ เช่น เว็บเพจ, วอล
เปเปอร์, พรีเซนเทชั่น ส่วนภาพในโหมด CMYK เหมาะส าหรับงานด้านพิมพ์ที่มีการจัดท าเป็นอาร์เวิร์คส่งไป
โรงพิมพ์ เช่น โบชัวร์, ฉลากผลิตภัณฑ์, หนังสือและนิตยสาร ดังนั้นในการเลือกโหมดสีส าหรับการออกแบบ

พาเนล Color ค าสั่งเรียก 

Window > Color หรือ F6 

พาเนล Swatches ค าสั่งเรียก 

Window > Swatches  

พาเนล Charactor ค าสั่งเรียก 

Window > Type > 

Character หรือ Ctrl + T 

พาเนล Align ค าสั่งเรียก 

Window > Align หรือ Shift 

+ F7 

พาเนล Stroke ค าสั่งเรียก 

Window > Stroke > หรือ 

Ctrl + F10 
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จะต้องพิจารณาจุดประสงค์ของการใช้งาน ทั้งนี้สามารถเปลี่ยนสีโหมดได้โดยเลือกค าสั่ง File > Document 
Color Mode > เลือกโหมดสี  ดังแสดงภาพที่ 3-16 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-16  แสดงค าสั่งโหมดสี Color Mode 
 
  โหมดสี RGB โหมดสีนี้จะมีแนวคิดจากการผสมแสงสีหลัก 3 สี เข้าด้วยกัน คือ แดง 
(Red), เขียว (Green) และน้ าเงิน (Blue) ซึ่งจะท าให้เกิดสีต่าง ๆ ได้เป็นจ านวนมากโดยขึ้นอยู่กับสัดส่วนความ
เข้มขของสีหลักแต่ละสีที่มีค่าได้ตั้งแต่ 0-255 และเมื่อสีหลักทั้ง 3 ที่มีความเข้มสูงสุดมาผสมกันก็จะได้สีขาว 
ซึ่งลักษณะเช่นนี้เรียกว่าการผสมสีแบบบวก (additive color system)  
  โหมดสี CMYK โหมดนี้เกิดขึ้นจากระบบการพิมพ์แบบแยกสี โดยภาพจะถูกแยก
ออกเป็นแม่พิมพ์ของสีหลักเพียง 4 สี คือ ฟ้า (Cyan), ม่วงแดง (Magenta), เหลือง (Yellow), ด า (Black) ซึ่ง
เมื่อพิมพ์สีเหล่านี้ซ้อนกันก็จะได้ภาพบนหน้ากระดาษตามต้นฉบับ ค่าของสีหลักอยู่ในรูปเปอร์เซ็นต์ของน้ าหนัก
หมึกพิมพ์ ตั้งแต่ 0-100 % ซึ่งตามทฤษฎีแล้ว สีหลักเพียง 3 สี คือ Cyan, Magenta, และ Yellow ก็เพียง
พอที่จะใช้ในการสร้างสีอื่น ๆ และเมื่อผสมสีทั้ง 3 ที่ความเข้มที่ 100% จะได้เป็นสีด า 

4.2 Panel Swatches 
   พาเนล Swatches เป็นพาเนลส าหรับเก็บสีและ Pattern ต่าง ๆ ที่ต้องใช้บ่อย 
โดยชุดสีนี้จะถูกบันทึกไว้กับไฟล์และสามารถเรียกกลับมาใช้เมื่อเปิดไฟล์ขึ้นมาแก้ไข นอกจากนี้ยังสามารถ
ก าหนดคุณสมบัติพิเศษต่าง ๆ ให้กับสีอีกด้วย 
   การเปิดพาเนล Swatches ขึ้นมาใช้งาน ท าได้ 2  วิธี ได้แก่ 

1. ใช้ค าสั่ง Window > Swatches เพ่ือเปิดพาเนลแบบวินโดว์ 
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2. เปิดจากคอนโทรลพาเนล โดยคลิกปุ่ม     ที่ Fill เพ่ือเลือกสีพื้นและคลิกปุ่ม      
     ที่ Stroke เพ่ือเลือกสีเส้น 

 
 
 
 
 
 
 
 

ภาพที ่3-17  แสดงตัวอย่างพาเนล Swatches 
 

4.3 Panel Charactor 
   การสร้างข้อความในโปรแกรม Adobe Illustrator จะแบ่งออกเป็น 3 แบบ 
ด้วยกัน ซึ่งแต่ละแบบจะมีคุณสมบัติพ้ืนฐานหลายอย่างท่ีแตกต่างกัน 

 Point Type เป็นข้อความแบบง่าย ๆ เหมาะส าหรับเนื้อหาที่มีความยางไม่มากนัก 
เช่น ไม่กี่ตัวอักษร หรือไม่กี่บรรทัด และมีคุณสมบัติพ้ืนฐานคล้ายออบเจ็คที่เป็นรูปวาดทั่ว ๆ ไป คือ เมื่อใช้
กรอบ Bounding Box ย่อ/ขยายขนาด หรือหมุนก็จะท าให้รูปทรงของตัวอักษรเปลี่ยนแปลงตามไปด้วย ดัง
แสดงภาพที่ 3-18 
 
 
 
 
 
 

ภาพที่ 3-18  แสดงตัวอย่างรูปแบบอักษรประเภท Point Type 

 Area Type เป็นข้อความซึ่งเหมาะกับเนื้อหาที่ความยาวมาก ๆ เช่น หลายบรรทัด
หรือหลายหน้าโดยที่สามารถสร้างข้อความาบรรจุไว้ภายในกรอบรูปทรงใด ๆ ก็ได้ โดยสามารถเชื่อมโยงเนื้อหา
จากกรอบหนึ่งไปยังอีกกรอบหนึ่ง และเมื่อมีการปรับรูปทรงของกรอบก็จะไม่มีผลให้รูปทรงตัวอักษร
เปลี่ยนแปลงไป ดังแสดงภาพที่ 3-19 
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ภาพที่ 3-19  แสดงตัวอย่างรูปแบบอักษรประเภท Area Type 

 Type on a Path เป็นข้อความที่เหมาะส าหรับใช้ประดับตกแต่ง โดยตัวอักษร
จะต้องเรียงตัวไปตามแนวของเส้น Path ดังแสดงภาพที่ 3-20 
 
 
 
 
 
 
 

 
ภาพที่ 3-20  แสดงตัวอย่างรูปแบบอักษรประเภท Type on a Path  

  ซึ่งในการพิมพ์ข้อความสามารถใช้ค าสั่งโดยที่ Tool Panel แล้วคลิกที่ปุ่ม      Type 
Tool ส าหรับพิมพ์ข้อความ ซึ่งเมื่อคลิกปุ่ม Type Tool ค้างไว้จะพบเครื่องมือส าหรับพิมพ์ข้อความในรูปแบบ
ต่าง ๆ ซ่อนไว้ ดังแสดงภาพที่ 3-21 
 
 
 
 
 
 
 
 

ภาพที่ 3-21  แสดงเครื่องส าหรับพิมพ์ข้อความ Type Tool ในรูปแบบต่าง ๆ  
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4.4 Panel Align 
  พาเนล Align เป็นพาเนลที่ใช้ส าหรับในการจัดระเบียบของเลเยอร์บนอาร์ตบอร์ด 
ซึ่งเลเยอร์ก็เรียบเสมือนกับการท างานของแผ่นใสที่ใช้ส าหรับในการจัดวางออบเจ็ค ในการสร้างชิ้นงาน โดย
สามารถวางออบเจ็คเป็นองค์ประกอบส่วนต่าง ๆ ไว้บนแต่ะเลเยอร์ โดยแต่ละเลเยอร์จะถูกจัดเรียงซ้อนทับกัน 
ซึ่งในการจัดเรียงเลเยอร์ ในบางครั้งต้องการให้เลเยอร์ที่เลือกมีความเสมอกันหรือซ้อนทับกันด้วยความพอดี 
ถ้าหากใช้สายตาของนักออกแบบในการก าหนด อาจท าให้เกิดความคลาดเคลื่อนได้ไม่มากก็น้อย ส าหรับงาน
ออกแบบแล้วความคลาดเคลื่อนของแต่ละเลเยอร์ แม้แต่เพียงมิลลิเมตรเดียว เมื่อน าไปท าการพิมพ์หรือเมื่อ
งานชิ้นนั้นมีขนาดที่ใหญ่ อาจท าให้มองเห็นข้อผิดพลาดได้ ซึ่งอาจท าให้งานออกแบบชิ้นนั้นไม่สมบูรณ์ตามที่
ต้องการ ดังนั้นการใช้งานเครื่องมือ Align ในการจัดระเบียบของเลเยอร์จึงเป็นสิ่งที่สมควรท า ดังตัวอย่างแสดง
ภาพที่ 3-22  
 
 
 
 
 
 
 
 
 

ภาพที่ 3-22 แสดงความแตกต่างของการใช้ค าสั่ง Align กับการไม่ใช้ค าสั่ง Align ในการจัดระเบียบเลเยอร์ 

  ซึ่งในค าสั่ง Panel Align จะมีค าสั่งส าหรับการจัดระเบียบเลเยอร์ให้เลือกใช้มากมาย 
เช่น ชิดขอบซ้าย ชิดขอบขวา ตรงกลางแนวตั้ง ตรงกลางแนวนอน ชิดชอบบน และชิดขอบล่าง เป็นต้น 
นอกจากนี้ยังสามารถก าหนดช่องว่างระยะห่างระหว่างออบเจ็คกับออบเจ็คได้อีกด้วย ดังแสดงภาพที่ 3-23 
 
 
 
  
 
 
 
 
 

ภาพที่ 3-23 แสดงหน้าต่างค าสั่งใน Panel Align 

การจัดวางเลเยอร์โดยไม่ใช้ค าสั่ง Align ขนาดของขอบจะ
หนาไม่เท่ากันท้ังหมด 

การจัดวางเลเยอร์โดยใช้ค าสั่ง Align ขนาดของขอบจะหนา
เท่ากันท้ังหมด 
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4.5 Panel Stroke  
   Stroke หรือ เส้น ในโรแกรม Adobe Illustrator เกิดจากการใช้เครื่องมือส าหรับ
การสร้างเส้น หรือ Path โดยการใช้ค าสั่งเครื่องมือ Pen Tool (P) หรือเครื่องมือ Pencil Tool (N) ในการวาด
เส้นและรูปทรงเรขาคณิต ซึ่งการวาดเส้นด้วยเครื่องมือ Pen Tool นี้ เส้นที่ได้จะไม่มีสีเรียกว่าเส้น Path หาก
ต้องการให้เส้นที่วาดเกิดสี นักออกแบบจะต้องท าการก าหนดค่าขนาดของเส้นที่ Panel Stroke โดยการไปที่
ค าสั่ง Window > Stroke ซึ่งจะปรากฎหน้าต่างพาเนลขึ้นมา ดังแสดงภาพที่ 3-24   
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-24  แสดงตัวอย่างหน้าต่าง Panel Stroke 

  5. แถบบไม้บรรทัด (Ruler) 
   ประโยชน์ของไม้บรรทัด คือ สามารถท าให้วัดและก าหนดต าแหน่งของออบเจ็คต่าง ๆ 
ได้อย่างแม่นย าขึ้น อีกท้ังยังใช้ในการสร้างเส้นไกด์อีกด้วย ซึ่งสามารถให้แสดงแถบไม้บรรทัดได้โดยคลิกขวาบน
อาร์ตบอร์ดแล้วเลือกค าสั่ง Show Rulers (คีย์ลัด Ctrl + R) เมื่อคลิกที่ไม้บรรทัดแล้วท าการเลื่อนเมาส์ไปใน
ต าแหน่งต่าง ๆ จะเห็นว่ามีเส้นประปรากฎทั้งแนวตั้งและแนวนอน เคลื่อนที่ไปตามต าแหน่งของเมาส์ ดังนั้น
สามารถดูต าแหน่งที่เมาส์ชี้อยู่ได้จากแถบไม้บรรทัด 
   การเปลี่ยนหน่วยวัด หลังจากที่ท าการเรียกแถบไม้บรรทัดแล้ว ยังสามารถเปลี่ยน
หน่วยวัดได้ตามตอ้งการโดยใช้ค าสั่งคลิกขวาที่แถบไม้บรรทัด จากนั้นจะปรากฎหน่วยวัดใช้เมาส์เลื่อนเพื่อเลือก
ได้ตามต้องการ ดังแสดงภาพที่ 3-25 
 
 
 
 
 

ภาพที่ 3-25  แสดงค าสั่งการเปลี่ยนหน่วยวัด 

ใช้ระบุเลขก าหนดเส้นประ 

ใช้ส าหรับกรอกตัวเลขขนาดของเส้น ใช้ก าหนดรูปแบบหัวและท้ายเส้น 

และใช้ก าหนดรูปแบบมุมของเส้น 
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  6. เส้น Grid, Guide และ Smart Guide 
   การใช้เส้น Grid เส้นกริด (Grid) คือ ตารางสมมติที่จะช่วยนการวาดและการจัดวาง
ออบเจ็คได้อย่างแม่นย า เมื่อต้องการให้แสดงเส้นกริด ให้ท าการคลิกขวาบนอาร์ตบอร์ดแล้วเลือกค าสั่ง Show 
Grid และเมื่อต้องการยกเลิกการแสดง ให้คลิกขวาแล้วเลือกค าสั่ง Hide Grid ถ้าต้องการให้ออบเจ็คยึดติดกับ
เส้นกริดอัตโนมัติขณะวาดหรือย้ายต าแหน่ง ให้ท าการเลือกค าสั่ง View > Snap to Grid และเมื่อต้องการ
ยกเลิกให้ท าค าสั่งเดิมซ้ าอีกครั้ง ดังแสดงภาพที่ 3-26 
 
 
 
 
 
 

ภาพที่ 3-26  แสดงการใช้ค าสั่งเส้น Grid 

   การใช้เส้น Guide คือ เส้นที่ช่วยในการบอกต าแหน่งเพ่ือจัดวางออบเจ็คเหมือนกับ
เส้นกริด แต่สามารถสร้างและจัดวางไปยังต าแหน่งต่าง ๆ ได้เอง ทั้งแนวตั้งและแนวนอน โดยต้องให้แสดงแถบ
ไม้บรรทัดเสียก่อน การสร้างเส้นไกด์ ท าได้โดยการคลิกลากเมาส์ออกจากแถบไม้บรรทัดตามแนวตั้งหรือ
แนวนอนที่ต้องการ การซ่อนเส้นไกด์ สามารถท าได้โดยคลิกขวาบนอาร์ตบอร์ดแล้วเลือกค าสั่ง Hide Guides 
และเมื่อต้องการให้แสดงเส้นไกด์กลับคืน ก็ให้คลิกขวาเลือกค าสั่ง Show Guides การล๊อคเส้นไกด์เพ่ีอไม่ให้
เปลี่ยนต าแหน่ง ก็สามารถท าได้โดยการคลิกขวาที่พ้ืนที่ว่างบนอาร์ตบอร์ด แล้วเลือกค าสั่ง Lock Guides และ
ถ้าต้องการลบเส้นไกด์บางเส้น ให้ใช้เครื่องมือ     Selection เลือกเส้นไกด์ที่ต้องการ แล้วกดปุ่ม Delete ดัง
แสดงภาพที่ 3-27 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-27  แสดงค าสั่งการเรียกใช้เส้นไกด์ 

พื้นที่ท างานท่ีใช้ค าสั่ง
เรียกเส้นกรดิแล้ว 

พื้นที่ท างานท่ีใช้ค าสั่งที่ยัง
ไม่ได้เรียกเส้นกริดแล้ว 
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   การใช้ Smart Guides เป็นเส้นไกด์ที่ปรากฎขึ้นโดยอัตโนมัติ ซึ่งจะอ านวยความ
สะดวกในการเลือก, การวาดและการจัดวางออบเจ็ค เมื่อเลื่อนเมาส์เหนือออบเจ็คชิ้นใดก็จะปรากฎโครงร่าง
และส่วนประกอบของเส้น Path ให้เห็น ช่วยให้มองเห็นต าแหน่งของออบเจ็คที่เลือกได้ง่ายขึ้นและนอกจากนี้
ยังบอกรายละเอียดต่าง ๆ ไม่ว่าจะเป็นองศา, จุดตัดเส้นหรือแนวของออบเจ็ค ซึ่งเทียบกับออบเจ็คใกล้เคียง ท า
ให้การวางมีความแม่นย ามากยิ่งขึ้น การแสดงเส้นสมาร์ทไกด์ท าได้ โดยเลือกค าสั่ง View > Smart Guides 
(คีย์ลัด Ctrl+U) หากต้องการยกเลิกก็ใช้ค าสั่งเติมอีกครั้ง ดังแสดงภาพที่ 3-28 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-28  การใช้ค าสั่ง Smart Guides 

  7. อาร์ตบอร์ด (Artboard) 
   เป็นพ้ืนที่ท างาน หรือ อาร์บอร์ด (Artboard) มีลักษณะเป็นเส้นกรอบสี่เหลี่ยมเหมือน
หน้ากระดาษใช้เป็นพ้ืนที่ในการสร้างและปรับแต่งภาพ ซึ่งจะมีขนาดตามที่ก าหนดไว้ตอนสร้างไฟล์ แต่ก็
สามารถปรับขนาดใหม่ได้ ตามปกติในการน าชิ้นงานไปใช้สิ่งที่อยู่บนอาร์ตบอร์ดเท่านั้นที่จะถูกแสดงออกมา 
   พ้ืนที่เตรียมงาน (Scratch Area) เป็นพ้ืนที่รอบ ๆ อาร์บอร์ดส าหรับใช้วาดออบเจ็ค
ชั่วคราวหรือใช้วางออบเจ็คที่เป็นองค์ประกอบต่าง ๆ ของอาร์ตเวิร์กก่อนที่จะน ามาใช้จริงบนอาร์ตบอร์ด 
สามารถใช้งาน Scratch area ได้เช่นเดียวกับอาร์ตบอร์ด เช่น วาด, แก้ไข และปรับแต่งออบเจ็ค แต่ตามปกติ
ออบเจ็คที่อยู่บริเวณนี้จะไม่ถูกพิมพ์ออกมา  ดังแสดงภาพที่ 3-29 
 
 
 
 
 
 
 

ภาพที่ 3-29  แสดงตัวอย่างอาร์ตบอร์ดและพ้ืนที่เตรียมงาน 

เสน้ Smart Guides 

อาร์ตบอร์ด 

พ้ืนที่เตรียมงาน 
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  8. การบันทึกไฟล์  
   ขณะที่ก าลังสร้างไฟล์ชิ้นงานหรือภายหลังจากที่ท างานเสร็จแล้ว นักออกแบบจะต้องท า
การบันทึกอาร์ตเวิร์กเก็บไว้เป็นไฟล์เอกสาร เพ่ือให้สามารถเปิดกลับขึ้นมาแก้ไขหรือท างานต่อได้ในภายหลัง 
โดยมีขั้นตอนการท างานดังนี้ 

1. ท าการคลิกเลือกค าสั่ง Flie > Save หรือใช้คีย์ลัด Ctrl +  S ดังแสดงภาพที่ 3-30 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 3-30  แสดงการเลือกใช้ค าสั่งในการบันทึกข้ันตอนที่ 1 

 
   2. จากนั้นท าการเลือกโฟลเดอร์ส าหรับเก็บไฟล์ และคลิกที่ช่องแล้วเลือกฟอร์แมตสกุล
ไฟล์ที่ต้องการเซฟ ซึ่งปกติควรเลือกเป็น Adobe Illustrator (.ai) แล้วคลิก Save ดังแสดงภาพที่ 3-31 ถึง           
3-32 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-31  แสดงการเลือกใช้ค าสั่งในการบันทึกข้ันตอนที่ 2 

เลอืกไฟลเดอรส์  าหรบัเก็บไฟล ์

ตัง้ช่ือไฟล ์

เลอืกฟอรแ์มตของไฟลท์ี่ตอ้งการ 
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   ขั้นตอนสุดท้ายจะปรากฎหน้าต่างเพ่ือให้ท าการเลือกเวอร์ชั่นที่ใช้ของโปรแกรม 
Adobe Illustrator ซึ่งหากเป็นเวอร์ชั่นเก่าก็สามารถเลือกเปลี่ยนได้ จากนั้นท าการคลิก OK เพ่ือท าการบันทึก 
ดังแสดงภาพที่ 3-32 

 
 
 

 
 
 
 
 
 
 

ภาพที่ 3-32  แสดงการเลือกใช้ค าสั่งในการบันทึกข้ันตอนที่ 3 
 
   นอกจากนี้ยังสามารถบันทึกไฟล์อาร์ตเวิร์กที่สร้างจาก Illustrator ไปใช้ในโปรแกรม
ตกแต่งภาพอย่าง Adobe Photoshop ได้ โดยไฟล์ที่ได้จะยังคงคุณสมบัติของเลเยอร์อยู่ ซึ่งจะช่วยให้การ
แก้ไขออบเจ็คแต่ละชิ้นนั้นง่ายขึ้น สามารถเอ็กซ์พอร์ตไฟล์ เป็นฟอร์แมต .PSD และ .JPG โดยใช้ค าสั่ง 
File >Export ดังแสดงภาพที่ 3-33  
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-33  แสดงการใช้ค าสั่ง Export File ขั้นตอนที่ 1 

กรณีที่ตอ้งการบนัทกึเป็นเวอรช์ั่น

เก่าใหค้ลกิเลอืกเปลีย่นเวอรช์ั่น 

เลือกค าสั่ง File > Export 
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   จากนั้นจะปรากฎหน้าต่างส าหรับเลือกประเภทไฟล์ โดยคลิกเลือกโฟลเดอร์เพ่ือเก็บ
ไฟล์ ท าการตั้งชื่อไฟล์ที่ต้องการบันทึก และเลือกประเภทไฟล์ที่ต้องการบันทึก ดังแสดงภาพที่ 3-34 และจะ
ปรากฎหน้าต่างให้เลือกโหมดของไฟล์ ดังแสดงภาพที่ 3-35 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 3-34  แสดงการใช้ค าสั่ง Export File ขั้นตอนที่ 2 
 
    
 
 
 
 
 
 
 
 
 

ภาพที่ 3-35  แสดงการใช้ค าสั่ง Export File ขั้นตอนที่ 3 
 
   Color Mode เลือกโหมดสีของไฟล์ผลลัพธ์ หากต้องการคงคุณสมบัติของเลเยอร์ไว้ 
ให้เลือกค่านี้ให้ตรงกับโหมดสีของไฟล์อาร์ตเวิร์คด้วย 

เลอืกฟอรแ์มตของไฟลท์ี่ตอ้งการ 

เลอืกไฟลเดอรส์  าหรบัเก็บไฟล ์

ก าหนดออปชั่นของไฟล ์
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   Resolution เลือกความละเอียดภาพ เนื่องจาก psd และ jpg เป็นไฟล์ประเภทบิท
แมพ ดังนั้นความละเอียดจึงเป็นตัวก าหนดความคมชัดของภาพและขนาดของไฟล์ด้วย หากก าหนดความ
ละเอียดสูง ภาพจะมีความคมชัดแต่มีขนาดไฟล์ที่ใหญ่กว่าการก าหนดความละเอียดต่ า ส าหรับงานสิ่งพิมพ์ควร
ใช้ความละเอียด High (300ppi) 
   Options ก าหนดออปชั่นอื่น ๆ ซึ่งมีรายละเอียด ดังนี้ 
   Flat Image ก าหนดให้รวมเลเยอร์ทั้งหมดให้เหลือเลเยอร์เดียว 
   Write Layers ก าหนดให้คงคุณสมบัติของเลเยอร์ไว้ (ยกเว้นโมเดลสี RGB) 
   Anti-alias ก าหนดให้ขอบเขตของภาพดูเรียบไม่เป็นรอบหยักขรุขระ 
  Embed ICC Profile บันทึกข้อมูลโปรไฟล์สี  (Color profile) รวมไปด้วย เพ่ือใช้
ส าหรับกระบวนการจัดการสีของภาพด้วยระบบ Color Management ซึ่งจะช่วยให้สีของภาพผลลัพธ์มีความ
เที่ยงตรงตามท่ีออกแบบไว้บนหน้าจอ 
 ทั้งหมดนี้เป็นเครื่องมือและฟังก์ชั่นการใช้งานที่จ าเป็นต้องใช้ในหน้าต่างการท างานในโปรแกรม Adobe 
Illustrator  โดยเทคนิคในการปฏิบัติงานโดยการใช้โปรแกรม Adobe Illustrator และขั้นตอนการออกแบบ
สื่ออินโฟกราฟิก ของส านักวิทยบริการและเทคโนโลยีสารสนเทศด้วยโปรแกรม Adobe Illustrator ซึ่งจะ
กล่าวในบทต่อไป  
 
3.2  ข้อควรระวังในการปฏิบัติงาน 
 3.2.1 ในการเลือกรูปแบบฟอนต์ในโปรแกรม Adobe Illustrator ควรเลือกฟอนต์ที่โปรแกรมสามารถ
รอบรับได้ ซึง่ต้องเป็นฟอนต์ที่ส าหรับใช้กับโปรแกรมกราฟิก เพ่ือป้องกันสระลอยหรือฟอนต์ไม่แสดงผล 
 3.2.2  ก่อนท าการ Create Font ควรตรวจสอบความถูกต้องก่อนทุกครั้ง ป้องกันความยุ่งยากในการ
แก้ไข 
 3.2.3  ในการเลือกโหมดสี ควรเลือกโหมดสีให้เหมาะสมกับชิ้นงาน เช่น หากเป็นงานที่ต้องใช้ระบบเว็บ
ไซด์หรือจอภาพในการน าเสนอ ควรเลือกโหมดสีเป็นประเภท RGB แต่ถ้าเป็นงานในระบบออปเซ็ตส าหรับโรง
พิมพ์ต้องเลือกโหมดสี CMYK  หากท าการเลือกโหมดสีผิด สีในการประมวลจะไม่แสดงตามต้องการ เช่น หาก
ไฟล์การท างานใช้โหมดสีแบบ CMYK จะไม่แสดงผล Effect ของระบบแสง RBG สีก็จะผิดเพ้ียนไป 



บทท่ี 4 
เทคนิคการปฏิบัติงาน 

 
 ในการจัดท าคู่มือการปฏิบัติงานเรื่อง การออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยี 
ด้วยโปรแกรมคอมพิวเตอร์กราฟิก Adobe Illustrator เพ่ือเป็นแนวทางให้ผู้ปฏิบัติงานสามารถปฏิบัติงาน
แทนกันได้ และเพ่ือให้การปฏิบัติงานเป็นไปในมาตรฐานเดียวกัน โดยมีรายละเอียดในการด าเนินงานในแต่ละ
ขั้นตอน ดังนี้ 
 4.1 กิจกรรมแผนการปฏิบัติงาน 
 4.2 ขั้นตอนและเทคนิคการปฏิบัติงาน 
 4.3 การติดตามประเมินผลการปฏิบัติงาน 
 
4.1  กิจกรรมแผนการปฏิบัติงาน 
 ผู้ปฏิบัติงานได้จัดท าคู่มือการปฏิบัติงานการออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและ
เทคโนโลยี ด้วยโปรแกรมคอมพิวเตอร์กราฟิก Adobe Illustrator ได้ด าเนินการตามแผนการปฏิบัติงานซึ่งเป็น
การสนับสนุนการด าเนินงานของกลุ่มพัฒนานวัตกรรมและเทคโนโลยีการศึกษา โดยมีล าดับเวลาในการ
ด าเนินงาน ดังแสดงตารางที่ 4-1 
 

กิจกรรม 
เวลาในการด าเนินงาน (สัปดาห์) 

หมายเหตุ 
1 2 3 4 5 

1. ผู้ปฏิบัติงานที่รับผิดชอบการ
ด า เ นิ น ง า น ข อ ง ก ลุ่ ม ง า น
ด า เ นิ น ง า น ต า ม ที่ ไ ด้ รั บ
มอบหมาย 

     การด าเนินงานปฏิบัติตามใบ
ปฏิบัติงาน 

2. ผู้ปฏิบัติงานที่รับผิดชอบท าการ
สรุปการด าเนินงานทั้งหมดในรอบ
เดือน  

     จั ด ส่ ง ข้ อ มู ล ท า ง อ อ น ไ ล น์  
Google Drive 

3 .  ผู้ ป ฏิ บั ติ ง า น ด า เ นิ น ก า ร
ออกแบบสื่ออินโฟกราฟิก 

      

 
ตารางที่ 4-1  แสดงแผนการปฏิบัติงานการออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยี

สารสนเทศ ด้วยโปรแกรมคอมพิวเตอร์กราฟิก Adobe Illustrator 
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4.2  ขั้นตอนและเทคนิคการปฏิบัติงาน 
 ผู้ปฏิบัติงานการออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยี ด้วยโปรแกรม
คอมพิวเตอร์กราฟิก Adobe Illustrator เช่น การออกแบบสรุปผลการด าเนินการเรียนการสอนผ่านระบบ            
E-learning ของนักศึกษา เพ่ือน าเสนอความเคลื่อนไหวของการใช้ระบบสื่อการสอนรายวิชาที่ได้รับความนิยม
จากระดับ 1-5 โดยสื่อที่ได้รับการออกแบบจะท าการประชาสัมพันธ์ผ่านเว็บไซต์ของส านักวิทยบริการและ
เทคโนโลยีสารสนเทศ โดยสรุปขั้นตอนการด าเนินงานเป็นรูปแบบ Flow chart ดังนี้ 
 
 
 
4.2.1 
 
 
 
 
 
4.2.2 
4.2.3 
 
 
 
 
 
4.2.4 
 
 
 
 
4.2.5 
 
 
 

ภาพที่ 4-1   แสดงขั้นตอนและเทคนิคการปฏิบัติงานในการออกแบบสื่ออินโฟกราฟิก 

ครบ 

ไม่ครบ 

ครบ 

ไม่ครบ 

เริ่ม 

สิ้นสุดกระบวนการ 

จัดส่งไฟล์งานสกุล .jpg ให้ผู้ด าเนินงานด้าน E-learning 

ส่งข้อมูลให้ผู้ปฏิบัติงาน  
E-learning ตรวจสอบ 

ผู้ปฏิบัติงาน E-learning สรุปผลการด าเนินงาน
จัดส่งข้อมูลผ่าน Google Drive share 

 

ตรวจสอบข้อมูล 

ผู้ปฏิบัติงานนักวิชาการช่างศิลป์ด าเนินการ 
1. ก าหนดกรอบแนวคิด 

2. ท าการออกแบบสื่ออินโฟกราฟิก 

ตรวจสอบข้อมูล 

เจ้าหน้าที่ท่ีเกี่ยวข้องเผยแพร่ข้อมูล 

ไม่ครบ 
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 4.2.1  การจัดส่งข้อมูลทางออนไลน์ Google Drive Share 
  เมื่อผู้ปฏิบัติงานด้าน E-learning ซึ่งเป็นหนึ่งในการด าเนินงานภายใต้การก ากับของกลุ่มพัฒนา
นวัตกรรมและเทคโนโลยีการศึกษา ได้ด าเนินการสรุปการด าเนินของงานในรอบเดือนที่ผ่านมาเป็นที่เรียบร้อย
แล้ว ผู้ปฏิบัติงานจะต้องด าเนินการอัพโหลดไฟล์ข้อมูล ซึ่งอยู่ในรูปแบบไฟล์ไมโครซอฟออฟฟิตเวิร์ต 
(Microsoft Office Word) โดยท าการอัพโหลดผ่านระบบออนไลน์ Google Drive Share ซึ่งมีขั้นตอนเข้า
ด าเนินการดังต่อไปนี้ 
  4.2.1.1 การเข้าสู่ระบบอินเทอร์เน็ต www.google.com ท าการลงชื่อเข้าใช้ระบบด้วย User และ 
Password E-mail ของมหาวิทยาลัยเทคโนโลยีราชมงคลพระนคร *******@rmutp.ac.th ดังแสดงภาพ      
ที ่4-2 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-2  แสดงหน้าเพจการเข้าสู่ระบบ www.google.com 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-2  แสดงหน้าเพจการเข้าสู่ระบบ www.google.com (ต่อ) 

 คลิกเพ่ือเข้าสู่ระบบ 

 ใช้ E-mail มหาวิทยาลัยเข้าสู่ระบบ 

mailto:*******@rmutp.ac.th%20ดัง
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  เมื่อเข้าสู่ระบบได้เรียบร้อยแล้ว ที่มุมบนขวามือจะปรากฎปุ่มรวมแอป Google เมื่อคลิก
เข้าไปจะปรากฎสัญลักษณ์ของแอปต่าง ๆ ที่ระบบ Google ให้บริการอยู่ จากนั้นคลิกที่ Google Drive         
เพ่ือเข้าใช้บริการ ดังแสดงภาพที่ 4-3 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-3  แสดงการเข้าระบบแอพ Google Drive 

  4.2.1.2  เมื่อเข้าสู่ระบบ Google Drive ได้เรียบร้อยแล้วก็จะปรากฎหน้าต่างของเพจ ให้เลือก
หัวข้อ Shared with me  ทางด้านซ้ายมือก็จะพบโฟลเดอร์ข้อมูลที่ผู้ปฏิบัติด้าน E-learning ได้สร้างและแชร์
ไว้ ดังแสดงภาพที่ 4-4 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-4  แสดงโฟลเดอร์ข้อมูลใช้ท าสื่ออินโฟกราฟิก 
 

 คลิกเลือก แอพ Google Drive 

 คลิกที่หัวข้อ Shared with me 

 
เลือกโฟลเดอร์ อีเลิร์นนิ่ง เพ่ือ
ท าการโหลดข้อมูลดิบ 
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  เมื่อเข้าสู่โฟลเดอร์อีเลิร์นนิ่งได้แล้วให้ท าการเปิดไฟล์ข้อมูลสรุปรายการการด าเนินงาน  อี
เลิร์นนิ่งที่ผู้ปฏิบัติงานได้ท าการอัพโหลดไว้ จากนั้นท าการดาวน์โหลดไฟล์มาเก็บไว้ในเครื่อง โดยคลิกที่ปุ่ม 
Download เพ่ือใช้ในการจัดวาง ดังแสดงภาพที่  4-5 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-5  แสดงขั้นตอนการเปิดไฟล์งานอีเลิร์นนิ่ง 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-5  แสดงขั้นตอนการเปิดไฟล์งานอีเลิร์นนิ่ง (ต่อ) 
 

 4.2.2  การก าหนดกรอบแนวคิด 
   การก าหนดกรอบแนวคิดการออกแบบอินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยี
สารสนเทศ ได้ท าการวิเคราะห์ เนื้อหาตามปริมาณข้อมูล ที่ผู้สรุปงานด้าน E-learning ส่งมา โดยในขั้นตอนนี้

คลิกที่ลูกศร 

คลิกท่ีตัวเลือก  
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นักวิชาการช่างศิลป์จะท าการก าหนดกรอบแนวคิดในการออกแบบ โดยท าการออกแบบเป็นภาพร่าง Sketch 
ลงกระดาษ ตามหลักการอกแบบกราฟิก เพ่ือก าหนดรูปแบบประเภทสื่ออินโฟกราฟิกให้เหมาะสม ซึ่งในการ
ออกแบบสื่ออินโฟกราฟิกสรุปผลการด าเนินงาน E-learning ได้เลือกใช้รูปแบบแสดงล าดับขั้นตอน โดย
สามารถน ามาปรับใช้ให้เหมาะสมกับการแสดงล าดับจ านวนผู้ใช้บริการ ดังแสดงภาพที่ 4-6 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-6  แสดงการออกแบบร่างสื่ออินโฟกราฟิก 
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 4.2.3  ท าการออกแบบสื่ออินโฟกราฟิก  
 4.2.3.1 เปิดโปรแกรม Adobe Illustrator   
   ท าการเปิดโปรแกรม Adobe Illustrator ขึ้นมา โปรแกรมจะให้ท าการตั้งค่าอาร์ตบอร์ด 
โดยที่ค าสั่ง เมนู File >  New โปรแกรมจะปรากฎหน้าต่าง New Document ให้ท าการตั้งค่าอาร์ตบอร์ด   
ในช่อง Name ให้ตั้งชื่อไฟล์งาน ในช่อง Units ก าหนดค่าหน่วยวัดเป็น Pixels ช่อง Width และ Height  
ก าหนดตัวเลขขนาดของชิ้นงาน หรืออาร์ตบอร์ด โดยก าหนดเป็นค่า 500 px 
   ในส่วน Advanced ช่อง Color Mode ท าการเลือกโหมดสี RGB และในช่อง Raster 
Effect เลือกความละเอียดสูงสุด Higth (300ppi) จากนั้นท าการคลิกปุ่ม OK ดังแสดงภาพที่ 4-7 
 
 
 
 
 

 
 
 
 

ภาพที่ 4-7 แสดงการเปิดโปรแกรม Adobe Illustrator 
   จากนั้นโปรแกรมจะปรากฎอาร์ตบอร์ดที่ใช้ในการท างาน ให้ท าการเรียกแถบไม้บรรทัด 
โดยการใช้ค าสั่งคีย์ลัด Ctrl + R  จากนั้นคลิกเมาส์ขวาท าการเปลี่ยนหน่วยวัดของไม้บรรทัดให้เป็นหน่วย
เซนติเมตร และใช้เมาส์คลิกท่ีมุมบนซ้ายมือ ตรงจุดบรรจบของแถบไม้บรรทัดแนวตั้งและแนวนอน แล้วท าการ
ลากมาไว้ที่มุมบนด้านซ้ายของอาร์ตบอร์ด เพ่ือท าการก าหนดแนวไม้บรรทัด บนแถบไม้บรรทัดจะเริ่มนับศูนย์
จากมุมบนด้านซ้ายมือของพ้ืนที่อาร์ตบอร์ด ดังแสดงภาพที่ 4-8 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-8 แสดงการตั้งแถบไม้บรรทัดบนอาร์ตบอร์ด 

ตั้งชื่อ
ไฟล์ เปลี่ยนหน่วย

วัด 
ก าหนดขนาดอาร์ต
บอร์ด ก าหนดโหมดสีและ

ความละเอียด 

ตัวเลขบนแถบไม้บรรทัดจะเริ่ม

พ้ืนที่ อาร์ตบอร์ด 
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  4.2.3.2 กั้นแนวเว้นขอบก าหนดพื้นที่การท างานบนอาร์ตบอร์ด 
   เมื่อท าการก าหนดแนวตั้งค่าไม้บรรทัดแล้ว ในขั้นตอนต่อไปผู้ปฏิบัติงานจะต้องท าการกั้น
แนวขอบ เพ่ือท าการก าหนดขอบเขตพ้ืนที่ของการออกแบบ ให้มีความห่างที่เหมาะสมเสมอกัน ไม่กว้างข้าง
หรือแคบข้าง โดยการใช้เมาส์คลิกบนแถบไม้บรรทัดเริ่มจากแนวนอนด้านบนแล้วลากลงมา  โดยสังเกตทาง
ซ้ายมือจะปรากฎแนวเส้นประตามการลากของเมาส์ แต่บนอาร์ตบอร์ดจะปรากฎเส้นไกด์สีเขียว ให้ลากเมส์วัด
มาที่ 1 เซนติเมตร จะได้เส้นไกด์แนวนอน ต่อมาใช้เมาส์คลิกบนแถบไม้บรรทัดแนวตั้งทางด้านซ้ ายมือ ท าการ
ลากเส้นไกด์ในแนวตั้งวัดมาที่ 1 เซนติเมตร ซึ่งจะได้เส้นไกด์แนวตั้งและแนวนอนทางด้านมุมบนซ้ายมือ       
ดังแสดงภาพที่ 4-9  
   จากนั้นให้ท าการก าหนดขอบศูนย์อีกครั้ง โดยคลิกที่จุดบรรจบของไม้บรรทัดที่มุมบนด้าน
ซ้ายมือ แล้วท าการลากมาไว้ที่มุมล่างด้านขวามมือของอาร์ตบอร์ด และท าการลากเส้นไกด์แนวนอนจากแถบ
ไม้บรรทัดด้านบนวัดลงมาที่ 1 เซนติเมตร และลากเส้นไกด์จากแถบไม้บรรรทัดแนวตั้งลากมาทางขวามือวัดมา
ที่ 1 เซนติเมตร ดังแสดงภาพที่ 4-10 
 
 
 
 
 

 
 
 
 
 

ภาพที่ 4-9  แสดงการลากเส้นไกด์ด้านมุมซ้ายบน ก าหนดขอบของงาน 
 
 
 
 
 

 
 

 
 

ภาพที่ 4-10  แสดงการลากเส้นไกด์ด้านมุมขวาล่าง ก าหนดขอบของงาน 
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   เมื่อท าการลากเส้นไกด์ครบทั้ง 2 มุมแล้ว  เมื่อท าการย่อพ้ืนที่เตรียมงานโดยใช้ค าสั่งคีย์
ลัด Ctrl + Alt + Spacebar สัญลักษณ์บนเมาส์จะเปลี่ยนจากลูกศรปกติ เป็นรูปแว่นขยายและมีเครื่องหมาย
ลบ อยู่ในแว่นขยาย พร้อมกับการคลิกเมาส์ เพ่ือท าการย่อพ้ืนที่เตรียมงานเพ่ือดูงานในภาพรวมทั้งหมด ซึ่งบน
พ้ืนที่อาร์ตบอร์ดจะปรากฎเส้นไกดท์ั้งแนวนอนและแนวตั้งครบทั้ง 4 มุม ดังแสดงภาพที่ 4-11 
 
 
 
 
 
 
 

 
 
 

ภาพที่ 4-11 แสดงการก าหนดพื้นที่ขอบเขตการท างาน 

   จากนั้นให้ท าการบันทึกไฟล์งาน โดยการใช้ค าสั่งคีย์ลัด Ctrl + Shift + S เพ่ือเป็นการ
บันทึกไฟล์งานที่เพ่ิงเริ่มบันทึกใหม่ครั้งแรก ซึ่งโปรแกรมจะปรากฎโฟลเดอร์ที่ใช้ส าหรับเก็บไฟล์งานในไดร์ฟที่
ก าหนดไว้ และเมื่อท าการกดบันทึกไฟล์แล้ว ก็จะปรากฎหน้าต่าง Illustrator Option เพ่ือระบุเวอร์ชั่นที่
สามารถเปิดไฟล์การออกแบบสื่ออินโฟกราฟิกได้ ดังแสดงภาพที่ 4-12  
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-12  แสดงการบันทึกไฟล์งานการออกแบบสื่ออินโฟกราฟิก 
 

ตั้งค่าชื่อไฟล์
เลือกฟอร์แมต  .ai 

เลือกเวอร์ชัน
ส าหรับไฟล์งาน 
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  4.2.3.3  ท าการวัดและก าหนดจุดกึ่งกลาง 
   เมื่อท าการบันทึกไฟล์เป็นที่เรียบร้อยแล้ว ในขั้นตอนนี้เป็นการก าหนดหาจุดกึ่งกลางของ
พ้ืนที่ท างาน ผู้ปฏิบัติงานจะต้องท าการลากเส้นไกด์มาไว้ที่จุดกึ่งกลาง เพ่ือเวลาจัดวางออบเจ็คจะได้เกิดความ
สมดุลของภาพ โดยการใช้เครื่องมือ Rectangle Tool (M)        น าไปวางมุมบนซ้ายของอาร์ตบอร์ดแล้วท า
การลากในแนวทแยงมุมไปที่มุมล่างขวาของอาร์ตบอร์ด จะเกิดกรอบสี่เหลี่ยมจัตตุรัสที่ไม่มีสีพ้ืนและสีเส้น 
จากนั้นท าตามขั้นตอนที่ 4.2.3.2 ลากเส้นไกด์มามาร์คไว้ทั้งแนวตั้งและแนวนอน จะได้เส้นไกด์สีเขียวใน
ลักษณะกากบาท ดังแสดงภาพที่ 4-13 
 
 
 
 

 
 
 

 
 

 
ภาพที่ 4-13  แสดงการวัดและก าหนดจุดกึ่งกลาง 

  4.2.3.4 การสร้างสีพ้ืน 
   จากข้ันตอนที่ 4.2.3.3 ได้ท าการสร้างกรอบสี่เหลี่ยมจัตตุรัสไว้แล้วนั้น ต่อไปให้ท าการใส่สี
พ้ืนของงานโดยใช้เมาส์คลิกไปที่ Fill จากนั้นเลือกสีที่พาเนล Swatches ตามที่ได้ท าการออกแบบไว้ตั้งแต่
ขั้นตอนแรก ซึ่งจะได้สีพื้นของชิ้นงานแสดงบนอาร์ตบอร์ด ดังแสดงภาพที่ 4-14 
 
 
 
 
 

 
 

 
 

ภาพที่ 4-14  แสดงการใส่สีพื้นให้ชิ้นงาน บนอาร์ตบอร์ด 
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  4.2.3.5 การสร้างข้อความหัวข้อ Head Line 
   เมื่อท าการลงสีพ้ืนเป็นที่เรียบร้อยแล้ว ให้ท าการล๊อคเลเยอร์พ้ืน โดยการคลิกที่ออบเจ็ค
แล้วใช้ค าสั่ง Ctrl + 2 ออบเจ็คสีพื้นที่ได้ท าการลงสีไว้ก็จะไม่ขยับเคลื่อนที่และยึดติดกับอาร์ตบอร์ด  
   จากนั้นท าการเปิดโปรแกรม Microsoft Office Word ท าการเปิดไฟล์งานสรุปการ
ด าเนินงาน    อีเลิร์นนิ่ง ท าการคัดลอกหัวข้อ “สรุปวิชาที่มีความเคลื่อนไหวในระบบ E-learning” โดยใช้ค าสั่ง 
Ctrl+C หรือใช้เมาส์คลิกขวาเลือกค าสั่ง copy ดังแสดงภาพที่ 4-15 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 4-15  แสดงการคัดลอกข้อความในโปรแกรม Microsoft Office Word 

    กลับมาที่โปรแกรม Adobe Illustrator ใช้เมาส์คลิกที่เครื่องมือ Type Tool (T) บน     
ทูลพาเนล จากนั้นมาคลิกเพ่ือสร้างข้อความบนอาร์ตบอร์ด และท าการวางข้อความที่ได้ท าการคัดลอกมาจาก 
Microsoft  Office Word โดยใช้ค าสั่ง Ctrl+V จะปรากฎข้อความที่คัดลอกมา ดังแสดงภาพที่ 4-16  
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-16  แสดงการวางข้อความที่คัดลอก 
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   จากนั้นคลิกที่ข้อความที่เพ่ิงวางท าแถบด า และเลือกรูปแบบตัวอักษร หรือ ฟอนต์ ซึ่งได้
ท าการออกแบบไว้ในขั้นตอนแรก โดยใช้ค าสั่งคีย์ลัด Ctrl+T เรียก Type Panel ขึ้นมาแล้วท าการเลือก
รูปแบบฟอนต์ ดังแสดงภาพที่ 4-17 
 
 
 
 
 
 
 

 

 
 
 
 

ภาพที่ 4-17  แสดงการเลือกรูปแบบฟอนต์ 

   เมื่อเลือกรูปแบบฟอนต์ที่จะใช้ได้แล้ว จากนั้นให้ท าการขยายขนาดของตัวอักษร และท า
การจัดวางรูปแบบ ตามที่ได้ออกแบบไว้ โดยการจัดข้อความลงมาให้เป็น 2 บรรทัด และท าแถบด าที่ข้อความ
และไปที่ Type panel ใช้ค าสั่งขยายระยะห่างของข้อความ จากนั้นคลิกทิ้ง 1 ที บนพ้ืนที่เตรียมงาน ดังแสดง
ภาพที่ 4-18 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-18  แสดงการใช้ค าสั่งขยายระยะห่างของข้อความ 
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   จากนั้นท าการคัดลอกข้อความที่เหลือมาจากโปรแกรม Microsoft Office Word ให้ครบ 
และน ามาจัดวางบนอาร์ตบอร์ดในโปรแกรม Adobe Illustrator ให้ครบสมบูรณ์ประโยค ตามท่ีได้ออกแบบไว้ 
ดังแสดงภาพที่ 4-19 
 
 
 
 
 
 
 
 

 
 

ภาพที่ 4-19  แสดงการจัดวางข้อความหัวข้อ 

  4.2.3.6 การสร้างรูปแบบตัวอักษร  
   เมื่อได้ท าการสร้างข้อความไว้แล้ว ขั้นตอนต่อมาเป็นการสร้างรูปแบบของตัวอักษร โดย
ท าการคัดลอกข้อความทั้งหมดของหัวข้อ ด้วยการคลิกออบเจ็คทั้งหมดพร้อมกับปุ่ม Shift และใช้ค าสั่งด้วย
การกดปุ่ม Alt พร้อมกับใช้เมาส์คลิกลากออบเจ็คทั้งหมด เป็นการคัดลอกออบเจ็คในโปรแกรม Adobe 
Illustrator นอกจากการใช้ค าสั่ง Copy บนเมนู Edit ซึ่งได้จะได้ออบเจ็คที่เหมือนกัน 2 ชุด ดังแสดงภาพ       
ที่ 4-20 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-20  แสดงการคัดลอกออบเจ็คในโปรแกรม Adobe Illustrator 
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   เมื่อท าการคัดลอกออบเจ็คเสร็จเรียบร้อยแล้ว ให้ท าการตรวจสอบข้อความให้ถูกต้อง ว่ามี
ข้อผิดพลาดตรงส่วนไหนหรือไม่ หากไม่มีข้อผิดพลาดให้ท าการ Create Font โดยการใช้เมาส์คลิกครอบออบ
เจ็คข้อความหัวข้อทั้งหมด แล้วใช้ค าสั่งคีย์ลัด Ctrl+Shift+O โปรแกรมจะเปลี่ยนจากกล่องข้อความ  ตัวอักษร
จะปรากฎเส้น Path  
   และท าการจัดกลุ่มข้อความ ให้แบ่งออกเป็น 2 กลุ่ม โดยข้อความชุดบนนับเป็นกลุ่มที่ 1 
และข้อความในชุดล่างนับเป็นกลุ่มที่ 2 โดยการใช้ค าสั่ง Ctrl+G  ซึ่งเมื่อท าการ Create Font และข้อความจะ
ไม่สามารถแก้ไขได้อีก ดังแสดงภาพที่ 4-21 
 
 
 
 
 
 
 

 
 

 
ภาพที่ 4-21  แสดงการใช้ค าสั่งจัดกลุ่มข้อความ 

   จากนั้นให้ท าการใส่สีข้อความ  โดยคลิกที่กลุ่มข้อความกลุ่มแรก แล้วไปที่ทูลพาเนล Tool 
Panel ไปที่เครื่องมือส าหรับใส่สีพ้ืน โดยไปที่ Swatches panel และเลือกสีพ้ืนและสีของเส้นตามสีที่ก าหนด
ไว้ ดังหรือเข้าไปเลือกกลุ่มสีที่โทนเดียวกัน โดยไปท่ี Swatches Libraries Menu ดังแสดงภาพที่ 4-22 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-22 แสดงการใส่สีพื้นและสีเส้นของข้อความ 

ท าการจัดกลุ่มข้อความแบ่งออกเป็น 2 ชุด 

คลิกเลือกสีพ้ืนและสีเส้นจาก  
Swatches panel 

เลือกสีจาก Swatches 

เลือกสีจาก swatches 
Libraries menu 
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   เมื่อใส่สีพ้ืนและเส้นในตัวอักษรกลุ่มแรกเสร็จเรียบร้อยแล้ว ให้ท าการใส่สีตัวอักษร ใน
ข้อความชุดที่ 2 แต่ในส่วนของชุดที่ 2 นี้ จะใส่เฉพาะสีพ้ืน โดยสามารถแยกชุดสีได้ด้วยการดับเบิ้ลคลิกที่
ข้อความที่ต้องการเปลี่ยนสี กลุ่มข้อความก็จะแยกกันชั่วคราวก็สามารถเปลี่ยนสีให้ไม่เหมือนกันได้ และเมื่อ
ต้องการจะให้กลับมาจัดกลุ่มเหมือนเดิม ให้ใช้เมาส์ดับเบิ้ลคลิกท้ิงบนพื้นที่เตรียมงาน ดังแสดงภาพที่ 4-23 
 
 
 
 
 
 
 
 

 
 
 

 
ภาพที่ 4-23  แสดงการใส่สีพื้นและสีเส้นในข้อความ 

   เมื่อใส่สีตัวอักษรครบทั้ง 2 กลุ่มแล้ว ในขั้นตอนสุดท้ายเป็นการจัดระเบียบข้อความเพ่ือให้
ข้อความตัวอักษรเป็นรูปแบบ Point Type โดยใช้เมาส์คลิกที่กลุ่มข้อความชุดแรก แล้วกดปุ่ม Shift บน
คีย์บอร์ด และคลิกกลุ่มข้อความกลุ่มที่ 2 จากนั้นไปที่ค าสั่งเมนู Window > Align > Align Objects เลือก
ค าสั่งจัดระเบียบข้อความแนวตั้ง       และแนวนอน        รูปแบบข้อความที่ได้จะเป็นแบบ Point Type และ
ท าการจัดวางให้เหมาะสม จากนั้นใช้ค าสั่งจัดกลุ่มข้อความ Ctrl+G ดังแสดงภาพที่ 4-24 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-24  แสดงการจัดระเบียบข้อความให้ได้รูปแบบ Point Type 

คลิกเลือก Align Object 
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  4.2.3.7 การสร้างภาพกราฟิก 
   เมื่อท าการสร้างข้อความส่วนหัวข้อเสร็จเรียบร้อยแล้ว ในขั้นตอนต่อไปเป็นการสร้าง
ภาพกราฟิกส าหรับล าดับความเคลื่อนไหวในระบบ E-learning โดยการใช้เครื่องมือส าหรับการสร้างรูปทรง
เรขาคณิต Rounded Rectangle Tool คลิกที่เครื่องมือ 1 ครั้ง จะปรากฎหน้าต่างก าหนดขนาดกว้างและสูง
ให้ใส่ตัวเลข เพ่ือสร้างกรอบสี่เหลี่ยมขอบมนขนาด 2 เซนติเมตร จ านวน 1 ออบเจ็ค จากนั้นใส่สีพ้ืน โดยคลิกที่
เครื่องมือ Fill 1 ครั้ง และเลือกสีที่ Swatches panel หากต้องการชุดสีเพ่ิมเติมให้ไปที่ Swatch Libraries 
menu จะมีชุดสีให้เลือกมากมาย ดังแสดงภาพที่ 4-25 
 
 
 
 

 
 
 
 
 

 
 

ภาพที่ 4-25  แสดงการเพ่ิมสีจาก Swatch Libraries menu 

   จากนั้นคลิกที่ช่อง Stoke ที่ทูลพาเนล เพ่ือใส่สีของเส้น โดยก าหนดให้ใส่สีเส้นให้เป็น     
สีขาว จากนั้นท าการก าหนดขนาดของเส้น และมุมของเส้น ดังแสดงภาพที่ 4-26 
 
 
 
 
 
 
 
 
 

 
 

ภาพที่ 4-26  แสดงการใส่สีเส้นและก าหนดขนาดของเส้นให้ภาพกราฟิก 

เลือกสีจาก swatches 
Libraries menu 
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   ต่อมาใช้เครื่องมือ Rounded Rectangle Tool ท าการสร้างกราฟิกสี่เหลี่ยมทรงผืนผ้า 
วาดตามขนาดที่ให้ออกแบบไว้อีกครั้ง ดังแสดงภาพที่ 4-27 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-27  แสดงการสร้างภาพกราฟิกทรงสี่เหลี่ยมผืนผ้า 

    จากนั้นให้คลิกที่ออบเจ็คสี่เหลี่ยมชิ้นแรกท่ีได้สร้างไว้แล้วคลิกขวาเลือกค าสั่ง Arrange > 
Bring to front หรือใช้ค าสั่งคีย์ลัด Shift+Ctrl+] เป็นการดันออบเจ็คท่ีอยู่ด้านหลังให้มาอยู่เป็นเลเยอร์หน้าสุด 
ดังแสดงภาพที่ 4-28 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-28  แสดงการเปลี่ยนต าแหน่งของเลเยอร์ 

   จากนั้นคลิกที่ออบเจ็คที่ 1 กดปุ่ม Shift แล้วคลิกที่ ออบเจ็คที่ 2 แล้วใช่ค าสั่ง Align โดย
เลือกค าสั่ง Vertical Align Center         เพ่ือจัดระเบียบให้ออบเจ็คทั้ง 2 มีจุดกึ่งกลางตรงกัน ดังแสดงภาพ
ที่ 4-29 
 

คลิกขวาที่ออบเจ็ค เพ่ือให้

ขยับมาเป็นเลเยอร์หน้าสุด 
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ภาพที่ 4-29  แสดงการจัดระเบียบจุดกึ่งกลางระหว่างออบเจ็คทั้ง 2 

   ต่อมาให้สร้างออบเจ็คใหม่อีก 1 เลเยอร์ โดยใช้ค าสั่งเดิม Rounded Rectangle Tool  
คลิกบนอาร์ตบอร์ดแล้วลากจากซ้ายไปขวาตามแนวทแยง จะได้กรอบสี่เหลี่ยมผืนผ้าขอบมน 1 ออบเจ็ค 

จากนั้นใช้เครื่องมือ Rectangle Tool        สร้างรูปทรงเรขาคณิตทรงสี่เหลี่ยม ครอบทับรูปทรงเรขาคณิต
สี่เหลี่ยมขอบมนอีกชิ้นหนึ่ง ดังแสดงภาพที่ 4-30 
 
 
 
 

 
 
 
 
 
 
 

ภาพที่ 4-30  แสดงการสร้างกราฟิกซ้อน 

   จากนั้นคลิกออบเจ็คที่ 1 กดปปุ่ม Shift พร้อมทั้งคลิกที่ออบเจ็คที่ 2 กดปุ่ม Shift ค้างไว้ 
โดยที่ออบเจ็คที่ 2 จะต้องอยู่เป็นเลเยอร์ด้านบนเสมอ แล้วคลิกขวา เลือกค าสั่ง Make Clipping mask หรือ
ใช้คีย์ลัด Ctrl + 7 จะได้ภาพกราฟิกดังแสดงภาพที่ 4-31 
   
 

คลิกเลือกค าสั่ง 
Align Center 

1 2 

1 

2 
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ภาพที่ 4-31  แสดงการใช้ค าสั่ง Make Clipping mask 

   จากนั้นลากออบเจ็คที่  1 ไปซ้อนทับออบเจ็คที่  2 แล้วคลิกออบเจ็คที่  2 ใช้ค าสั่ง 
Arrange > Bring to front หรือใช้ค าสั่งคีย์ลัด Shift+Ctrl+] เพ่ือให้ออบเจ็คที่ 2 เป็นเลเยอร์แรก ดังแสดง
ภาพที่ 4-32 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-32  แสดงการจัดวางเลเยอร์กราฟิก 

   ขั้นตอ่มาให้ท าการตกแต่งโดยการใส่ Effect ให้เลเยอร์กราฟิก เริ่มจากการคลิกที่ออบเจ็ค
ที่ 1 แล้วไปที่เมนู Effect > Stylize > Drop Shadow  ดังแสดงภาพที่ 4-33 โปรแกรมจะปรากฎหน้าต่าง ให้
ก าหนดเปอร์เซนต์ และองศาของเงาที่ต้องการให้เกิดได้ โดยในช่อง Opacity เป็นการก าหนดเปอร์เซนต์ความ
เข้มอ่อนของแสดงเงา ในช่อง X Offset และ ช่อง Y Offset  เป็นการก าหนดองศาของเงา ในตัวอย่างนี้ 
ก าหนดองศา 1:1 ดังแสดงภาพที่ 4-34 

1 2 
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ภาพที่ 4-33  แสดงการใช้ค าสั่ง Effect เพ่ือใส่เงาให้ออบเจ็ค 
 
 
 
 
 
 
 
 
 

 
 
 

ภาพที่ 4-34  แสดงการค านวน Drop Shadow 

   ขั้นตอนสุดท้ายในการสร้างภาพกราฟิก เป็นการตกแต่งภาพกราฟิกให้เกิดความสมดุล 
โดยการคัดลอกเลเยอร์ ด้วยการคลิกที่ออบเจ็คที่ 1 แล้วกดปุ่ม Alt พร้อมลากออบเจ็คออกมา จากนั้นให้ไปที่ 
ทูลพาเนลเลือกค าสั่ง Rotate Tool (R)  แล้วมาคลิกที่ออบเจ็คที่ 1 พร้อมกดปุ่ม Shift แล้วหมุนออบเจ็คให้อยู่
ในต าแหน่งที่ต้องการแล้วคลิกทิ้งปล่อยออบเจ็ค จะได้ออบเจ็คในองศาที่กลับกันกับออบเจ็คที่คัดลอกมา      
ดังแสดงภาพที่ 4-35 
 
 

กรอกตวัเลขก ำหนด
เปอรเ์ซนตแ์ละองศำ 
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ภาพที่ 4-35  แสดงการปรับหมุนออบเจ็คด้วยค าสั่ง Rotate Tool (R)   

   จากนั้นจัดวางออบเจ็คที่หมุนแล้วไปไว้ด้านหลัง โดยการคลิกท่ีออบเจ็คที่ 1 แล้วลากไปจัด
วางซ้อนบนออบเจ็คที่ 2 ใช้ค าสั่ง Arrange > Bring to front หรือใช้ค าสั่งคีย์ลัด Shift+Ctrl+] เพ่ือให้ออบเจ็ค
ที่ 2 เป็นเลเยอร์แรก ซึ่งจะได้ภาพกราฟิกต้นแบบไว้ส าหรับใส่ข้อมูลอันดับรายวิชา จากนั้นคลิกครอบออบเจ็ค 
กราฟิกทั้งหมดแล้วใช้ค าสั่งจัดกลุ่ม Ctrl + G รวมเป็น 1 ออบเจ็ค และท าการคัดลอกภาพกราฟิก โดยกดปุ่ม 
Alt + Shift แล้วลากออบเจ็คออกมา  ดังแสดงภาพที่ 4-36 
 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-36  แสดงภาพกราฟิกใส่ข้อมูลอันดับรายวิชา 

คลิกท่ีเครื่องมือ คลิกแล้วหมุนออบเจ็ค 
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  สุดท้ายในขั้นตอนนี้ ให้ท าการเปลี่ยนสีของออบเจ็คกราฟิก โดยการดับเบิ้ลคลิกแตกกลุ่มออบเจ็คที่
ต้องการเปลี่ยนสี แล้วท าการเลือกสีที่ต้องการจาก Swatches Panel หรือจาก Swatches Libraries menu 
ดังแสดงภาพที่ 4-37 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 4-37  แสดงภาพกราฟิกท่ีเปลี่ยนสีจาก Swatches Libraries menu 

  4.2.3.8 การใส่ข้อความ 
   เมื่อด าเนินการสร้างภาพกราฟิกส าหรับใส่ข้อความเตรียมไว้เรียบร้อยแล้ว ในขั้นตอนนี้
จะต้องท าการใส่ข้อความที่เป็นรายละเอียดสรุปการด าเนินงานของแต่ละรายวิชาในระบบ E-learning โดยไป
โปรแกรม Microsoft Office Word คัดลอกข้อความไว้ ท าแถบด าข้อความที่ต้องการใช้ค าสั่ง  Ctrl + C        
ดังแสดงภาพที่ 4-38 
 
 
 
 
 
 
 
 
 

 
 

ภาพที่ 4-38 แสดงการคัดลอกข้อความจาก Microsoft Office Word 

เลือกสีจาก swatches 
Libraries menu 
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   จากนั้นกลับไปที่โปรแกรม Adobe Illustrator ใช้ค าสั่ง Ctrl + Spacebar ปลายเมาส์จะ
เกิดรูปแว่นขยายและมีเครื่องหมายบวกในแว่นขยาย พร้อมทั้งคลิก1-2 ครั้ง เพ่ือขยายพ้ืนที่อาร์ตบอร์ดหน้าจอ 
จากนั้นไปที่ทูลพาเนล คลิกเลือกเครื่องมือ Type Tool แล้วคลิกบนอาร์ตบอร์ดท าการสร้างข้อความ และเลือก
รูปแบบตัวอักษร และเลือกสีให้กับตัวอักษร ดังแสดงภาพที่ 4-39 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 4-39  แสดงการวางข้อความหัวข้อชื่อรายวิชา 

   แล้วกลับไปที่โปรแกรม Microsoft Office Word คัดลอกข้อความในส่วนของชื่ออาจารย์
ประจ าวิชาไว้ แล้วโปรแกรม Adobe Illustrator ใช้เครื่องมือ Type Tool แล้วคลิกบนอาร์ตบอร์ด ใช้ค าสั่ง 
Ctrl + V วางข้อความ เลือกรูปแบบตัวอักษร ดังแสดงภาพที่ 4-40 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-40  แสดงการวางข้อความในส่วนของชื่ออาจารย์ประจ าวิชา 
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   จากนั้นไปที่โปรแกรม Microsoft Office Word คัดลอกข้อความในส่วนของสาขาวิชา 
และคณะที่อาจารย์สังกัดใช้ค าสั่ง Ctrl + C คัดลอกไว้ แล้วกลับไปโปรแกรม Adobe Illustrator ใช้เครื่องมือ 
selection Tool แล้วคลิกที่ข้อความรายชื่ออาจารย์ กดปุ่ม Alt + Shift พร้อมทั้งคลิกแล้วลากลงมา จากนั้น
ดับเบิ้ลคลิกที่ข้อความที่เพ่ิงคัดลอกมาใหม่แล้วใช้ค าสั่ง Ctrl + A และ Ctrl + V วางข้อความ และใช้วิธีเดิม
คัดลอกยอดวิวของรายวิชา จัดวางไว้ตามที่ออกแบบ ท าการเพ่ิมขนาดฟอนต์ของตัวเลขยอดวิว และเปลี่ยนสี
ตัวเลข ให้เป็นสีโทนเดียวกับภาพกราฟิก ดังแสดงภาพที่ 4-41 
 
 
 
 
 
 

 

 
 

 
ภาพที่ 4-41  แสดงการจัดวางข้อความรายวิชาและคณะที่อาจารย์สังกัดในรายวิชาแรก 

   เมื่อจัดวางข้อความในส่วนของรายวิชาแรกเสร็จเรียบร้อยแล้ว ให้ด าเนินการคัดลอกและ
สร้างข้อความในส่วนของรายวิชา ชื่ออาจารย์ประจ าวิชา สาขาและคณะที่สังกัด และตัวเลขยอดผู้เข้าดูรายวิชา 
ท าซ้ าจนครบทุกรายวิชา พร้อมทั้งเปลี่ยนสีตามล าดับ โดยการคลิกที่ขาข้อความทั้งหมด ทั้งรายชื่อวิชา รายชื่อ
อาจารย์ สาขาคณะ และยอดตัวเลขผู้ชม ใช้ค าสั่ง Alt + Shift พร้อมคลิกและลากเม้าส์ลงมาวางในกรอบ
สี่เหลี่ยมสีขาว จากนั้นก็คัดลอกทีละส่วนไล่ตั้งแต่รายวิชา ชื่ออาจารย์ สาขาและคณะ สุดท้ายคือตัวเลขยอดวิว
และเปลี่ยนสีตามภาพกรอบกราฟิก ดังแสดงภาพที่ 4-42 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-42  แสดงการจัดวางข้อความรายวิชา ชื่ออาจารย์และคณะที่สังกัดในรายวิชาทั้งหมด 



การออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยสีารสนเทศ ด้วยโปรแกรม Adobe Illustrator | 76  

   เมื่อท าการใส่ข้อความรายละเอียดทั้งหมดเรียบร้อยแล้ว ให้ท าการใส่ตัวเลขล าดับที่ตั้งแต่ 
1- 6 โดยใช้เครื่องมือ Type Tool (T) สร้างกล่องข้อความและพิมพ์ตัวเลขพร้อมทั้งใส่สีขาว เพ่ือให้ตัดกับสีพ้ืน 
ดังแสดงภาพที่ 4-43  
 
 
 
 
 

 
 
 
 

ภาพที่ 4-43  แสดงการใส่ตัวเลขล าดับที่ 

  4.2.3.9 การใส่หน่วยงานที่จัดท า Create Font และบันทึกไฟล์งานในรูปแบบภาพบิทแมพ 
   ในขั้นตอนนี้เป็นขั้นตอนสุดท้าย โดยการใส่ข้อมูลชื่อกลุ่มงานที่จัดท าสื่ออินโฟกราฟิก โดย
ใช้เครื่องมือ Type Tool สร้างกล่องข้อความพิมพ์ว่า “จัดท าโดยกลุ่มพัฒนานวัตกรรมและเทคนิคศึกษา ส านัก
วิทยบริการและเทคโนโลยีสารสนเทศ” และเลือกรูปแบบตัวอักษรพร้อมทั้งใส่สี และจัดวางตรงกึ่งกลาง
ด้านล่างอาร์ตบอร์ดตามท่ีได้ออกแบบไว้ ดังแสดงภาพที่ 4-44 
 
 
 
 
 
 
 
 
 
 
 

ภาพที่ 4-44 แสดงการใส่ข้อความรายชื่อหน่วยงาน 
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   สุดท้ายเมื่อท าการจัดวางตามที่ได้ออกแบบไว้เรียบร้อยแล้ว ให้ท าการตรวจสอบความ
ถูกต้องของข้อความการสะกดค าผิดค าถูก รายชื่อหน่วยงาน รายชื่อบุคคลให้ถูกต้อง จากนั้นให้ท าการจับกลุ่ม
ออบเจ็ค Ctrl + G ทั้งหมดโดยการใช้เมาส์คลิกครอบออบเจ็คทั้งหมดบนอาร์ตบอร์ด และใช้ค าสั่ง Create 
Font คีย์ลัด Ctrl+ Shift + O และกดปุ่ม Ctrl + S เพ่ือท าการบันทึกการกระท าท้ังหมด  
   จากนั้นท าการ Export ไฟล์ที่ได้ท าการออกแบบเสร็จเรียบร้อยแล้วให้อยู่ในรูปแบบของ
ไฟล์ภาพ โดยไปที่เมนู File > Export เมื่อคลิกเข้าไปแล้วโปรแกรมจะปรากฎหน้าต่างส าหรับการบันทึก โดย
ในช่อง Save as type ให้เลือกฟอร์แมตสกุลไฟล์ .jpg ดังแสดงภาพที่ 4-45  
 
 
 
 

 
 

 
 
 

 
ภาพที่ 4-45  แสดงการ Export File 

   กดที่ปุ่ม Save โปรแกรมจะมีหน้าต่างให้ก าหนดโหมดสีของชิ้นงาน และก าหนดความ
ละเอียดของงาน โดยในช่องโหมดสีให้เลือกระบบ RGB ส่วนในช่อง Resolution ให้ก าหนดความละเอียดที่ 
High (300ppi) แล้วคลิกที่ปุ่ม OK โปรแกรมจะท าการบันทึกภาพอินโฟกราฟิกที่ได้ออกแบบไว้ในรูปแบบไฟล์
ภาพบิทแมพ ดังแสดงภาพที่ 4-46 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 4-46 แสดงการบันทึกภาพอินโฟกราฟิก 

เลือกฟอร์แมต .jpg 



การออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยสีารสนเทศ ด้วยโปรแกรม Adobe Illustrator | 78  

4.2.4 จัดส่งไฟล์งานสกุล .jpg ให้ผู้ด าเนินงานด้าน E-learning 
 เมื่อท าการออกแบบและบันทึกไฟล์ภาพสื่ออินโฟกราฟิก ให้อยู่ในรูปแบบไฟล์ภาพในสกุล .jpg เป็น
ที่เรียบร้อยแล้ว ในขั้นตอนต่อมาเป็นการอัพโหลดไฟล์งานกลับส่งคืนให้ผู้ปฏิบัติงานด้าน E-learning ท าการ
ตรวจสอบคุณภาพไฟล์ภาพส าหรับอัพโหลดเข้าระบบเว็บไซต์ ด้วยการอัพโหลดไฟล์ภาพเข้าระบบ Google 
Drive Share แล้วแจ้งให้ผู้ปฏิบัติงานทราบเพื่อท าการตรวจสอบ 

4.2.5 ผู้ปฏิบัติงานด้าน E-learning ท าการเผยแพร่ 
  เมื่อผู้ปฏิบัติงานด้าน E-learning  ท าการตรวจสอบคุณภาพไฟล์ภาพ ให้มีความละเอียดเหมาะสม
ส าหรับอัพโหลดขึ้นเว็บไซต์เป็นที่เรียบร้อยแล้ว ขั้นตอนต่อมาผู้ปฏิบัติงานที่เกี่ยวข้องด าเนินการน าไฟล์ภาพที่
ได้ไปเผยแพร่ผ่านเว็บไซต์ของส านักวิทยบริการและเทคโนโลยีสารสนเทศ แต่ถ้าไฟล์ภาพมีความละเอียดไม่
เพียงพอ ผู้ปฏิบัติงานด้าน E-learning จะแจ้งความประสงค์ให้ปรับลด-เพ่ิมขนาดของไฟล์ภาพ แล้วด าเนินการ
ส่งไฟล์ภาพใหม่อีกครั้ง เพ่ือท าการเผยแพร่ตามระบบ 
  ทั้งหมดนี้เป็นการจบขั้นตอนการออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยี
สนเทศ ด้วยโปรแกรมคอมพิวเตอร์ Adobe Illustrator  
 
4.3 การติดตามประเมินผลการปฏิบัติงาน 
  การประเมินคุณภาพของการออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยีสารสนเทศ 
ด้วยโปรแกรมคอมพิวเตอร์ Adobe Illustrator ทางหน่วยงานจะใช้วิธีการประเมินผลการด าเนินงานโดยผ่าน
การตรวจสอบจากรองผู้อ านนวยการและผู้อ านวยการส านักวิทยบริการและเทคโนโลยีสารสนเทศ ท าการ
พิจารณาคุณภาพ ตรวจสอบและติดตามผ่านระบบเว็บไซด์ E-learning ดังแสดงภาพที่ 4-47 
 
 
 
 
 
 
 
 
 
 
 

 
ภาพที่ 4-47  แสดงตัวอย่างสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยีสารสนเทศ ที่เผยแพร่ผ่าน 

  ระบบเว็บไซด์ E-learning 



บทท่ี 5 
ปัญหาอุปสรรค  และขอ้เสนอแนะ 

  
 ในการจัดท าคู่มือการปฏิบัติงานเรื่อง การออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยี
สารสนเทศ ด้วยโปรแกรมคอมพิวเตอร์กราฟิก Adobe Illustrator ผู้ปฏิบัติงานได้น าเสนอปัญหา อุปสรรค 
และข้อเสนอแนะแนวทางในการแก้ไขการปฏิบัติงาน จากประสบการณ์ของผู้เขียนที่ปฏิบัติงานในด้านการใช้
โปรแกรมคอมพิวเตอร์ประยุกต์ Adobe Illustrator เพ่ือเสนอเป็นแนวทางการแก้ไขในการพัฒนาปรับปรุงงาน 
ให้งานที่ท าอยู่มีประสิทธิภาพมากยิ่งขึ้นและเพ่ือให้การปฏิบัติงานเป็นไปในมาตรฐานเดียวกัน ซึ่งในการ
ปฏิบัติงานมีปัญหาอุปสรรค และข้อเสนอแนะดังต่อไปนี้ 
  
5.1  ปัญหา อุปสรรคของผู้ปฏิบัติงานในการออกแบบส่ืออินโฟกราฟิก 
 

ขั้นตอนการด าเนินงาน ปัญหา/อุปสรรค แนวทางแก้ไข 

1. การสร้างกล่องข้อความ 
 
 
 

- ในการเลือกรูปแบบตัวอักษร
หรือฟอนต์ บางรูปแบบโปรแกรม
ไม่สามารถรองรับได้ท าให้ เกิด
อาการที่ เ รี ยกว่ า  “สระลอย” 
โดยเฉพาะในโปรแกรม Adobe 
Illustrator เวอร์ชั่น CS6  

1. พิมพ์วรรณยุกต์ลอยได้ด้วยการ
ใส่โค๊ด asci โดยการกดปุ่ม Alt 
ค้างไว้และตามด้วยตัวเลขดังนี้ 

  - ตัวอักษร Font ตระกูล DB, 
JS, PSL 

    ไม้เอก = Alt + 0139 
    ไม้โท = Alt + 0140 
    ไม้ตรี  = Alt + 0141 
    ไม้จัตวา = Alt + 0142 
    การันต์ = Alt + 0143 
  - ตัวอักษร Font ตระกูล DSB 
    ไม้เอก = Alt + 0135 
    ไม้โท = Alt + 0136 
    ไม้ตรี = Alt + 0137 
    ไม้จัตวา = Alt + 0138 
    การันต์ = Alt + 0139 
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ขั้นตอนการด าเนินงาน ปัญหา/อุปสรรค แนวทางแก้ไข 

      2. เลื่อนทีละตัว 
   - กดปุ่มลูกศร เลื่อน Cursor ไป
อยู่หลังสระหรือวรรณยุกต์ที่เรา
ต้องการจะเลื่อน  

   - กด Shift ค้างไว้และกดปุ่ม
ลูกศรซ้าย 1 ครั้ง จะเกิดแถบด า 

   - กด Alt + Shift ค้าง ใช้ปุ่ม
ลูกศรปรับต าแหน่งบน ล่าง ซ้าย 
ขวา ตามต้องการ 

3. หาฟอนต์ที่ปรับแก้สระลอย
แล้วมาใช้  

4. ถ้าไม่ต้องแก้ไขข้อความแล้ว ให้
ท า ก า ร  Create Font แ ล ะ 
ดั บ เ บิ้ ล ค ลิ ก เ พ่ื อ  Ungroup 
ชั่วคราว และขยับย้ายต าแหน่ง
ตามต้องการ 

5. พิมพ์วรรณยุกต์หรือสระใน
กล่องข้อความใหม่ และจัดวาง
ตามต าแหน่งที่ต้องการ 

2. การ Clipping Mask 
 

 

 

 

 

 

 

เมื่อใช้ค าสั่ง Clipping Mask แล้ว
โปรแกรมไม่ตอบสนอง แต่ขึ้น
หน้าต่างเตือนว่าเกิดการผิดพลาด 

เกิดจากต าแหน่งของออบเจ็คที่
ทับซ้อนกัน ซึ่งต าแหน่งพ้ืนที่ที่
ต้องการใช้อยู่จะต้องท ากรอบ
ครอบไว้ โดยต้องให้กรอบที่ท า
ครอบไว้อยู่ในเป็นเลเยอร์หน้า
เสมอ จึงจะสามารถใช้ค าสั่ ง 
Clipping Mask ได ้
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ขั้นตอนการด าเนินงาน ปัญหา/อุปสรรค แนวทางแก้ไข 

3. การ Create Font ต้องการแก้ไขข้อความท่ี Create 
Font ไปแล้ว  

- ตรวจสอบความถูกต้อง การ 
สระกดค าถูกผิด ความถูกต้องของ
ชื่อ ต าแหน่งบุคคล  
- จ าเป็นต้องท าการแก้ไขข้อความ
ที่ Create Font ไปแล้ว เพียง
บางตัวบางต าแหน่ง ให้ท าการ
ดับเบ้ิลคลิกท่ีข้อความต้องการ
แก้ไข เพ่ือ Ungroup ชั่วคราว
แล้วขยับปรับแก้ไขได้ที่ละ
ตัวอักษรตามต้องการ  

4. การเลือกสีในกลุ่ม Swatches ออกแบบใส่สีพ้ืนและสีเส้นแล้ว  
ไม่เด่น  

- ในขั้นตอนการออกแบบเลือกสีที่
ใช้ ผู้ปฏิบัติงานจะต้องมีความรู้
พ้ืนฐานในเรื่อง วงจรสี, อิทธิพล
ของสี, การจับคู่สีคู่ตรงข้าม, โทน
สี และการเลือกสีสื่อความหมาย 

5. การส่งไฟล์ให้ผู้ปฏิบัติงานน าไป
เผยแพร่ 

- คุณภาพของไฟล์ภาพที่ส่งไปไม่
ชัด 

- ในขั้นตอนการบันทึก Export 
จะต้องเลือกความละเอียดของ
ภาพให้อยู่ในระดับสูงเสมอ หรือ 
ใ ห้ ท า ก า ร บั น ทึ ก เ ป็ น ไ ฟ ล์
สกุล .pdf จากนั้นเปิดโปรแกรม 
Adobe Photoshopเ ปิ ด ไ ฟ ล์
งานสกุล .pdf  ในขั้นตอนเปิด
ไฟล์งานที่บันทึกไว้ ระบบจะถาม
ความละเอียดให้ก าหนด ไม่ต่ า
กว่า 150 dpi แล้วบันทึกใหม่ที
ละหน้าโดยก าหนดสกุล . jpg 
หรือ .png จากนั้นด าเนินการส่ง
ตามปกติ  
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5.2  ข้อเสนอแนะเพื่อการพัฒนา  
 การจัดท าคู่มือการปฏิบัติงานเรื่อง การออกแบบสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยี
สารสนเทศ ด้วยโปรแกรมคอมพิวเตอร์กราฟิก Adobe Illustrator ในปัจจุบันน าเสนอเป็นแบบภาพนิ่งบน
เว็บไซต์ออนไลน์ในระบบ E-learning ผ่านเว็บไซต์ของมหาวิทยาลัย ไม่ดึงดูดความสนใจของผู้เข้าชม ใน
อนาคตสามารถพัฒนาการออกแบบและรูปแบบการน าเสนอให้อยู่ในรูปแบบไฟล์ภาพเคลื่อนไหว หรือเรียกว่า
ไฟล์ Gif เป็นรูปการ์ตูน หรือสื่อที่เกี่ยวข้องกับเรื่องนั้นๆ เพ่ือดึงดูดความน่าสนใจมากยิ่งขึ้น เป็นการเพ่ิม
ประสิทธิภาพการท างานของผู้ปฏิบัติงานในอนาคต  
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- ตัวอย่างสื่ออินโฟกราฟิกของส านักวิทยบริการและเทคโนโลยีสารสนเทศ 
(สื่ออินโฟกราฟิกรายงานสรุปการด าเนินงานรายวิชาในระบบ E-learning 
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